# Table of Contents

**Preface** ........................................................................................................ ix
  Terms and Conditions .................................................................................. ix
  Manual Conventions .................................................................................. xiii

**What’s New with TopSURV** ................................................................. xv

**Chapter 1**

**Introduction** ................................................................. 1-1
  Title Bar ............................................................................. 1-2
  Menu Bar ............................................................................ 1-2
  Security ............................................................................. 1-3

**Chapter 2**

**Job** ............................................................................. 2-1
  Open ................................................................................ 2-2
    Open Job ....................................................................... 2-2
  New .................................................................................. 2-3
    New Job ......................................................................... 2-3
  Select Survey Configurations .................................... 2-4
  Coordinate System .................................................... 2-5
  Projections ................................................................. 2-6
  Grid to/from Ground Params .................................... 2-7
  Geoid ............................................................................ 2-8
    Add Geoid .................................................................... 2-8
  Units ............................................................................. 2-9
  Display .......................................................................... 2-11
  Alarms ........................................................................... 2-12
  Delete ............................................................................ 2-12
  Config ........................................................................... 2-13
    Config: Survey ........................................................ 2-14
  Select Survey Configurations .................................... 2-14
<table>
<thead>
<tr>
<th>Configuration</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS+ Configuration</td>
<td>2-14</td>
</tr>
<tr>
<td>Configurations</td>
<td>2-14</td>
</tr>
<tr>
<td>Config: Survey</td>
<td>2-15</td>
</tr>
<tr>
<td>Config: Base (Static) Receiver</td>
<td>2-19</td>
</tr>
<tr>
<td>Config: Base Radio</td>
<td>2-21</td>
</tr>
<tr>
<td>Internal Hiper Lite</td>
<td>2-22</td>
</tr>
<tr>
<td>Pacific Crest Radio Parameters</td>
<td>2-23</td>
</tr>
<tr>
<td>Satel Radio Parameters</td>
<td>2-24</td>
</tr>
<tr>
<td>Base Cell Phone Parameters</td>
<td>2-24</td>
</tr>
<tr>
<td>Base Multicast Parameters</td>
<td>2-25</td>
</tr>
<tr>
<td>Config: Base (Static) Antenna</td>
<td>2-26</td>
</tr>
<tr>
<td>Config: Rover Receiver</td>
<td>2-27</td>
</tr>
<tr>
<td>Laser Config</td>
<td>2-30</td>
</tr>
<tr>
<td>Config: Rover Radio</td>
<td>2-30</td>
</tr>
<tr>
<td>Config: Beacon</td>
<td>2-32</td>
</tr>
<tr>
<td>Config: WAAS</td>
<td>2-33</td>
</tr>
<tr>
<td>CDGPS Radio</td>
<td>2-34</td>
</tr>
<tr>
<td>Config: EGNOS</td>
<td>2-34</td>
</tr>
<tr>
<td>Config: OmniSTAR</td>
<td>2-35</td>
</tr>
<tr>
<td>Config: Rover Antenna</td>
<td>2-36</td>
</tr>
<tr>
<td>Config: Init (Occupation) Times</td>
<td>2-37</td>
</tr>
<tr>
<td>Config: Survey Parms</td>
<td>2-38</td>
</tr>
<tr>
<td>Config: Stakeout Parms</td>
<td>2-40</td>
</tr>
<tr>
<td>Config: Advanced</td>
<td>2-42</td>
</tr>
<tr>
<td>Total Station Configuration</td>
<td>2-43</td>
</tr>
<tr>
<td>Configurations</td>
<td>2-43</td>
</tr>
<tr>
<td>Config: Survey</td>
<td>2-44</td>
</tr>
<tr>
<td>Config: Instrument</td>
<td>2-44</td>
</tr>
<tr>
<td>Config: Connection Mode</td>
<td>2-46</td>
</tr>
<tr>
<td>Config: Cable</td>
<td>2-47</td>
</tr>
<tr>
<td>Config: Radio</td>
<td>2-48</td>
</tr>
<tr>
<td>Satel Radio Parameters</td>
<td>2-48</td>
</tr>
<tr>
<td>Config: Mode</td>
<td>2-49</td>
</tr>
<tr>
<td>Config: Search/Track</td>
<td>2-51</td>
</tr>
<tr>
<td>Config: Survey Parameters</td>
<td>2-52</td>
</tr>
<tr>
<td>Config: Stakeout Parms</td>
<td>2-55</td>
</tr>
<tr>
<td>Config: Miscellaneous</td>
<td>2-56</td>
</tr>
<tr>
<td>Config: Coordinate System</td>
<td>2-57</td>
</tr>
</tbody>
</table>
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Status</td>
<td>2-84</td>
</tr>
<tr>
<td>Duplicate Objects</td>
<td>2-84</td>
</tr>
<tr>
<td>Export to File</td>
<td>2-85</td>
</tr>
<tr>
<td>To File</td>
<td>2-85</td>
</tr>
<tr>
<td>Select Point Type(s) to Export</td>
<td>2-87</td>
</tr>
<tr>
<td>Points to Export</td>
<td>2-87</td>
</tr>
<tr>
<td>Select TN3</td>
<td>2-88</td>
</tr>
<tr>
<td>Export To Format</td>
<td>2-88</td>
</tr>
<tr>
<td>Text File Format</td>
<td>2-89</td>
</tr>
<tr>
<td>Custom Style</td>
<td>2-90</td>
</tr>
<tr>
<td>Export to Controller</td>
<td>2-90</td>
</tr>
<tr>
<td>Import/Export Settings</td>
<td>2-90</td>
</tr>
<tr>
<td>Files To Export</td>
<td>2-91</td>
</tr>
<tr>
<td>Sessions</td>
<td>2-92</td>
</tr>
<tr>
<td>Info</td>
<td>2-93</td>
</tr>
<tr>
<td>Job Info</td>
<td>2-93</td>
</tr>
<tr>
<td>Mode</td>
<td>2-94</td>
</tr>
<tr>
<td>Observation Mode</td>
<td>2-94</td>
</tr>
</tbody>
</table>

## Chapter 3

### Edit

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Points</td>
<td>3-2</td>
</tr>
<tr>
<td>Display</td>
<td>3-3</td>
</tr>
<tr>
<td>Find by Point</td>
<td>3-4</td>
</tr>
<tr>
<td>Find by Code</td>
<td>3-5</td>
</tr>
<tr>
<td>Add (Edit) Point</td>
<td>3-5</td>
</tr>
<tr>
<td>Code-Attributes</td>
<td>3-7</td>
</tr>
<tr>
<td>Codes and Attributes</td>
<td>3-8</td>
</tr>
<tr>
<td>Codes - Attributes</td>
<td>3-8</td>
</tr>
<tr>
<td>Code</td>
<td>3-9</td>
</tr>
<tr>
<td>Attributes</td>
<td>3-9</td>
</tr>
<tr>
<td>Point Lists</td>
<td>3-11</td>
</tr>
<tr>
<td>List of Point Lists</td>
<td>3-11</td>
</tr>
<tr>
<td>Add/Edit Point List</td>
<td>3-12</td>
</tr>
<tr>
<td>X-Sect Templates</td>
<td>3-14</td>
</tr>
<tr>
<td>Roads</td>
<td>3-17</td>
</tr>
<tr>
<td>Start Point</td>
<td>3-19</td>
</tr>
</tbody>
</table>
Table of Contents

Horizontal Alignment ................................................ 3-20
  Line ................................................................. 3-21
  Curve .............................................................. 3-22
  Spiral ............................................................. 3-23
  Intersection Point ............................................. 3-24
Vertical Alignment .................................................... 3-25
  Vertical Grade .................................................. 3-26
  Parabola .......................................................... 3-27
  Long Section ................................................... 3-28
X-Section ................................................................... 3-29
Properties ................................................................... 3-30
Calculate Road Points ............................................... 3-31
Raw Data ................................................................ 3-34
Edit Raw Data ........................................................ 3-36
Sessions ..................................................................... 3-37
Session Setup .......................................................... 3-38

Chapter 4
View ........................................................................... 4-1
  Enable ................................................................. 4-2
  Zoom In/Out/Window .......................................... 4-2
  Zoom All ........................................................... 4-2
  Zoom To Point .................................................... 4-2
  Toolbar ............................................................. 4-3
  Properties .......................................................... 4-4

Chapter 5
GPS Survey ........................................................... 5-1
  Status ............................................................... 5-2
  Elevation Mask .................................................. 5-4
  Start Base .......................................................... 5-8
  Multi Base .......................................................... 5-10
  Init mmGPS+ ....................................................... 5-10
  Transmitter ......................................................... 5-12
  Resection ........................................................... 5-14
  Known Point ....................................................... 5-15
  Add Point ........................................................... 5-18
  Calibration ............................................................. 5-18
Table of Contents

Topo ................................................................................. 5-20
  Line .................................................................................. 5-29
  Azimuth-Distance-Height ............................................. 5-30
  Laser BS Meas ............................................................... 5-32
    Config Laser .............................................................. 5-32
  Config Laser .................................................................... 5-33
Auto Topo Survey ............................................................. 5-34
Known Point Init ............................................................... 5-38
X-Section ........................................................................... 5-39
Find Station .......................................................................... 5-39
Tape Dimension ................................................................. 5-39
Static Occupation .............................................................. 5-40
Localization ........................................................................ 5-41
  Add Localization Point .............................................. 5-43
  Localization Results ................................................... 5-44

Chapter 6
Total Station Survey ......................................................... 6-1
  Occupations and Backsight Survey Setup .................... 6-2
    Backsight Survey .......................................................... 6-2
    Resection ..................................................................... 6-5
    Elevation ....................................................................... 6-8
    Multi-Point Backsight ............................................... 6-10
    Check Backsight .......................................................... 6-12
  Observations .................................................................... 6-13
    Sideshot - Direct .......................................................... 6-14
    PTL Mode ..................................................................... 6-16
  Offsets ............................................................................. 6-18
    Horizontal Angle Offset ............................................. 6-19
    Horizontal/Vertical Angle ............................................ 6-22
    Distance Offset ............................................................ 6-23
    Hidden Point ................................................................ 6-24
    Two Line Intersection ............................................... 6-25
    Line and Corner ........................................................... 6-26
    Line and Offset ............................................................. 6-27
    Plane and Corner .......................................................... 6-28
  Cross-Section ................................................................. 6-29
  Find Station ..................................................................... 6-31
Table of Contents

Tape Dimension ............................................................... 6-33
Missing Line ................................................................. 6-35
Auto Topo ................................................................. 6-36
Scanning ........................................................................ 6-39
Remote Control ......................................................... 6-40
  Remote Control .......................................................... 6-40
  Rotate ........................................................................ 6-42

Chapter 7

Stake ............................................................................... 7-1
  Points ........................................................................... 7-2
  Stakeout Point ............................................................ 7-2
  GPS+ Stakeout ............................................................ 7-4
    Configure Radio ......................................................... 7-5
  TS Stakeout ................................................................. 7-6
    Configure Link .......................................................... 7-7
  Point in Direction ......................................................... 7-8
    Point in Direction ....................................................... 7-8
  GPS+ Stakeout ............................................................ 7-10
  TS Stakeout ................................................................. 7-10
  Point List ....................................................................... 7-11
    Stakeout Point List ..................................................... 7-11
    Stakeout (GPS and TS) .............................................. 7-13
      Select Point ............................................................. 7-13
  Lines ............................................................................ 7-14
    Stakeout Line ............................................................ 7-14
      GPS+ Stakeout ......................................................... 7-15
      TS Stakeout ............................................................. 7-16
  Offsets ......................................................................... 7-17
    Line & Offset .............................................................. 7-17
      Stakeout Line & Offset .............................................. 7-17
      Station & Offsets ....................................................... 7-19
      Initial Point Name .................................................... 7-20
      GPS+ Stakeout .......................................................... 7-21
      TS Stakeout ............................................................. 7-22
    Intersection & Offsets ............................................. 7-23
      Intersection & Offsets .............................................. 7-23
      GPS+ Stakeout .......................................................... 7-25
# Table of Contents

- **TS Stakeout** ......................................................... 7-25
- **Curve & Offsets** ......................................................... 7-26
- **Spiral & Offset** .................................................. 7-26
- **Stakeout Spiral & Offset** .................................... 7-27
- **Roads** ................................................................. 7-28
  - **Stakeout Road** .................................................. 7-28
    - **Initial Point Name** ........................................ 7-31
    - **GPS+ Stakeout** ........................................... 7-31
    - **TS Stakeout** .................................................. 7-32
  - **Stakeout Slope** .................................................. 7-33
  - **Stakeout Alignment** .......................................... 7-34
  - **GPS+ Stakeout** ........................................... 7-35
  - **TS Stakeout** .................................................. 7-36
  - **Stakeout Real Time Road** ................................... 7-37
    - **Initial Point Name** ........................................ 7-39
    - **GPS+ Stakeout** ........................................... 7-39
    - **TS Stakeout** .................................................. 7-40
- **DTM** ................................................................. 7-40
- **CodeStrings** ..................................................... 7-41

## Chapter 8

**COGO** ................................................................. 8-1

- **Inverse** ............................................................ 8-2
- **Inverse Point to Points List** ................................... 8-5
- **Intersection** .......................................................... 8-7
- **Inverse Point to Line** ......................................... 8-9
- **Point in Direction** .................................................. 8-11
- ** Traverse** ............................................................. 8-13
  - **BS Point** .......................................................... 8-14
- **Curve Solutions** ................................................... 8-15
  - **Curve Solution** .................................................. 8-15
  - **PI & Tangents** .................................................. 8-18
  - **Three Pt Curve** ................................................ 8-20
  - **Radius & Points** ............................................... 8-22
- **Area** ..................................................................... 8-24
# Table of Contents

Known Area ........................................................................... 8-26  
Hinge .................................................................................... 8-26  
  Known Area - Hinge ......................................................... 8-26  
Line ..................................................................................... 8-29  
  Known Area - Line ........................................................... 8-29  
Transformations .................................................................... 8-31  
  Rotate ............................................................................... 8-31  
  Translate ........................................................................... 8-32  
  Scale ................................................................................ 8-33  
  Select Points by Range .................................................. 8-34

## Appendix A

### File Formats ................................................................. A-1
  
Point Coordinate Formats ................................................ A-1  
  FC-4 .............................................................................. A-1  
  FC-5 .............................................................................. A-2  
  GTS-6 ............................................................................ A-2  
  FC-6/GTS-7 ................................................................. A-3  
  GTS-7 with strings ......................................................... A-3  
  GT .................................................................................. A-4  
  DXF ............................................................................... A-4  
  SHP ............................................................................... A-4  
  Land XML ................................................................. A-4  
  CR5 ............................................................................... A-5  
  MOSS GENIO ............................................................ A-6  
  NEZ ............................................................................... A-7  
  NEZ with strings ......................................................... A-7  
  Cut Sheet Standard .................................................... A-8  
  Cut Sheet User Defined ............................................. A-8  
  Check Sheet ............................................................... A-9  
  PTL Sheet ................................................................. A-10  

Code Libraries ................................................................. A-10  
  Topcon Data Dictionary (TDD) Format .................. A-10  
  XML Format ............................................................. A-11  
  Data Base Format (DBF) ........................................ A-12

### Roads Formats ............................................................. A-13
  
  SSS Road ................................................................. A-13  
  TDS Road ................................................................. A-14
# Table of Contents

MC Road ................................................................. A-17  
LandXML Road ....................................................... A-18  
TopSURV Road ....................................................... A-18  
X-sect Templates Formats ........................................... A-20  
SSS Template ........................................................... A-20  
TDS X-section Template ........................................... A-20  
TopSurv Template .................................................... A-21  
Localization Format ................................................ A-22  
  GC3 ...................................................................... A-22  
Roads Survey Formats .............................................. A-22  
  X-Section Surveys ................................................ A-22  
  Find Station Report .............................................. A-22  
Raw Data Formats ................................................... A-23  
  FC-5 ................................................................. A-23  
  GTS-6 ............................................................... A-23  
  FC-6/GTS-7 ....................................................... A-24  
  Land XML ........................................................ A-27  
  TDS RawData ....................................................... A-27  
  MOSS Survey ..................................................... A-28

# Index
Preface

Thank you for purchasing your Topcon receiver, survey product or accessory (the “Product”). The materials available in this manual (the “Manual”) have been prepared by Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon products. This Manual is designed to assist owners with the use of software (the “Software”) to be used with the Product and its use is subject to these terms and conditions (the “Terms and Conditions”).

NOTICE

Please read these Terms and Conditions carefully.

Terms and Conditions

PROFESSIONAL USE – Topcon Products are designed to be used by a professional. The user is required to be a professional surveyor or have a good knowledge of surveying, in order to understand the user and safety instructions before operating, inspecting or adjusting. Always wear required safety attire (safety shoes, hard hat, etc.) when operating the Products.

COPYRIGHT – All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved. You may not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access to, any graphics, content, information or data in this Manual without TPS’ express written consent and may only use such information for the care and operation of your Product. The information and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work, time and
Preface

money, and are the result of original selection, coordination and arrangement by TPS.

**TRADEMARKS** – Topcon®, HiPer®, TopSURV™, Topcon Link™, Topcon Tools™, and Topcon Positioning Systems™ are trademarks or registered trademarks of TPS. Windows® is a registered trademark of Microsoft Corporation. Bluetooth® is a registered trademark owned by Bluetooth SIG, Inc. and is used by Topcon Positioning Systems, Inc. under license. Sokkia Corporation and the names of Sokkia Corporation products referenced herein are either trademarks or registered trademarks of Sokkia Corporation. Satel is a trademark of Satel, Oy. Other product and company names mentioned herein may be trademarks of their respective owners.

**DISCLAIMER OF WARRANTY** – EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL, THE PRODUCT, AND ANY ACCOMPANYING SOFTWARE ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL, THE SOFTWARE, OR THE PRODUCT. SUCH DISCLAIMED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION, TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE PRODUCT.

LICENSE AGREEMENT – Use of the Software and any other computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) to be used with a Topcon Product constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such Software under the terms stated herein and in any case only with a single Product or single computer. You may make one (1) backup copy of the Software. Otherwise, the Software may not be copied or reproduced. You may not assign or transfer the Software or this license without the express written consent of TPS. This license is effective until terminated. You may terminate the license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the Terms or Conditions. You agree to destroy the Software and manual upon termination of your use of the Product. All ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not acceptable, return any unused Software and the Manual.

CONFIDENTIALITY – This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent than the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the Product. Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate remedy.
WEBSITE; OTHER STATEMENTS – No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made by an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software License Agreement, Disclaimer of Warranty and limitation of liability).

SAFETY – Improper use of a Topcon Product can lead to injury to persons or property and/or malfunction of the Product. The Product should only be repaired by authorized TPS warranty service centers. Users should review and heed the safety warnings in the manual accompanying the Product.

MISCELLANEOUS – The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to conflict of laws.
## Manual Conventions

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File ➤ Exit</strong></td>
<td>Click the File menu and click Exit.</td>
</tr>
<tr>
<td><strong>Enter</strong></td>
<td>Indicates the button or key labeled Enter.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>Indicates a field on a dialog box or screen, or a tab within a dialog box or screen.</td>
</tr>
<tr>
<td><strong>Topo</strong></td>
<td>Indicates the name of a dialog box or screen.</td>
</tr>
</tbody>
</table>

---

**TIP**

Supplementary information that can help you configure, maintain, or set up a system.

---

**NOTICE**

Supplementary information that can have an affect on system operation, system performance, measurements, personal safety.
What’s New with TopSURV

This chapter briefly describes new features and functions for version 4.11 of TopSURV.

RTK and PP
An additional mode for surveying and data collection.
For details on configuring for RTK&PP survey type, see “Config: Survey” on page 2-15.

mmGPS+ RTK
RTK survey mode using mmGPS+ system.
For details on setup of mmGPS+ system, see “Init mmGPS+” on page 5-10.

Third Party TS support
Now Sokkia/Leica total station models are supported.
For details on formats, see “Config: Instrument” on page 2-44.
What's New with TopSURV

**Multiport**
This is now supported for Base and Rover Receivers. For details on configuring with these modems, see “Config: Survey” on page 2-44.

**Point Name + Constant and Station & Offset**
Staked out points can have these new parameters. For details on using them in point name design, see “Config: StakeoutParms” on page 2-40.

**Staked out Points Listed**
Staked out points are now listed along with the regular points. For details on editing points, see “Points” on page 3-2.

**Linework**
Points collected with codes and strings can be joined with lines. For details on linework representation, see “Codes - Attributes” on page 3-8 and “Properties” on page 4-4.
What's New with TopSURV

**LandXML Import to TN3**

- DWG/DXF 3D-faces Import to TN3
- Import Parcels from LandXML

These Import/Export functions are now available.

For details on import files, see “Import From File” on page 2-69.

**Scatter plots for GPS RTK data**

RTK data can now be represented in graphic mode.

For details on scatter plots, see page 5-4.

**Storing codes for Base**

This is now available when starting the base station.

For details, see “Start Base” on page 5-8.

**Base Station Offsets**

These offsets can be added to correct the Base coordinates according to the offsets between the topo point’s known and observed coordinates, and then to recompute all points.

For details, see page 5-26.
DTM and Realtime Road Stakeout
These have been added to the stakeout types available in TopSURV. For details on staking, see “DTM” on page 7-40 and “Stakeout Real Time Road” on page 7-37.
Introduction

TopSURV is Topcon’s survey software available for hand-held controllers. When installed on a hand-held controller that runs the Windows® CE operating system, such as Topcon’s FC-1000, FC-100 and FC-2000, TopSURV is used for:

- field data collection
- stakeout and control work

The TopSURV main screen consists of a title bar, menu bar and a work area.

![Figure 1-1. Main Screen](image)

**NOTICE**

The appearance of the screen titles and text depend upon the device used. Most of the screen shots in this manual are obtained from an FC-1000.
Title Bar

When on the main screen, the title bar displays the instrument button and the name of the job open (and the configuration name), the Reconnect button, as well as connection and controller power status icons.

![Figure 1-2. Title Bar – Main Screen](image)

If the controller has Bluetooth® wireless technology, the Reconnect button appears to reflect the status of Bluetooth connection.

When within a menu option, the title bar displays the bitmap button, the name of the screen, and any system buttons required for various operations.

![Figure 1-3. Title Bar – Menu Functions](image)

Menu Bar

The menu bar has seven menus used to configure and manage a survey job, and to control data.

![Figure 1-4. Menu Bar](image)

See the following chapters for a description of each menu and its functions.
Security

Upon initial startup, a Security screen displays. TopSURV requires an access code to start. Contact a Topcon representative to acquire the necessary codes.

- **Key Value 1** and **Key Value 2**: the device’s numbers; record to give to a Topcon representative
- **Activation IDs**: the fields in which to enter the security codes received from a Topcon representative to activate the purchased modes: **TS, Robotic, GPS+, GIS (RT DGPS and PP DGPS), Roads**, and **mmGPS**.

![Security Screen](image)

Figure 1-5. Security
Introduction

Notes:

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________
Job

The Job menu includes the following menu items:

- Open
- New
- Delete
- Config
- Import
- Export
- Info
- Mode
- Exit

Figure 2-1. Job Menu
Open

To open a job, click Job ▶ Open.

Open Job

The Open Job screen can be used to select a job.

![Open Job Screen]

The Job List field contains the names of all existing jobs created/opened using this software. When a job is selected in this list, the Created and Modified fields will reflect when the job was created and last modified.

- **Browse**: displays the open job screen to browse directories for selecting the job to open.
- **Open**: makes the chosen job current.

Initially the Job List is empty.

The following screen is opened when selecting the Browse button. Highlight the file to open and press OK. The selected job will now be opened and program will return to the main screen (Figure 2-3 on page 2-3).
To open a new job, click Job ➤ New.

**New Job**

The New Job creation process is performed with the help of a Wizard. Press the Next button after all the fields of this screen have been set. The information will be saved after the Finish button is pressed and the selected values will be stored. The new job becomes current and takes all the settings from the previously open job, unless changed.

- : displays the directory where the job will be created. Press **Browse** to change the directory.
• **Name:** the name of the new job.

• **Created By:** the name or some other identifier of the surveyor.

• **Comments:** any additional information about the project, for example, the conditions of survey.

• **Current Date:** displays the current date.

• **Browse:** changes of the job directory.

• **Next:** opens the *Select Survey Config* screen.

• **Finish:** saves the settings and returns to the main screen.

### Select Survey Configurations

Survey Configuration is a set of parameters that does not depend on the job. One Configuration can be used by several Jobs.

The description of how to work with configurations (edit existing and create new) will be discussed in “Config” on page 2-13. Initially, TopSURV contains pre-defined configurations: *My RTK, My RTK and PP, My Network RTK, My mmGPS+ RTK, My RT DGPS, My PP Static, My PP Kinematic* and *My PP DGPS* for the GPS+ mode; and *My Conventional, My Reflectorless, and My Robotic* for the Total Station mode.

- **GPS+ Config** (for the GPS+ mode): shows the GPS+ Configuration for the current job. The drop-down list shows the configurations available for the GPS+ mode. To edit the configuration press the **...** button.
• **TS Config** (for the TS mode): shows the total station Configuration for the current job. The drop-down list shows the configurations available for the TS mode. To edit the configuration press the ... button.

• **Enable Job History**: when this box is checked, every surveyor’s operation on the job will be entered and saved in the file.

• **Back**: returns to the previous screen.

• **Next**: opens the *Coordinate Systems* screen.

• **Finish**: saves the settings, creates a new job, and returns to the main screen.

**Coordinate System**

This screen contains coordinate system information for the new job.

![Coordinate System Screen](image)

**Figure 2-6. Coordinate System**

• **Projection**: specifies the projection to be used. The ... button opens the *Projections* screen where active projections can be manipulated (added from a list of pre-defined projections, deleted).

• **Use Grid to Ground**: when this box is checked, the ... button becomes available to open the *Grid to/from Ground Param* screen where transformation parameters are set to place grid coordinates to a near ground reference surface and vice versa.
Datum: shows the datum for the selected projection. The drop-down list displays all datums pre-defined in the current version: WGS84, NAD83, ETRS89, ITRF. The button is unavailable.

Geoid Model: shows the geoid selected (if any). The button opens the Geoids List screen where geoids can be added, deleted, or their properties viewed.

Back: returns to the previous screen.
Next: opens the Units screen.

Projections

The Projections screen contains a list of cataloged projections, that can be chosen for use in the job.

• Pre-Defined: contains the tree of available projections divided by regions.
• Active: contains the list of chosen projections (corresponds to the drop-down list in the Projections field of the Coordinate System screen). The first time the screen is opened, it is empty.

: selects the chosen projection in the Pre-Defined panel and inserts it into the Active panel.

: deletes the highlighted projection from the Active panel.
• **OK**: saves the changes and returns to the *Coordinate System* screen.

**Grid to/from Ground Params**

The *Grid to/from Ground Params* screen is used to convert point coordinates from the grid projection to another reference surface to produce near ground values of distances. After the work is complete, the point coordinates can be converted back to the grid projection.

The *Grid to/from Ground Params* screen contains the parameters of the *Grid to Ground* and *Ground to Grid* coordinate transformation.

![Figure 2-8. Grid to/from Ground Params](image)

**TIP**

The “hand” symbol means the function is selectable. Press the button to display the parameter and enter a value.

• **Scale Factor/Avg Job Ht**: sets the value of the corresponding parameter: scale or average job height.

• **Direction**: selects coordinate transformation type, either from Grid to Ground or from Ground to Grid.

• **Az Rotation**: the angle value in degrees.

• **Offsets**: sets the offsets of the origin along the North and East axes to reduce coordinates to manageable values.

• **OK**: returns to the *Coordinate System* screen.
Geoid

Geoid is a physical reference surface. Its shape reflects the distribution of mass inside the earth. Geoid undulations are important for converting GPS-derived ellipsoidal height differences to orthometric height differences.

The Geoids List screen contains a list of Geoids available for selection from models previously downloaded to the controller.

- **Add**: opens the Add Geoid screen.
- **Remove**: deletes the geoid from the list.
- **Edit**: opens the Add Geoid screen to change the geoid.

Add Geoid

From the Add Geoid screen, select a Geoid file from the controller and see the boundaries of the geoid application.
After being chosen, the geoid file appears in the **Geoids List** screen. The job will refer to the selected geoid file when performing calculations.

- **Geoid Format**: the format of the geoid; either **Geoid 99, Australian, Canadian 2000, Canadian 95, Geoid 2003, Mexico 97**, or **GeoidGFF**.

- **Browse**: opens the **Select Geoid** screen for choosing the geoid file from the disk. After the geoid is chosen, the fields in the lower part of the screen display the coordinates of the north-west and south-east points of the geoid.

- **Geoid Boundary**: sets the boundary of the geoid application.

  - : the longitude and latitude of the point that sets the north-west boundary of the geoid.

  - : the longitude and latitude of the point that sets the south-east boundary of the geoid.

## Units

The **Units** screen displays the default units that will be used in the job.

![Figure 2-11. Units](image)

- **Distance Units**: units of linear measurements for the job. These can be Meters; IFeet - (International Feet, 1 Ifoot = 0.3048 Meters); US Feet (1 USFt = 1200/3937 Meters); IFeet and Inches, or US Feet and Inches (the latter two are calculated taking into account that 1 Foot = 12 Inches).
TIP

If the selected units are USfeet, linear values can be entered as meters, or IFeet by appending “m” or “if” to the entered value.

If the selected units are in meters, then a linear value in USFeet, or International feet can be entered by appending “f”, or “if” to the end of the entered value.

If the selected units are in IFeet, linear values can be entered in meters or USfeet by appending “m”, or “f” to the entered value. The appended characters “m”, “f”, or “if” are case insensitive. In other words, enter “M”, “F”, or “IF”.

- **Angle Units**: units of angular measurements for the job. These can be Degrees, Grads (Gons), Radians (for Cogo use only), or Mils (for Cogo use only). (360 degrees = 400 grads = 2 $\pi$ radians = 6400 mils.)

TIP

Azimuth and distances can be entered as two points separated by “-”, “;”, or “,”. Certain angles can be entered as three points separated by “-”, “;”, or “,”. For instance a value of 100-101 indicates the Azimuth or Distance from Point 100 to Point 101.

- **Temperature** (only for TS mode): units of temperature, used only for the raw measurements. These can be Celsius (C), or Fahrenheit (F).

- **Pressure** (only for TS mode): units of atmosphere pressure, used only for the raw measurements. These can be mmHg, or hPa.

- **Back**: returns to the previous screen.
- **Next**: opens the Display screen.
- **Finish**: saves the settings and returns to the main screen.
Display

The Display screen customizes the software interface.

![Display Screen](image)

**Figure 2-12. Display**

- **Coord Type**: displays the coordinate type for the projection selected.
- **Coord Order**: the Northing/Easting order and height type of the local coordinates.
- **Azimuth Origin**: the reference direction of azimuth.
- **Disp Dir As**: select whether to display the direction as bearing or azimuth.
- **Disp CL Pos As**: select how to display the position on the center line: as station or chainage.
- **Back**: returns to the previous screen.
- **Next**: opens the Alarms screen.
- **Finish**: saves the settings and returns to the main screen.
Alarms

The Alarms screen sets the sound alerts for situations of low power, low memory, poor radio link, and loss of initialization for the controller, GPS+ receiver (GPS+ column), or total station (TS column). Place check marks to select the desired alert conditions.

<table>
<thead>
<tr>
<th>Alarms</th>
<th>Finish</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audible Alarm:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Instrument</td>
<td>Controller</td>
<td>GPS+</td>
</tr>
<tr>
<td>Power Alarm</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Memory Alarm</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Radio Link</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Loss of Init</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Audible Alarm**: check this field to enable audible alarms. The alert will sound automatically when an alert situation occurs.
- **Back**: returns to the previous screen.
- **Finish**: saves the settings and returns to the main screen.

Delete

To delete a job, click **Job > Delete**.

![Figure 2-13. Alarms](image)

![Figure 2-14. Delete Job](image)
The **Delete Job** screen deletes jobs. Once deleted from the Job List, the file containing the job chosen is deleted from the disk.

By default, the job files are stored in the \Jobs folder in the directory where the application has been installed.

- **Browse**: If a job is not listed in this list, browse through the directories to select the job for deletion.
- **Delete**: deletes the job.
- **Close**: closes the screen without deleting job.

## Config

The Config submenu changes the parameters set during Job creation.
Config: Survey

To configure a survey, click Job ▶ Config ▶ Survey.

Select Survey Configurations

The Select Survey Configurations screen can also be reached using the New Job Wizard (see “New” on page 2-3). (Note, that the appearance of the screen depends upon the mode enabled).

![Figure 2-16. Select Survey Config](image)

- **…**: opens the Configurations screen that edits the parameters of the configurations.
- **Enable Job History**: when this box is checked, every surveyor’s operation on the job will be entered and saved in the file.
- **Finish**: sets the selected configuration for the current job and returns to the main screen.

GPS+ Configuration

To configure a GPS+ survey, press the button in the GPS+ Config field of the Select Survey Config screen.

Configurations

The Configurations screen presents a list of available configurations (Figure 2-17 on page 2-15). Editing and adding of a configuration is accomplished with the help of a Wizard.
Figure 2-17. Configurations

- **Delete**: deletes the highlighted configuration.
- **Edit**: opens the **Config: Survey** screen for changing configuration settings.
- **Add**: opens the **Config: Survey** screen for adding a new configuration.
- **OK**: returns to the **Select Survey Configurations** screen.

**Config: Survey**

The **Config: Survey** screen contains general settings for the configuration.

Figure 2-18. Config: Survey

- **Name**: the name of the configuration that will be displayed in the **Configurations** screen.
• **Type:** the type of the configuration; either RTK, RTK and PP, Network RTK, My mmGPS+ RTK, My mmGPS+ Network RTK, Real Time DGPS, PP Static, PP Kinematic, or PP DGPS. “PP” means Post-Processing.

  – RTK (Real Time Kinematic) implies, first, a pair of receivers operating simultaneously and, second, a radio link established between the two receivers. From a functional point of view, the two receivers will differ from each other. One of the receivers (usually referred to as the Base Receiver) is located at a fixed point with known coordinates. The base receiver will transmit the differential corrections to the other receiver (usually referred to as the Rover Receiver) via a radio link. To establish a proper connection between the two receivers, specify necessary communication parameters first.

  – RTK and PP (Real Time Kinematic and Post Processing) implies that during real time kinematic the collected data are being written to files for data post processing.

  – Network RTK (Network Real Time Kinematic) implies the usage of either VRS (Virtual Reference Station) data or FKP parameters (network area corrections) received from operating reference station networks.

  – mmGPS+ (RTK, RTK&PP or Network RTK) implies setting up the RTK GPS+ survey system as usual, but with the addition of a wireless PZS-1 sensor at the rover to pick up the Lazer Zone signal from the PZL-1 transmitter for accurate (millimeter) elevations.

  – Real Time DGPS (Real Time Differential GPS) implies that the rover uses differentiation correction data transmitted from DGPS services.

  – PP Static (Static Post Processing) implies two receivers that collect data at stationary locations during a long period of time. Then in the office, the software operator processes the GPS data collected in the field and calculates the relative position of the receivers. Usually it is “differential processing”, when data from two or more receivers are processed together in order to compute these receivers'
relative positions. If the coordinates of one receiver are known, then the coordinates of the other can be calculated.

– PP Kinematic (Kinematic Post Processing) also implies two receivers. One is fixed, the other is moving along some trajectory. The processing of the collected data is performed later, as for the PP Static type.

– PP DGPS (Post Processing Differential GPS) implies that the raw observations made by the rover would have to be written to files as well as the differential correction data.

If the Network RTK or RT DGPS configuration is chosen for editing, the Config: Survey screen will have the Corrections field.

![Figure 2-19. Config: Survey – For Network RTK](image)

- **Corrections**: the type of correction data used. For the Network RTK configuration it can be VRS or FKP. For the RT DGPS configuration it can be User Based, Beacon, CDGPS, WAAS, EGNOS, OmniSTAR, or OmniSTAR HP.

**TIP**

If the name of Network RTK configuration has *N3 as the last three characters, Net.3 support will be activated in TopSURV. Topcon Net.3 software establishes a connection between the computer and three base receivers to form a set of corrections (Net3) used by the rover receiver.
• **Next**: opens the *Config: Base Receiver* screen. For Network RTK and Real Time DGPS (except User Based mode), the *Config: Rover Receiver* screen will display next. If the PP Static type is chosen, the *Config: Static Receiver* screen will display next.

• **Finish**: saves the changes and returns to the *Configurations* screen.

For RTK survey types, the bitmap on the upper-left corner displays the pop-up menu containing two items:

• **MultiPort**: when selected, the MultiPort functionality becomes available and the *Num Ports* field is added to the *Config: Survey* screen.

• **Help**: accesses the Help files.

![Figure 2-20. Config: Survey – MultiPort](image)

• **Num Ports**: sets the number of ports to configure the Base/Rover to transmit/receive data from two different ports.
Config: Base (Static) Receiver

For RTK, the Config: Base Receiver screen contains settings for the Base.

- **RTK Format**: the format of the base receiver differential corrections transmitted to the rover. It can be CMR, CMR+, RTCM 2.1, 2.2, 2.3, 3.0.

- **Elevation mask**: data from satellites below this elevation will not be used.

- **Back**: returns to the previous screen.

- **Next**: opens the Config: Base Radio screen.

- **Finish**: saves the changes and returns to the Configurations screen.

For RTK and PP survey types, the Base Receiver (Base Recrv) screen has the following settings to record data to files:

- **Log To**: the location to save the data.
- **Logging Rate**: the frequency of data logging.
- **File Name**: the name of the file to save the data.

Figure 2-21. Config: Base Receiver

Figure 2-22. Config: Base Receiver – For RTK & PP Survey Type
• **RTK Format**: the format of the base receiver differential corrections transmitted to the rover. It can be CMR, CMR+, RTCM 2.1, 2.2, 2.3, 3.0.

• **Elevation Mask**: data from satellites below this elevation will not be used.

• **Raw Data Logging**: the set of logging parameters; log to the receiver, set the logging rate and select if the name of the receiver file is automatically set or user-defined. In the latter case, the corresponding dialog box will be displayed at the logging start.

• **Back**: returns to the previous screen.

• **Next**: opens the **Config: Base Radio** screen.

• **Finish**: saves the changes and returns to the **Configurations** screen.

For **PP Static**, **PP Kinematic**, or **PP DGPS** survey types, the **Config: Static (Base) Receiver** screen has the same parameters as for **RTK** and **PP** survey type except the **RTK Format** field.

![Figure 2-23. Config: Base Receiver – For PP Kinematic Survey Type](image)

- **Back**: returns to the previous screen.

- **Next**: opens the **Static (Base) Antenna** screen.

- **Finish**: saves the changes and returns to the **Configurations** screen.
**Config: Base Radio**

The *Config: Base Radio* screen contains the parameters of the radio modem connected to the Base receiver.

- **Radio Modem**: the type of the modem. The list of pre-defined modem types changes its contents depending upon the job configuration chosen.

- **Receiver Port Connected to Radio**: contains the parameters of the connection port: port, parity, number of data bits, baud rate, the number of stop bits.

- **Defaults**: returns all the values in the *Receiver Port Connected to Radio* field to defaults.

- **Config Radio**: displays the parameters for the chosen modem. The button changes its appearance or disappears depending upon the modem chosen.

![Figure 2-24. Config: Base Radio](image)

- **Back**: returns to the previous screen.

- **Next**: opens the *Base Antenna* screen.

- **Finish**: saves the changes and returns to the *Configurations* screen.

**NOTICE**

Using Custom, AirLink GPRS, AirLink CDMA, AirLink CDPD¹, CDMA2000, Sierra Wireless MP200 CDPD and
Internal HiPer Pro modem types does not require additional settings except the ones described.

For Internal Hiper Lite

- **Config Radio**: opens the *Internal Hiper Lite* screen.

**Internal Hiper Lite**

The *Internal Hiper Lite* screen sets the channel number and the power of the base station’s transmitter.

![Internal Hiper Lite Screen](image)

**Figure 2-25. Internal Hiper Lite**

- **Channel**: sets the channel number.
- **Power**: controls the power amplifier, either *Low* (250mW) or *High* (1W). Greater power provides for longer distance transmissions.
- **Link Rate**: sets the data transmission rate for the RF link.
- **RTS/CTS**: sets the data flow control
- **OK**: returns to the *Config: Base Radio* screen where all settings are saved after pressing the *Finish* button and then transmitted when the configuration is used.

1. CDPD stands for “Cellular Digital Packet Data”. CDPD is an open packet data service, defined as an autonomous overlay network, specified for the cellular TDMA network.
For Pacific Crest and Internal HiPer (Pacific Crest)

- **Config Radio**: opens the *Pacific Crest RadioParms* screen.

**Pacific Crest Radio Parameters**

The *Pacific Crest RadioParms* screen sets the channel number and the sensitivity of the Radio Modem.

![Pacific Crest RadioParms](image)

- **Channel**: sets the operating channel to the radio modem.
- **Sensitivity**: selects the sensitivity level for the radio modem; either low, moderate, high or off.
- **OK**: returns to the *Config: Base Radio* screen. All the settings will be saved and transmitted after the Configuration will be selected for operation.
For Satel modems

- **Config Radio**: opens the *Satel Radio Parms* screen.

**Satel Radio Parameters**

The *Satel Radio Parms* screen sets the model of the Satel modem, the channel number and the frequency of the Radio Modem.

![Satel Radio Parms](image)

- **OK**: returns to the *Base Radio* screen where all the settings will be saved after the **Finish** button is pressed and transmitted when the configuration is used.

For **Internal HiPer GSM**, **Motorola V60 Cell Phone**, **Siemens TC35 Modem**, **Siemens M20 Modem**, **Nextel i58sr Cell Phone**, **Wavecom Fastrack GSM**

- **Config GSM**: opens the *Base Cell Phone Parms* screen.

**Base Cell Phone Parameters**

The *Base Cell Phone Parms* screen (Figure 2-28 on page 2-25) contains a field for Base PIN input.
• **OK**: returns to the *Base Radio* screen where all the settings will be saved after the **Finish** button is pressed and transmitted when the configuration is used.

For AirLink CDMA (Multicast UDP)

• **Config Multicast**: opens the *Base Multicast Parms* screen.

**Base Multicast Parameters**

The *Base Multicast Parms* screen sets IP addresses for communication between the base and several rovers using the UDP protocol.

• **Address to add**: the field for IP address input
• **IP addresses list**: displays all IP addresses available
• **Delete**: deletes the highlighted IP address
• **Add**: adds a new address specified in the *Address to add* field to the list of IP addresses

• **OK**: returns to the *Config: Base Radio* screen where all the settings will be saved after the *Finish* button is pressed and transmitted when the configuration is used.

In Multi-Port mode there will be two *Config: Base Radio* screens to configure radios.

![Figure 2-30. Config: Base Radio1 Out](image)

**Config: Base (Static) Antenna**

The *Config: Base Antenna* (Config: Static Antenna) screen contains settings for the antenna connected to Base.

![Figure 2-31. Config: Base Antenna](image)

• **Ant Type**: the type of the Topcon antenna. It can be *CR-3, CR-3 with Cone, CR-4, CR-4 Cone, HiPer GD/GGD, HiPer Lite/Lite+, HiPer Pro, HiPer+, Legant 2, Legant3 with UHF, Legant E, MapAnt B, MGA-1, MGA-2, Odyssey, PG-A1, PG-A1 with*
ground plane, PG-A2, PG-A5, Regant-DD, Regant-SD, Regency-DD, Regency-SD, or Unknown.

- **Ant Ht**: the height of the antenna.
- **Meas Type**: the type of antenna height measurement; either **Vertical** (measuring to ARP, antenna reference point) or **Slant** (measuring to edge of antenna). The screen also illustrates the measurement type.
- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Rover Receiver** screen. In the PP Static case, the **Config: Occupation Times** screen is opened.
- **Finish**: saves the changes and returns to the **Configurations** screen.

### Config: Rover Receiver

The **Config: Rover Receiver** screen contains Rover settings.

- **RTK Format**: the format of the rover receiver differential corrections received from the base; either CMR, CMR+, RTCM 2.1, RTCM 2.2, RTCM 2.3, RTCM 3.0, Full (RTCM 1,31,3) or Partial (RTCM 9,34,3). The list of pre-defined formats changes its contents depending upon the job configuration chosen.
- **Elevation mask**: data from satellites with elevation angles below this value will not be used.
- **Back**: returns to the previous screen.
• **Next**: opens the *Config: Rover Radio* screen. When within the RT DGPS configuration, the *Config: Beacon, Config: WAAS, CDGPS Radio, Config: EGNOS, or Config: OmniSTAR* screen will open depending on the correction type on the *Config: Survey* screen.

• **Finish**: saves the changes and returns to the *Configurations* screen.

For *RTK and PP* survey type, the *Rover Receiver* screen has the following parameters:

![Config: Rover Receiver – For RTK and PP](Image)

• **RTK Format**: the format of the base receiver differential corrections transmitted to the rover. It can be CMR, CMR+, RTCM 2.1, 2.2, 2.3, 3.0, Full (RTCM 1,31,3), or Partial (RTCM 9,34,3).

• **Elevation Mask**: data from satellites below this elevation will not be used.

• **Raw Data Logging**: the set of logging parameters; log to the receiver, set the logging rate and select if the name of the receiver file is automatically set or user-defined. In the latter case, the corresponding dialog box will be displayed at the logging start.

• **Back**: returns to the previous screen.

• **Next**: opens the *Config: Rover Radio* screen.

• **Finish**: saves the changes and returns to the *Configurations* screen.
For PP Kinematic or PP DGPS surveys, the **Config: Rover Receiver** screen has the same parameters as for RTK and PP except the **RTK Format** field:

![Config: Rover Receiver](image1)

**Figure 2-34. Config: Rover Receiver – For PP Kinematic and PP DGPS**

- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Rover Antenna** screen.
- **Finish**: saves the changes and returns to the **Configurations** screen.

For RTK survey types, the bitmap on the upper-left corner displays the pop-up menu containing three items:

- **Output Ports**: sets the number of ports available for output of NMEA messages, and adds the **Num Out Ports** field to the **Config: Survey** screen.

![Config: Rover Receiver](image2)

**Figure 2-35. Config: Rover Receiver – Number Out Ports**

- **Laser Config**: when selected, the **Next** button opens the **Laser Config** screen.
- **Help**: accesses the Help files
Laser Config

The Laser Config screen contains typical laser parameters.

![Figure 2-36. Laser Config](image)

Config: Rover Radio

The Config: Rover Radio screen (Figure 2-37 on page 2-31) contains parameters for the radio modem connected to the Rover receiver.

- **Radio Modem**: the type of modem.
- **Receiver Port Connected to Radio**: contains the parameters of the connection port: port, parity, data, baud rate, the number of stop bits.
- **Defaults**: returns all the values to defaults in the Receiver Port connected to radio fields.
- **Config Radio**: displays parameters for the selected modem. The button changes its appearance or disappears depending upon the modem chosen.
• **Back**: returns to the previous screen.
• **Next**: opens the *Config: Rover Antenna* screen.
• **Finish**: saves the changes and returns to the *Configurations* screen.

For details, see “Config: Base Radio” on page 2-21.

In Multi-Port mode there will be several *Config: Rover Radio* screens to configure radios.
**Config: Beacon**

The **Config: Beacon** screen contains settings for a radio-beacon source of differential GPS corrections.

![Image of Config: Beacon](image)

- **Country**: the country where the radio-beacon differential service is located.
- **Station**: the station that provides broadcasting differential corrections for the rover.
- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Rover Antenna** screen.
- **Finish**: saves the changes and returns to the **Configurations** screen.
**Config: WAAS**

The *Config: WAAS* screen contains settings for the WAAS source of differential correction data.

![Config: WAAS Screen](image)

- **Channel 1** and **Channel 2**: two receiver channels that can be allocated to WAAS satellites.
- **WAAS PRN #**: the WAAS satellite’s PRN number.
- **GPS PRN #**: the GPS satellite’s PRN number, which is associated with the WAAS PRN number.
- **Ionospheric corrections**: enable/disable the use of ionospheric corrections from the WAAS satellite when computing positions:
  - **None**: ionospheric corrections are not used
  - **Apply if avail**: use ionospheric corrections if available
  - **Use sat only if avail**: use only the satellites for which ionospheric corrections are available.
- **Back**: returns to the previous screen.
- **Next**: opens the *Config: Rover Antenna* screen.
- **Finish**: saves the changes and returns to the *Configurations* screen.
**CDGPS Radio**

The *CDGPS Radio* screen contains settings for the CDGPS Radio to receive differential correction data.

![Figure 2-41. CDGPS Radio](image)

- *Receiver Port Connected to Radio*: contains parameters for the connection port: port, parity, number of data bits, baud rate, and the number of stop bits.
- **Back**: returns to the previous screen.
- **Next**: opens the *Rover Antenna* screen.
- **Finish**: saves the changes and returns to the *Configurations* screen.

**Config: EGNOS**

The *Config: EGNOS* screen contains settings for an EGNOS source of differential correction data.

![Figure 2-42. Config: EGNOS](image)
• **Channel 1** and **Channel 2**: up to two receiver channels can be allocated to an EGNOS satellite.

• **EGNOS PRN #**: the EGNOS satellite’s PRN number.

• **GPS PRN #**: the GPS satellite’s PRN number, which is associated with the EGNOS PRN number.

• **Ionospheric corrections**: enable/disable use of ionospheric corrections from the EGNOS satellite when computing positions:
  - **None**: ionospheric corrections are not used
  - **Apply if avail**: use ionospheric corrections if available
  - **Use sat only if avail**: use only the satellites for which ionospheric corrections are available.

• **Back**: returns to the previous screen.

• **Next**: opens the **Config: Rover Antenna** screen.

• **Finish**: saves the changes and returns to the **Configurations** screen.

**Config: OmniSTAR**

The **Config: OmniSTAR** screen contains settings for an OmniSTAR source of differential correction data.

![Figure 2-43. Config: OmniSTAR](image)

- **Satellite**: the satellite that delivers differential GPS corrections.
- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Rover Antenna** screen.
- **Finish**: saves the changes and returns to the **Configurations** screen.
The **Config: Rover Antenna** screen contains settings for the antenna connected to the Rover.

![Figure 2-44. Config: Rover Antenna](image)

- **Ant Type**: the type of the Topcon antenna. It can be *CR-3, CR-3 with Cone, CR-4, CR-4 Cone, HiPer GD/GGD, HiPer Lite/Lite+, HiPer Pro, HiPer+, Legant 2, Legant3 with UHF, Legant E, MapAnt B, MGA-1, MGA-2, Odyssey, PG-A1, PG-A1 with ground plane, PG-A2, PG-A5, Regant-DD, Regant-SD, Regency-DD, Regency-SD, or Unknown.*

- **Ant Ht**: the height of the antenna.

- **Meas Type**: the type of the antenna height measurement; either *Vertical* (measure to ARP, antenna reference point) or *Slant* (measure to edge of antenna). The screen also illustrates the measurement type.

- **Back**: returns to the previous screen.

- **Next**: opens the **Config: Survey Parms** screen. For RTK & PP and PP Kinematic surveys, the **Config: Init Times** screen opens that is the same as the **Config: Occupation Times** screen for PP Static survey.

- **Finish**: saves the changes and returns to the **Configurations** screen.
**Config: Init (Occupation) Times**

The *Config: Init (Occupation) Times* screen contains timing settings for the receiver logging, used in automatic mode during a PP Static Survey, and depends upon the number of satellites available and the number of frequencies used.

<table>
<thead>
<tr>
<th>Num SVs</th>
<th>Single Freq</th>
<th>Dual Freq</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>60</td>
<td>20</td>
</tr>
<tr>
<td>5</td>
<td>40</td>
<td>15</td>
</tr>
<tr>
<td>6+</td>
<td>20</td>
<td>10</td>
</tr>
</tbody>
</table>

*Figure 2-45. Config: Occupation Times*

The *Config: Init (Occupation) Times* screen contains settings for RTK&PP, PP Static and PP Kinematic modes. Occupation Times are the times required for ambiguity resolution (that is, the time required to estimate fixed ambiguity positions).

- **Num SV**: the number of satellites.
- **Single Freq**: the default occupation time in minutes for single frequency mode for a given number of satellites.
- **Dual Freq**: the default occupation time in minutes for dual frequency mode for a given number of satellites.
- **Back**: returns to the previous screen.
- **Next**: proceeds to the next screen (PP Static: *Config: Stakeout Parms*; RTK&PP and PP Kinematic: *Config: Survey Parms*).
- **Finish**: saves the changes and returns to the *Configurations* screen.
**Config: Survey Parms**

The *Config: Survey Parms* screen sets the parameters used by default during the survey. These parameters can be changed with the help of the Settings button from any Survey screen in GPS+ mode.

- **Solution Type**: sets the solution type for each epoch. It can be “Fix Only”, “Fix and Float”, “Fix, Float, DGPS”, “DGPS”, “DGPS, Auto”, or “All”.
  - **Fix**: positions were computed by the RTK engine using the carrier phase measurements from base and rover receivers. Integer ambiguities were fixed.
  - **Float**: positions were computed by the RTK engine using the carrier phase measurements from base and rover receivers. Integer ambiguities, however, were NOT fixed (their float estimates were used instead).
  - **DGPS**: that the positions were determined using only the pseudo-range measurements or carrier-phase pseudo-ranges.
  - **All**: positions were computed using all epochs accepted, including autonomous solutions.
  - **Auto**: autonomous positions when differential corrections are not available.

- The **Auto Accept** field sets parameters for automatic acceptance during a stationary survey. These are:
  - **Num Meas to Avg**: sets the number of measurements used for averaging, as needed.
- **Precision**: sets Horizontal and Vertical precision values, if to be taken into account. If both **Precision** and **Num Meas To Avg** are checked, both these conditions must be satisfied before the coordinates are accepted.

- The **Auto Topo** field sets parameters for kinematic surveys. These are:
  - **Method**: defines the method for measuring the interval between the received epochs; by time, by horizontal distance, or by slope distance.
  - **Interval**: sets the value of this interval.

For PP Kinematic or PP DGPS, the **Config: Survey Parms** screen displays the following parameters:

![Config: Survey Parms](image)

- **Topo**: enter the number of epochs to log on each location.
- **Auto Topo**: sets the time interval between locations. Only this method is currently available.
- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Stakeout Parms** screen.
- **Finish**: saves the changes and returns to the **Configurations** screen.
The **Config: Stakeout Parms** screen sets the parameters that will be used by job during a stakeout. These parameters can be changed with the help of the Settings button from any Stakeout screen in GPS+ mode.

![Config: Stakeout Parms](image)

- **Hz Dist Tolerance**: sets when the graph will switch to a bull’s eye in Stakeout.

- **Reference Direction**: sets the reference direction for stakeout. The reference direction can be North, moving direction, the direction to the reference point, or a reference azimuth.

The **Store Staked Point As** field sets the rule for naming staked points:

- **Point**: sets the rule for defining names for the staked-out points (Figure 2-49 on page 2-41). It can be design point name, next point name, design point with a pre-defined prefix (that is, stk_01, where “stk_” is the prefix), design point with a pre-defined suffix.

  The choice of the prefix or suffix appears only when the corresponding item is chosen from the drop-down menu.

  Also, a specified numerical constant can be added automatically to generate the staked point name.
For instance, if the constant specified is 1000, and the design point is 100, the staked point would be named 1100 (that is, 100+1000). If the design point is alphanumeric, the constant will be appended to the name. For example, for the design point ALPHA, the corresponding staked out point will be named ALPHA1000.

– **Note**: sets the rule for setting Notes for the staked out points. It can be design point name, design point with a prefix, design point with a suffix. Also, it can be Station & Offset information.

If the Station & Offset option is activated, an edit box for entering alphanumeric prefix will appear. For the US, this prefix is “Sta”, for the international markets is “Cha”, and for the Korean/Japanese markets is “No.”. With this option
activated, depending on the choice for the prefix, TopSURV will automatically generate one note for each stakeout point as follows:

Sta5+5.5R5.0 or Cha505.5R5.0 or No.5+5.5R5.0

- **Solution Type** (for RTK, RTK&PP, Network RTK and RT DGPS modes only): defines the type of position solutions that should be used for the stakeout: **Fix Only; Fix and Float; Fix, Float, DGPS; DGPS; DGPS, Auto; or All.**

- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Advanced** screen.
- **Finish**: saves the changes and returns to the **Configurations** screen.

### Config: Advanced

The **Config: Advanced** screen sets several additional parameters for the GPS+ mode.

![Figure 2-51. Config: Advanced](image)

- The **Multipath reduction** is used when a signal received includes multiple reflections from nearby objects. Check the **Multipath Reduction** field to use this mode during the survey.
- **Co-Op tracking**: involves additional resources for acquisition of the signal, phase-lock and delay-lock loops.
- **Satellite system**: defines the system of satellites to use.
• RTK Position (only for RTK and Network RTK): selects the method of RTK corrections definition; either Extrapolation or Matched Epoch (sometimes described as asynchronous or synchronous, respectively).

• Back: returns to the previous screen.

• Finish: saves the changes and returns to the Configurations screen.

Total Station Configuration

To configure a total station survey, press the button in the TS Config field of the Select Survey Config screen.

Configurations

For TS configurations, the Configurations screen presents a list of available configurations for Total Stations. Editing and adding of a configuration are performed with the help of a Wizard.

```
Figure 2-52. Configurations
```

• Delete: deletes the configuration.

• Edit: changes the configuration settings.

• Add: adds a new Configuration.

• OK: returns to the Select Survey Configurations screen.
Config: Survey

The **Config: Survey** screen contains general settings for the configuration.

![Figure 2-53. Config: Survey](image)

- **Name**: the name of the configuration that will be displayed in the **Configurations** screen.
- **Type**: the type of the Configuration; either *Conventional*, *Reflectorless*, or *Robotic*.
- **Next**: opens the **Config: Instrument** screen.
- **Finish**: saves the changes and returns to the **Configurations** screen.

Config: Instrument

The **Config: Instrument** screen (Figure 2-54 on page 2-45) contains typical total station parameters and communication settings.

- **Manufacturer**: defines if a Topcon instrument is used. For the Conventional and Reflectorless surveys also Sokkia and Leica instruments, and for survey emulation the Manual Mode can be used.

- **Model**: sets the model of the total station, taking into account the type of the configuration. For Robotic types, only motorized models will be displayed in the drop-down menu.
Table 2-1 gives Topcon instrument models and their available functionality.

**Table 2-1. Instrument Model and Available Functionality**

<table>
<thead>
<tr>
<th>GTS Series – Conventional</th>
<th>AP-L1 – Conventional and Robotic</th>
</tr>
</thead>
<tbody>
<tr>
<td>GTS-220 – Conventional</td>
<td>GMT100 – Conventional</td>
</tr>
<tr>
<td>GTS-230/230W – Conventional (Bluetooth)</td>
<td>GTS 1/GTS 3 – Conventional</td>
</tr>
<tr>
<td>GTS-600 – Conventional</td>
<td>GRT 2000 – Conventional and Robotic</td>
</tr>
<tr>
<td>GTS-720/720W – Conventional</td>
<td>GPT 1000 – Reflectorless</td>
</tr>
<tr>
<td>GTS-800/810 – Conventional</td>
<td>GPT 2000 – Reflectorless</td>
</tr>
<tr>
<td>GTS-800A/810A – Conventional and Robotic</td>
<td>GPT 6000 – Reflectorless</td>
</tr>
<tr>
<td>GTS-820A – Conventional and Robotic</td>
<td>GPT 3000/3000W – Reflectorless</td>
</tr>
<tr>
<td>AP-L1A – Conventional and Robotic</td>
<td>GPT 7000/7000W – Reflectorless</td>
</tr>
<tr>
<td>GMT100 – Conventional</td>
<td>GPT 8000 – Reflectorless</td>
</tr>
<tr>
<td>GRT 2000 – Conventional and Robotic</td>
<td>GPT 8000A/8200A – Reflectorless and Robotic</td>
</tr>
</tbody>
</table>

Sokkia instrument models can be: SET3, SET4, SET5, SET300, SET400, or SET500.
Leica instrument models can be: TCR400, TCR700.

- **Back**: returns to the previous screen.
- **Next**: opens the *Config: Conn Mode* screen.
- **Finish**: saves the changes and returns to the *Configurations* screen.
**Config: Connection Mode**

The *Config: Conn Mode* screen selects the connection mode of the Total Station.

![Image](image.png)

Figure 2-55. Config: Conn Mode

- **Initial Connection**: the connection mode. Depending upon the type of the instrument, it can be the following:
  - For Conventional and Reflectorless modes: *Cable*
  - For Robotic (AP-L1, AP-L1A, GRT-2000): *Radios Only, Cable*
  - For Robotic (GTS-800A/810A): *Radios Only, RC2 with Radios, RC2 Only, Cable*
  - For Robotic (GPT-820A/8000A/8200A): *Radios Only, RC2 with Radios, RC2 Only, RC2W Only, Cable*

- **Back**: returns to the previous screen.
- **Next**: opens the *Config: Cable* screen.
- **Finish**: saves the changes and returns to the *Configurations* screen.
**Config: Cable**

The *Config: Cable* screen contains the parameters of the cable connection.

![Config: Cable Screen](image)

- *Cable Comm Settings*: the parameters for the cable connection: *Baud* (baud rate), *Parity*, *Data* (number of the data bits), and *Stop* (number of the stop bits).
- **Back**: returns to the previous screen.
- **Next**: opens the *Config: Radio* screen (for Robotic surveys), *Config: Mode* (for motorized Conventional or Reflectorless surveys), or *Config: Survey Parms* (for Conventional or Reflectorless surveys).
- **Finish**: saves the changes and returns to the *Configurations* screen.
**Config: Radio**

The *Config: Radio* screen sets the parameters of the modem connected to the total station.

![Config: Radio](image)

- **Type**: the type of the modem.
- **Radio Comm Settings**: sets radio communication parameters: parity, number of data bits, baud rate, and the number of stop bits.
- **Configure Radio**: opens either the *Pacific Crest* or *Satel RadioParms* screen.
- **Back**: returns to the previous screen.
- **Next**: opens the *Config: Mode* screen

*For Satel modems*

**Satel Radio Parameters**

The *Satel Radio Parms* screen sets the model of the Satel modem, the channel number, and the frequency of the Radio Modem (Figure 2-58 on page 2-49).
• **OK**: returns to the *Config: Radio* screen. All settings will be transmitted after pressing the **Finish** button.

### Config: Mode

The *Config: Mode* screen contains the parameter defining the turning ability of conventional total stations. This mode is available only for motorized instruments in Conventional and Reflectorless modes of operation.
Conventional and Reflectorless total stations that support Motorized and/or Auto Tracking mode include:

<table>
<thead>
<tr>
<th>Table 2-2. Total Stations that Support Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>GTS-800/810 – Motorized</td>
</tr>
<tr>
<td>GTS-800A/810A – Motorized and Auto Tracking</td>
</tr>
<tr>
<td>GPT-8000 – Motorized</td>
</tr>
<tr>
<td>GPT-8000A/8200A – Motorized and Auto Tracking</td>
</tr>
<tr>
<td>AP-L1 – Motorized and Auto Tracking</td>
</tr>
<tr>
<td>AP-L1A – Motorized and Auto Tracking</td>
</tr>
<tr>
<td>GMT-2000 – Motorized</td>
</tr>
<tr>
<td>GRT-2000 – Motorized and Auto Tracking</td>
</tr>
</tbody>
</table>

- **Enable Motor Turning**: sets the motor to active mode.
- **Auto Tracking**: if motor turning is enabled, sets the motorized total station into remote control, or a fully automatic mode of operation.
  - In **Non-Remote** mode, the instrument can be set to perform auto tracking, or auto aiming, tasks.
  - The **Auto Tracking** mode causes the total station to track the reflector as the surveyor moves from point to point.
  - The **Auto Tracking/Auto Aiming** mode causes the instrument to find the prism in the pre-defined region.
  - The **No Aiming/No Tracking** mode disables the total station operation program.
- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Search/Track** screen (for Robotic configurations) or the **Config: Survey Params** screen (for Conventional configurations).
- **Finish**: saves the changes and returns to the **Configurations** screen.
Config: Search/Track

The Config: Search/Track screen contains settings for the total station signal tracking in the Robotic mode. Depending on the selected total station being chosen, the parameters differ.

![Figure 2-60. Config: Search/Track](image)

- **Turning Speed**: sets the turn speed of a total station in revolutions per minute.
- **Start Search After**: sets the delay between the loss of the signal and the start of searching.
- **Pattern**: sets the program for tracking and searching.
  - **Normal** (for AP-L1A and GRT-2000) or **Pattern 1** mode searches for the prism at the point where the prism was lost. The instrument gradually searches in up and down directions, and will continue until the prism is found.
  - **High** (for AP-L1A and GRT-2000) or **Pattern 2** mode searches for the prism for a set amount of time. The instrument searches from up to down and continues until the prism is found, or after a maximum of six attempts.
  - **Auto tracking** mode changes to manual mode when the prism cannot be found within six attempts, and returns to the point where the prism was lost.¹

¹ For details, refer to the Instruction Manual “Automatic Tracking Total Stations. GTS-800A Series”.

---

Config: Survey
- **Trk Speed:** sets the speed for tracking. It can be slow, medium, or fast; or, in the case of GTS800a model, either Survey or Machine controlled.

- **Sensitivity:** sets the detection sensitivity of the accepted signal. It can be low, medium or high. This parameter is available for all instruments except GPT-8000A.

- **Track Light:** sets the light on the line of sight to be enabled or disabled.

- **Scan Range:** sets the width of the tracking signal. It can be narrow, middle or wide. Available only in the AP-L1A total stations.

- **Range:** sets the range of searching or tracking, in degrees, for the vertical and horizontal planes.

- **Back:** returns to the previous screen.

- **Next:** opens the **Config: Survey Params** screen.

- **Finish:** saves the changes and returns to the **Configurations** screen.

### Config: Survey Parameters

The **Config: Survey Parms** screen contains the default parameters that will be used during the survey. They can be changed with the help of the Settings button from any Survey screen.

![Figure 2-61. Config: Survey Parms – First Screen](image)

- **Meas Method:** sets the mode of side-shot measurements. It can be: **Sideshot-Direct, Sideshot Direct/Reverse, and Angle/Dist**
Sets-Dir/Rev. These methods are described in “Observations” on page 6-13.

- **Angle Sequence**: sets the sequence of measured angles. (Available in the Angle/Dist Sets-Dir/Rev mode.) Here FS is foresight point (the next occupation point), BS is backsight point (the previous occupation point), and Plunge term stands for flipping and rotating the total station telescope by 180 degrees. These are used for the reduction of the angle errors. Possible sequences are BS/FS Plunge BS/FS; BS/FS Plunge FS/BS; FS/BS Plunge BS/FS; BS Plunge BS/FS Plunge FS; or FS Plunge FS/BS Plunge BS.

- **Num Sets**: the number of measurement sets participating in the average. Here the Num Sets defaults to 1 and cannot be changed if Sideshot-Direct or Sideshot Direct/Reverse is selected in the Meas Method field. Selecting Angle/Dist Sets-Dir/Rev in the Meas Method field allows for NumSets to be greater than 1.

- **Tolerances**: the admissible deviation values of the horizontal and zenith angles and the distance.

- **Distance Averaging**: defines if the distance used is measured using one signal or the average of several signals.

- **Measure Reverse Dist**: enables reverse distance measurements. These are used for the reduction of the distance measurement errors.

- **Auto Advance Set**: sets the Automatic Repetition of the measurements to active mode, the survey automatically advances to the next set. This field can be enabled only for motorized surveys and only if a Meas Method of Angle/Dist Sets-Dir/Rev is selected.

- **Auto Accept Meas**: activates the review of automatic repetition needed to accept each measurement. This field can be enabled only for Robotic, non-RC2 surveys and only when a Meas Method of Angle/Dist Sets-Dir/Rev is selected.

- **Next**: opens the next Config: Survey Parms screen.

- **Finish**: saves the changes and returns to the main screen.
The next *Config: SurveyParms* screen contains the additional survey parameters.

![Figure 2-62. Config: Survey Parm – Second Screen](image)

- **Meas Type**: sets the order and the type of the measurements in one set. Here:
  - *HA*: horizontal angle
  - *VA*: vertical angle
  - *SD*: slope distance
  - *HD*: horizontal distance
  - *VD*: vertical distance
- **EDM mode**: determines the sensitivity of the distance measurements: *Coarse 1mm, Coarse 10mm* or *Fine 0.1mm, Fine 1mm*.
- **Prism Constant**: the parameter of the prism, characterizing the difference between the reflection plane and the center of the prism.
- **Point Guide**: check if it is desired to operate the tracking lights.
- **Non-Prism**: check to enable the non-prism mode.
- **AutoTopo** (only for the Robotic survey): the parameters of the automatic survey.
- **Back**: returns to the previous screen.
- **Next**: opens the *Config: StakeoutParms* screen.
- **Finish**: saves the changes and returns to the main screen.
Config: Stakeout Parms

As for the GPS+ mode, the **Config: Stakeout Parms** screen sets the default stakeout parameters. These parameters can be changed using the **Settings** button from any Stakeout screen in TS mode.

![Figure 2-63. Config: Stakeout Parms](image)

- **Hz Dist Tolerance**: sets when the graph will switch to a bull’s eye in Stakeout.
- **Reference Direction**: sets the direction assumed to be the referenced one during the stakeout. For now, it can be Instrument Reference only.
- The **Store Staked Point As** field sets the rules for staked points naming:
  - **Point**: sets the rule for defining names for the staked-out points. It can be design point name, next point name, design point with a pre-defined prefix (i.e., stk_01, where “stk_” is prefix), or design point with a pre-defined suffix.
  - **Note**: sets the rule for defining Notes for the staked-out points. It can be Design Point, Design PT Prefix, or Design PT Suffix.
- **Turn TS to Des Pt**: controls the way the total station turns toward the design point.
- **Back**: returns to the previous screen.
- **Next**: opens the **Config: Miscellaneous** screen.
- **Finish**: saves the changes and returns to the **Configurations** screen.
The **Config: Miscellaneous** screen is used to customize the user interface:

- **Display Coordinates after Measurement**: when checked, computed coordinates are displayed automatically after a total station measurement is performed and before the point coordinates are stored into the database.

- **Apply Earth Curvature and Refraction**: corrects the computed heights for Earth Curvature (Vertical Distance) and slope distances and vertical angles for atmospheric refraction.

- **Prompt for Rod Height**: when checked, prompts for a height of a Rod (Target) before a point is stored.

- **Prompt for BS Check**: when checked, will bring up the **Backsight Check** screen when the **Backsight Setup** screen is exited.

- **Prompt for Control Codes**: when checked, a dialog will appear to specify the control code and attribute before a surveyed point is stored.

- **Stakeout Sound**: makes a sound each time a point is staked-out.

- **Manual Stakeout Update (Robotic Only)**: when checked, the **Meas** button in a Stakeout screen must be pressed to make a measurement to the Robotic Total Station. When not checked, the measurements are recorded continuously. This applies to the Stakeout screens only.

- **Beep on Storing Points**: beeps each time a point is stored.
- **VA Zero at Level**: if checked, vertical angle measurements are oriented to be zero at the Horizontal (“Level”) direction. If this option is unchecked, vertical angle measurements are oriented to be zero at the vertical (“Zenith”) direction (default). Only certain Total Stations allow TopSURV to set this value. For this reason, ensure that this option is set to the same value in the total station as is set in TopSURV.

- **Use Horizontal Angle Left**: if checked, the horizontal angle measurements are shown in a counter-clockwise (“Left”) direction. If this option is unchecked, the horizontal angle measurements are shown in a clockwise (“Right”) direction (default). TopSURV will automatically set the Total Station to “HR” or “HL” depending on the selection.

- **Automatically display BS Setup screen**: if checked, the *Backsight Setup* screen displays automatically when attempting to access any of the screens involving total station observations.

- **Back**: returns to the previous screen.

- **Finish**: saves the changes and returns to the *Configurations* screen.

**Config: Coordinate System**

*Job ➔ Config ➔ Coord Sys* opens the *Coordinate System* screen. For details, see “Coordinate System” on page 2-5.

**Config: Units**

*Job ➔ Config ➔ Units* opens the *Units* screen. For details, see “Units” on page 2-9.
Config: Temperature/Pressure

Job ▶ Config ▶ Temp/Press opens the Temperature/Pressure screen to set parameters for Total station surveys.

![Temperature/Pressure Screen]

Figure 2-65. Temperature/Pressure

- Temperature: sets the temperature to allow for distance calculation.
- Pressure: sets the pressure to allow for distance calculation.

Display

Job ▶ Config ▶ Display opens the Display screen. For details, see “Display” on page 2-11.

Alarms

Job ▶ Config ▶ Alarms opens the Alarms screen. For details, see “Alarms” on page 2-12.
Menu Display

With the Config submenu, the appearance of the menus can also be modified. Some rarely used functions are not displayed, but can be enabled through the Config ▶ Menu Display submenu and the Config Menus screen.

Config Menus

The Config Menus screen displays the list of menus and submenus for each special submenu for the current job configuration.

![Config Menus Screen](image)

- **Menu**: the list of available menus.
- **Sub Menu to Display**: the list of the selected menu items available for display. Place a check mark near the item to display in the menu.
- **Use Icons**: check this box to display the menu items on the main screen as icons.
- **OK**: saves the changes and closes the screen.
Activate Modules

The Security screen, which can be called using the Config ▶ Activate Modules submenu, displays the device’s numbers and the IDs which were entered to activate the main features in TopSURV when the software started for the first time.

Figure 2-67. Security

- **Key Value 1,2**: the default key values of the controller
- **Activation IDs**: the codes needed to enable observation modes and usage of roads in TopSURV.
- **OK**: saves the ID values, and if allowed, provides access to the observation modes and creating and using roads (through the following submenus: Edit ▶ X-Sect Templates, Edit ▶ Roads, Stakeout ▶ Roads, and Stakeout ▶ Slope).
Import

To import data, click Job ▶ Import.

![Import Submenu](image)

Figure 2-68. Import Submenu

The Import function is used to add points, codes and attributes, Roads, Cross Section Templates, Point Lists and Localization from another job, file, or controller. Codes and attributes can be imported from Code Libraries, as well.

The bitmap in the upper-left corner of the screen displays the floating menu of the Help item.

**Import From Job**

To import from a job, click Job ▶ Import ▶ From Job.

**Select Job**

The Select Job screen (Figure 2-69 on page 2-62) selects the job for import. If there is no desired job in the Job List, press the Browse button to select a job from the disk. The second Select Job screen will be opened. Select starts the import process wizard.
The second Select Job screen helps browse directories on the controller to select a job.

- **Name**: the name of the imported file.
- **OK**: approves the selection and opens the Import screen.
Import From Job

The *Import From Job* screen selects the data to import and, if necessary, filters the imported points.

![Image of Import From Job screen]

**Figure 2-71. Import From Job**

- **Points**: select the points for import, from the drop-down menu:
  - *All Points*  
  - *By Type*  
  - *By Range and Code*  
  - *None*

- The following data can be imported along with points:
  - *Code Library*  
  - *Localization*  
  - *Point Lists*  
  - *Roads*

- **Back**: returns to the previous screen.

- **Next**: depending on selections, opens either the *Select Point List(s) to Import* screen, or *Select Point Type(s) to Import* screen, or *Select Roads to Import* screen if only *Roads* is checked and *All points* is selected.

- **Finish**: starts the import process if only *Code Library* and/or *Localization* items are chosen and *By Type*, or *By Range and Code*, or *By Type, Range and Code* are not selected. Otherwise, the button is not available.
Select Point Type(s) to Import

The Select Point Type(s) to Import screen is used to select the types of points to be imported if Code Library, Localization or Roads are checked (if points filter by type has been enabled in the Import From Job screen). This can be done by placing check marks in the list, next to the desired types of points.

Figure 2-72. Select Point Type(s) to Import

- **Point Types**: the list of the point types. The following types are available for import:
  
<table>
<thead>
<tr>
<th>Design Points</th>
<th>Control Points</th>
<th>Cogo Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Station</td>
<td>Topo Points</td>
<td>Offset Topo Points</td>
</tr>
<tr>
<td>Auto Topo Points</td>
<td>Sideshot</td>
<td>Offset</td>
</tr>
<tr>
<td>Remote</td>
<td>Reflectorless</td>
<td>BackSight</td>
</tr>
<tr>
<td>Stake Points</td>
<td>Stake Line</td>
<td>Check Points</td>
</tr>
<tr>
<td>Manually Typed</td>
<td>Tape Dimension</td>
<td></td>
</tr>
</tbody>
</table>

- **Check** and **Uncheck**: toggles the highlighted item(s) on or off, depending on the button being pressed. Press Ctrl while selecting to select more than one item.

- **Back**: returns to the previous screen.

- **Next**: opens Points to Import screen (if points filter by type, code and range has been enabled in the Import From Job screen). Otherwise, the button is not available.
Points to Import

The Points to Import screen filters the imported points.

![Points to Import Screen](image)

Figure 2-73. Points to Import

- **Points with Codes**: if set, all points with the selected codes will be imported.
- **Select**: opens the Code screen for code selection.
- **Range of Points**: select the points to import. These can be set by range ("-", ";" or "," can be used as a range separator) or by enumeration.
- **Back**: returns to the previous screen.
- **Next**: opens the Select Road(s) to Import screen (if Roads was checked in the Import From Job screen).
Code

The Code screen contains a list of available codes. All points with codes selected here will be imported.

Figure 2-74. Code

- **Uncheck**: removes the mark from the highlighted code.
- **Check**: marks the highlighted entries.
- **OK**: returns to the previous screen with the codes selected.

Select Road(s) to Import

The Select Road(s) to Import screen selects the roads to import along with the data. Select from the Roads list for import by placing check marks next to them.

Figure 2-75. Select Road(s) to Import

- **Roads**: the list of available roads in the selected job.
- **Check and Uncheck**: toggles the highlighted item(s) on or off, depending on the button being pressed.
• **Back**: returns to the previous screen.

• **Next**: opens the *Select Point List(s) to Import* screen (if *Point Lists* was checked in the *Import* screen).

**Select Point List(s) to Import**

The *Select Point List(s) to Import* screen is used to select the point lists (if available) to import along with the data. Place the check marks to select the lists to import.

![Select Point List(s) to Import](image)

- **Point Lists**: the list of available point lists in the selected job.

- Check and Uncheck: toggles the highlighted item(s) on or off, depending upon the button being pressed.

- **Back**: returns to the previous screen.

- **Next**: is not available.

- **Finish**: starts the import process.
Import Status

The Import Status screen reflects the import process and contains a progress bar and a comments window. The progress bar displays the percentage of the data being imported.

Press the Close button to return to the main screen.

Duplicate Objects

If the existing job contains points, roads or point lists with the same names as the imported job, the Duplicate Objects screen appears.

The Duplicate Objects screen is a warning that prevents the loss of points, roads or point lists when names of these imported objects coincide with existing ones.

- Overwrite: the imported object will overwrite the existing one.
- **Rename**: the imported object will be renamed. The new name should be noted in the corresponding field.

- **Prefix/Suffix**: the imported object will differ from the existing object by prefix or suffix. The prefix/suffix should be noted in the corresponding field.

- **Yes**: press the button to accept the decision.

- **Yes To All**: press the button to accept the same decision for all similar cases.

- **Skip**: press the button to skip the object without importing.

- **Skip All**: press the button to skip all the objects with names that coincide with the names of existing objects, without importing.

### Import From File

To import data from a file, click **Job ▶ Import ▶ From File**.

### From File

The **From File** screen imports points, roads, cross section templates, and localization from files with either pre-defined or custom formats. For a description of these formats, see Appendix A.

- **Data Type**: select the data type to import from the file: *Points*, *Point Lists*, *Code Library*, *Roads*, *X-Sect Templates*, *Localization*, *Surfaces (TINs)*, or *Multiple Types*. 
• **Format**: select the type of the file being imported:
  
  – For *Points* and *Point Lists* data types: FC-4, FC-5, GTS-6, FC-6/GTS-7, GTS-7 with strings, GT, DXF, DWG, SHP, LandXML, CR5, MOSS GENIO, NEZ, NEZ with strings, and Text (Custom Format)
  
  – For *Code Library* data type: TDD, XML, DBF.
    Code Library is a set of codes with attributes used in the job. Once created, it can be saved as a file with *.tdd, *.xml, or *.dbf extensions.
  
  – For *Roads* data type: SSS Road, TDS Road, MC Road, LandXML or TopSURV Road
  
  – For *X-Sect Template* data type: SSS Template, TDS X-Section Template or TopSURV Template
  
  – For *Localization*, currently only GC3 is available
  
  – For *Surfaces (TINs)* data type: DXF, DWG, LandXML
  
  – For *Multiple Types* data type: LandXML
  
  For *Points* and *Point Lists* data types the *Import From File* screen displays additional settings.

![Figure 2-80. Import From Text File](image)

• **Point Type**: the type of the imported points.
  
  – *Control Points*: the points with coordinates, known from the catalog; used for localization.
  
  – *Design Points*: points used as targets for stakeout.
Import

– *Topo Points*: the points collected during a stationary survey.
– *Auto Topo Points*: the points collected during a kinematic survey.

- *ASCII File Properties*: define the conditions of the imported file interpretation. These conditions use the same type for the attributes, and quotes for the text values. The *ASCII File Properties* field appears for a .txt imported files.
- *Next*: opens the *Import From Format* screen for the format being chosen in the *File Type* field.

**Import From Format**

The *Import From Format* screen browses directories from which to select the file to import data from.

![Figure 2-81. Import From Format](image)

- **Type**: specifies the extension for the filename.
- **Name**: the name of the imported file.
- **OK**: approves the selection and opens the *Coordinate System* screen. For text file types, the *Text File Format* screen opens.

For *Surfaces (TINs)* data type, **OK** opens the *Import Status* screen and starts the import process to save results into TN3 files.

When *Multiple Types* data type is chosen, the *Import from LandXML* screen opens.
Text File Format

The **Text File Format** screen imports a file of arbitrary text format.

*Delimiter* sets the separator symbol between data in the import file; either a space, a comma, tabs or other (select from the list).

*Header in First Row* check if the text file has a header.

*Select File Format* sets the order of fields in the selected file.

*Add Format* creates a new file format with the help of the *Custom Style* screen.

*Edit Format* changes the selected file format with the help of the same *Custom Style* screen.

*Back* returns to the previous screen.

*Next* opens the *Coordinate System* screen.

*Finish* opens the *Import Status* screen and starts the import process.
**Custom Style**

Using the arrows, move the necessary items from the left side of the screen (the *Available* column) to the right side (the *Order* column) in the desired order.

![Custom Style Table]

- **Save**: saves the File Style and returns to the *Text File Format* screen. A new string appears in the Select File format drop-down menu.
- **Close**: returns to the previous screen.

**Coordinate System**

The *Coordinate System* screen (Figure 2-84 on page 2-74) is similar to that described in the section “Coordinate System” on page 2-5.

This screen contains information about the coordinate system for the imported job.

The differences are:

- It is possible to set the Coordinate Type for the imported file. These can be: *WGS84, Datum, Grid, or Ground*.
- The distance units used in the file can be recalculated to *Meters, IFeet, or USFeet*. 
• **Finish**: opens the *Import Status* screen and starts import process. (See “Import Status” on page 2-68.)

**Import From LandXML**

For *Multiple Types* data type there is ability to choose specific data from the LandXML file to be imported: Point Lists, Parcels, Surfaces, and Alignments.

• **Next**: opens the *Select Data For Import* screen.
**Select Data For Import**

The *Select Data For Import* screen is used to choose objects for importing from LandXML files.

- **Objects**: the list of available objects in the selected LandXML file.
- **Check** and **Uncheck**: toggles the highlighted item(s) on or off, depending on the button being pressed.
- **Back**: returns to the previous screen.
- **Finish**: opens the *Import Status* screen and starts the import process.

![Select Data For Import Screen](image)

**Figure 2-86. Select Data For Import**
Import From Controller

To import a job from a device, click Job ▶ Import ▶ From Controller.

Import/Export Settings

The Import/Export Settings screen is used to set the Import/Export options for the data interchange with another controller device.

- **Com Port**: selects the Communication port. These can be COM1, COM2, IR Port, or Ethernet. Also there can be communication via Bluetooth.
- **Next**: opens the File Import Directory screen.
- **Finish**: closes the screen, starting import to the default (root) directory.
File Import Directory

The **File Import Directory** screen selects the destination directory for data import.

![File Import Directory Screen]

- **Back**: returns to the previous screen.
- **Finish**: opens the **Import Status** screen performing the import process to the chosen directory.
Export

To export data, click **Job ▶ Export**.

The bitmap in the upper-left corner of the screen displays the floating menu of the **Help** item.

**Figure 2-89. Export Submenu**

The Export function is used to export points, codes and attributes, Roads, Cross Section Templates, Point Lists, Localization, Road Survey and Raw Data from the current job to another job, file, controller, or session settings to the receiver. Codes and attributes can be exported to Code Libraries, as well.

The bitmap in the upper-left corner of the screen displays the floating menu of the **Help** item.

**Export to Job**

To export data to a job, click **Job ▶ Export ▶ To Job**.

**Select Job**

The **Select Job** screen (Figure 2-90 on page 2-79) selects the destination job to export to. If there is no desired job in the Job List, press the **Browse** button to select a job from the disk.
**Figure 2-90. Select Job**

- **Select:** press to start the export process wizard.

**Export To Job**

The *Export To Job* screen is used to select the code library, localization parameters, roads, and/or point lists that should be exported along with the data.

**Figure 2-91. Export To Job**

- **Points:** select the points for export, from the drop-down menu:
  - All Points
  - By Type
  - By Range and Code
  - By Type, Range and Code
  - None
The following data can be exported along with points:

- Code Library
- Localization
- Roads
- Point Lists

- Back: returns to the previous screen.
- Next: depending on selections, opens either one of the Select Point List(s) to Export screens, or Select Point Type(s) to Export screen, or Select Roads to Export screen if only Roads is checked and All points is selected.
- Finish: starts the export process if only Code Library and/or Localization items are chosen and By Type, or By Range and Code, or By Type, Range and Code are not selected. Otherwise the button is not available.

Select Point Type(s) to Export

The Select Point Type(s) to Export screen selects the types of points to export if Code Library, Localization or Roads are checked (if points filter by type has been enabled in the Export screen). Place check marks near the desired types.

![Figure 2-92. Select Point Type(s) to Export](image)

- Point Types: the list of point types. The following types are available for exporting:

  Design Points  Control Points  Cogo Points
  Base Station  Topo Points  Offset Topo Points
  Auto Topo Points  Sideshot  Offset
Check and Uncheck: toggles the highlighted item(s) on or off, depending on the button being pressed. Press Ctrl while selecting to select more than one item.

Back: returns to the previous screen.

Next: opens Points to Export screen (if points filter by code and range has been enabled in the Export To Job screen).

Points to Export

The Points to Export screen filters the exported points.

- Points with Codes: export all points with the selected codes.
- Select: opens the Code screen.
- Range of Points: selects the points to export. These can be set by range (“-”, “;” or “,” can be used as range separators) or by enumeration.
- Back: returns to the previous screen.
- Next: opens the Select Road(s) to Export screen (if Roads was checked in the Export To Job screen).
**Code**

The *Code* screen contains a list of available codes. All the points with the codes chosen here will be imported.

- **Uncheck**: removes the mark from the highlighted code.
- **Check**: marks the highlighted entries.
- **OK**: returns to the previous screen with the codes selected.

**Select Road(s) to Export**

The *Select Road(s) to Export* screen selects the roads to export along with the data. Place the check marks to select the exported roads.

- **Roads**: the list of available roads in the job.
- **Check and Uncheck**: toggles the highlighted item(s) on or off, depending upon the button being pressed.
• **Back**: returns to the previous screen.
• **Next**: is not available.
• **Finish**: opens the *Export Status* screen and starts the export process.

**Select Point List(s) to Export**

The *Select Point List(s) to Export* screen selects the Point Lists (if available) to export along with the data. Place check marks near the exported point lists.

![Select Point List(s) to Export](image)

- **Point Lists**: the list of available point lists in the selected job.
- **Check** and **Uncheck**: toggles the highlighted item(s) on or off, depending upon the button being pressed.
- **Back**: returns to the previous screen.
- **Next**: is not available.
- **Finish**: opens the *Export Status* screen and starts the export process.
Export Status

The Export Status screen reflects the export process and contains a progress bar and a comments window. The progress bar displays the percentage of the data being exported.

![Image of Export Status screen]

Press the Close button to return to the main screen.

Duplicate Objects

If the existing job contains points, roads or pointlists with the same names as the job that these are exported to, the Duplicate Objects screen displays.

![Image of Duplicate Objects screen]

The Duplicate Objects screen is a warning, that prevents the loss of points, roads or pointlists when names of these exported objects coincide with those of the selected job.

- **Overwrite**: the exported object will overwrite the existing one.
• **Rename**: the exported object will be renamed. The new name should be noted in the corresponding field.

• **Prefix/Suffix**: the exported object will differ from the existing object by prefix or suffix. The prefix/suffix should be noted in the corresponding field.

• **Yes**: press the button to accept the decision.

• **Yes To All**: press the button to accept the same decision for all similar cases.

• **Skip**: press the button to skip the object without exporting.

• **Skip All**: press the button to skip all the objects with names that coincide with the names of existing objects, without exporting.

**Export to File**

To export data to a file, click **Job ▶ Export ▶ To File**.

**To File**

The **To File** screen exports points, codes, roads, cross section templates, localization, roads survey and raw data to files with either pre-defined or custom formats. For a description of these formats, see Appendix A.

![Figure 2-99. To File](image)

• **Data Type**: select the data type to export to the file: **Points, Point Lists, Code Library, Roads, X-Sect Templates, Localization, Roads Survey, Raw Data** or **Surfaces (TINs)**.
• **Format**: select the file type to export data to:
  
  – For **Points** data type these are: FC-4, FC-5, GTS-6, FC-6/GTS-7, GTS-7 with strings, GT, DXF, DWG, SHP, Cut Sheet Standard, Cut Sheet User Defined, Check Sheet, PTL Sheet, LandXML, CR5, MOSS GENIO, NEZ, NEZ with strings, or Text (custom format).
  
  – For **Code Library** data type: TDD, XML, DBF.
  
  – Code Library is a set of codes with attributes used in the job. Once created, it can be saved as a file with *.tdd, *.xml, or *.dbf extensions.
  
  – For **Roads** data type these are: SSS Road, TDS Road, MC Road, Land XML, or TopSURV Road.
  
  – For **X-Sect Template** data type these are: SSS Template, TDS X-Section Template, or TopSURV Template.
  
  – For **Localization**, only GC3 for now.
  
  – For **Roads Survey** these are: X-Section Surveys or Find Station Report.
  
  – For **Raw Data** these are: FC-5, GTS-6, FC-6/GTS-7, LandXML, TDS Raw Data, or MOSS Survey. If LandXML is chosen, two check boxes become available to select the type of raw data to export: Export TS Raw Data and/or Export GPS Raw Data.
  
  – For **Surfaces (TINs)** data type these are: DXF, DWG, LandXML.

• **Select Types of the Points** (for **Points** data type only): check this field if not all types of points should be exported.

• **Use Filters** (for **Points** data type only): check this field if filters (by code and by range) should be used for exported points.

• **Stored Stakeout Points** (for **Points** data type only): check to export stored points saved by stakeout process.

• **ASCII File Properties** (for **Points** data type only): define the conditions of the exported file interpretation. These are the use of the same type for the attributes or not, and the use of quotes for
the text values. This field appears only for the text format of the exported file.

- **Next**: opens the *Select Point Type(s) to Export* screen (if Points data type is selected, and *Select Types of The Points* is checked); or the *Points to Export* screen (if Points data type is selected, *Select Types of The Points* is unchecked and *Use Filters* is checked); or the *Select TN3* screen if Surfaces (TINs) data type is chosen; or the *Export To File* screen for the format chosen in the *File Type* field (for all other cases).

### Select Point Type(s) to Export

The *Select Point Type(s) to Export* screen is similar to that described in the section “Select Point Type(s) to Export” on page 2-80, except for the behavior of the Next button. Here, Next opens the *Points to Export* screen (if Points data type was selected and Use Filters was checked in the To File screen) or the *Export To Format* screen.

### Points to Export

The *Points to Export* screen is similar to that described in the section “Points to Export” on page 2-81, except for the behavior of the Next button. Here, Next opens the *Export To Format* screen.
Select TN3

The Select TN3 screen is used to select a TN3 file to export data to DXF, or DWG, or LandXML files.

![Select TN3 File](image)

- **Type**: specifies the extension for the files being searched.
- **Name**: the name of the file whose data will be exported.
- **OK**: approves the selection and opens the Export To Format screen.

Export To Format

The Export To Format screen selects a destination directory and the name of the file.

![Export to Format](image)

- **Type**: specifies the file extension.
- **Name**: the name of the exported file.
Export

• OK: approves the selection and opens the Coordinate System screen. See “Coordinate System” on page 2-73. For text file types, OK opens the Text File Format screen.

Text File Format

The Text File Format screen exports a file of arbitrary text format.

![Text File Format Screen]

Figure 2-102. Text File Format

• Delimiter: selects the delimiting symbol between the data in the exported file. It can be space, comma, tab or other.

• Header in First Row: select to output a header in the file.

• Select File Format: sets the order of fields in the exported file.

• Add Format: creates a new file format with the help of the Custom Style screen.

• Edit Format: changes an existing file format with the help of the same Custom Style screen.

• Back: returns to the previous screen.

• Next: opens the Coordinate System screen. See “Coordinate System” on page 2-73.

• Press Finish to start the export process.
Custom Style

Using the arrows, move the necessary items from the left side of the screen (the Available column) to the right side (the Order column) in the desired order.

- **Save**: saves the File Style. A new entry appears in the Select File Style drop-down menu.
- **Close**: returns to the previous screen.

Export to Controller

To export a job to a controller, click **Job ▶ Export ▶ To Controller**.

Import/Export Settings

The **Import/Export Settings** screen sets the Import/Export options for the data interchange with another controller device.
- **Com Port**: selects the Communication port. These can be *COM1, COM2, IR Port*, or *Ethernet*. Also there can be communication via *Bluetooth*.

- **Next**: opens the **Files To Export** screen.

- **Finish**: closes the screen starting import to the default (root) directory.

**Files To Export**

The **Files To Export** screen browses directories to select the data to be exported.

- **Back**: returns to the previous screen.

- **Finish**: starts the export process of the selected files.
Sessions

To export a session to the receiver, click **Job ▶ Export ▶ Sessions**.

In the **Sessions** screen, the left panel contains a tree of the available receivers and their session plans. The right panel contains a list of sessions to export.

![Figure 2-106. Job Sessions](image)

- **▶** selects the session to export.
- **✗** deletes the session from the export list.
- *Goto sleep mode*: if checked, the receiver will be put to sleep mode.
- **Refresh**: refreshes the export list.
- **Export**: start the connection with the receiver.
- **Close**: closes the screen without performing export.

The bitmap in the upper left corner of the screen consists of two items:

- **Edit Session**: opens the **Sessions** screen. For details see “Sessions” on page 3-37.
- **Help**: opens Help files.
**Info**

To get job information, click **Job ▹ Info**.

**Job Info**

The **Job Info** screen contains information about the current job:

- **Job name**
- **Created by** (or created as Default)
- **Number of stored Points**
- **Points**
  - **Order by Name** (the first and the last point)
  - **Point Name**
- **Job size** on disk
- **Job created** (the time and date of job creation)
- **Job modified** (the time and date of job modification)
Mode

To set the instrument mode, click Job ▶ Mode.

Observation Mode

The Observation Mode screen also can be opened by clicking on the instrument icon on the upper-left corner of the TopSURV main screen.

![Observation Mode Screen](image)

- **Select Instrument Type**: sets the operation mode; either GPS+ or Total Station.
- **Use Bold Font**: if the normal font is not seen clearly on the controller, it is recommended to use the bold font.
- **Bluetooth**: the option for remote (wireless) control on short distances.

The bitmap in the upper-left corner of the screen displays the floating Help menu.
Edit

Edit menu includes the following menu items:

- Points
- Codes
- Point Lists
- X-Sect Templates (when Roads are activated)
- Roads (when Roads are activated)
- Raw Data
- Sessions (for GPS+ post processing modes only)

![Image of Edit Menu]

Figure 3-1. Edit Menu
Points

To edit points, click Edit ▶ Points.

The Points screen contains the list of stored points with coordinates and codes, and a set of tools for database operation. In the Point column, an icon explaining the special point type displays.

![Points Table]

**Figure 3-2. Points**

- **Find by Code:** opens the Find by Code screen to enter a code for searching for a point.
- **Find by Point:** opens the Find by Point screen to enter a point name (or a part of the name) for searching.
- **Find Next:** finds next point that satisfies the same conditions as the previous found point.
- **Delete:** deletes the point from the list.
- **Edit:** opens the Edit Point screen to edit point parameters: name, code, coordinates and/or other parameters stored along with the point.
- **Add:** creates a new point through the Add Point screen.
- The bitmap on the upper-left corner displays the following pop-up menu:
  - **PTL Mode:** switches on the PTL (Point-To-Line) Mode. (The screen changes its appearance on Points (PTL).) For details, see “PTL Mode” on page 6-16.

![Edit Button]
– **String**: switches on the strings displaying function along with the codes.

– **Help**: accesses the help files.

**Settings**: opens the *Display* screen.

## Display

The **Display** screen is used to customize the interface.

![Display Settings](image)

**Figure 3-3. Display**

- **Coord Type**: the type of coordinates displayed.
- **Coord Order**: the Northing/Easting order and height type of the local coordinates.
- **Azimuth Origin**: the reference direction of azimuth.
- **Disp Dir As**: selects whether to display the direction as bearing or azimuth.
- **Disp CL Pos As**: selects how to display the position on the center line: as station or chainage.
- **Ok**: saves the settings and returns to the *Points* screen.
Find by Point

The *Find by Point* screen contains settings for searching for a point by its name.

- **Point**: the name of a point or a part of the name.
- **Match entire name**: set if the whole name was entered in the *Point Name* field.
- **Match partial name**: set if a part of the searched name was entered in the *Point Name* field.
- **Search**: starts the search process and returns to the *Points* screen, highlighting the point found.
Find by Code

The Find by Code screen contains a form of searching for a point by its code.

![Figure 3-5. Find by Code](image)

- *Code*: the name of the code
- *Search*: starts the search process and returns to the *Points* screen, highlighting the first point with the code selected.

Add (Edit) Point

The Add (Edit) Point screen displays the form of the point properties.

![Figure 3-6. Add/Edit Point](image)

The Point Info tab contains the following fields:
- *Point*: sets the name of the point.
- *Code*: sets the code for the point. Can be entered manually or chosen from the drop-down list.
• : the Attributes List bitmap, opens the Code-Attributes screen to set the attributes for the code.

• The fields for the coordinates of the point in the current coordinate system (the field name changes with the display type).

• Control Point: check this field to use the point as the Control.

• Note: the short note for the point.

• The bitmap next to the Attributes List bitmap displays the following list:
  – String: toggles on the String field. Also, the sign appears. For details, see “Topo” on page 5-20.
  – Note: opens the Note screen. For details, see “Topo” on page 5-20.

• OK: saves the changes and returns to the Points screen.

If the PTL Mode is on, the Add (Edit) Point screen has the following parameters:

![Figure 3-7. Add Point (PTL)](image)

• Start Ref Pt, End Ref Pt: the reference points. Can be selected from map, from list or entered manually.

• PTL Offsets: the offsets from the reference line formed by the reference points:
  – Line: the distance from start reference point along the reference line, where the perpendicular to this line passes though the target.
– **Offset**: the horizontal distance from the target.
- **Ell ht**: the height of the target.
- **OK**: saves the changes and closes the screen.

**Code-Attributes**

The *Code-Attributes* screen sets attributes for the selected code.

![Figure 3-8. Code-Attributes](image)

- **Code**: shows the code selected.
- **Ctrl Code**: shows the control code list. The Control Code is a special type of code that can be used by the graphic tool for the interpretation of survey results.
- The lower field shows the available attributes and provides a field to enter its value.
- **Attrib Range**: opens the *Attribute Ranges* screen to view the ranges for the attributes.
- **Multiple Codes**: opens the *Multiple Code-Attributes* screen. Attributes can only be added using the *Codes - Attributes* screen (see “Codes - Attributes” on page 3-8).
Codes and Attributes

To edit codes and attributes, click Edit Codes.

Codes - Attributes

The Codes - Attributes screen contains a list of codes used for the survey, the list of attributes for each code, and a set of tools for editing the codes and attributes. Codes already in use cannot be edited or deleted.

- **Codes**: contains a list of codes.
- **Attributes**: contains a list of attributes for the selected code.
- **Del**: deletes the highlighted entry.
- **Edit**: opens the applicable Code or the Attribute screen with the properties of the highlighted entry.
- **Add**: opens the applicable blank Code or the Attribute screen. A new attribute can be added if at least one code exists and is highlighted.

The bitmap at the upper-left corner displays a pop-up menu:

- **Save As**: select it to export codes to the file.
- **Help**: accesses the Help files.
Code

The Code screen contains the parameters of a code:

- **Code Name**: the name of the code.
- **Line and Point**: selects the line and point plotting attributes for the linework.
- **OK**: saves the changes, closes the screen and returns to the Codes - Attributes screen.

Attributes

The Attributes screen contains the parameters of an attribute.

- **Attribute Name**: the name of the code attribute.
- **Type**: sets the type of the code attribute:
  - **Menu**: if the attribute value can only be selected from a list of available values.
– **Text**: if the attribute value is an alpha-numeric string.

– **Integer**: if the attribute value is an integer.

– **Real Number**: if the attribute value is a real number.

For the **Menu** type attribute, specify a set of admissible values, entered in the lower right field and added to the list with the **Add** button (Figure 3-11 on page 3-9).

- **X**: deletes the highlighted entry from the menu.

For **Text** type attribute, set the number of characters available for the text value.

![Figure 3-12. Attributes – Text](image)

For the **Integer** or **Real Number** type attributes, set the minimum and the maximum values of the attribute.

![Figure 3-13. Attributes – Integer](image)

- **OK**: saves the changes, closes the screen and returns to the **Code** - **Attributes** screen.
Point Lists

The Point List is a group of points that can be simultaneously processed. Point list is tightly integrated throughout TopSURV. Depending on the context, the points may or may not be connected with a line. A Point List with its points connected forms a polyline.

To use the Point Lists, select **Edit ▶ Point Lists**.

List of Point Lists

The **List of Point Lists** screen contains a list of existing Point Lists on the left part of the screen, and the two windows on the right part, that present the general view of the selected list in the horizontal and vertical planes. To view the current selected point list in a larger map, double-click one of the map plots.

![List of Point Lists](image)

Figure 3-14. List of Point Lists

- **Delete**: press to delete the Point List from the list.
- **Copy**: press to create a copy of the selected List.
- **Edit**: opens the **Edit Point List** screen. Press to edit the properties of the selected List.
- **Add**: opens the **Add Point List** screen. Press to create a new List.
- The bitmap on the upper-left corner displays the following pop-up menu:
  - **Edit Points**: displays the **Points** screen. For details, see “Points” on page 3-2.
  - **Help**: accesses the help files.
Add/Edit Point List

The *Point List* tab displays general properties of the Point List.

![Add Point List – Point List Tab](image)

**Figure 3-15. Add Point List – Point List Tab**

- **Point List Name**: the name of the Point List.
- **List of Points**: the list of currently selected points. Adding the point to the list can be performed in two ways.
  - Through the map: tap the plot on the right. The large *Map* screen opens. Select the points by tapping them on the map; the two sequentially tapped points will be connected with a line. Press *Close* to return to the *Add/Edit Point List* screen.
  - Through the Select Points button: pressing the button displays the floating menu of five items: *By Range*, *By Code*, *By CodeString*, *By Radius*, *From Map*, and *From List*. Select the desired way of adding points and enter in this way: set the range, check the codes, set the center point and the radius of the area, select the points from the map or using the list.
- **Point Info**: shows the point information of a current selected single point.
- The up and down arrows to the left of List of Points move the highlighted point up or down in the order of the points.
- : switches on/off the keyboard arrow keys that duplicate the arrows on the screen.
- : deletes the highlighted point from the list.
• 🔄: closes the plot of the point list. Only the list of points table will be available.

• The bitmap on the upper-left corner displays the following pop-up menu:
  – Edit Points: displays the Points screen. For details see “Points” on page 3-2.
  – Help: accesses the help files.

The Properties tab shows only the Name field, that duplicates the Point List Name on the Point List tab.

![Figure 3-16. Add Point List – Properties Tab]
**X-Sect Templates**

A Cross Section Template is a template for the creation of a complex cross-section view of the road. The Cross Section Template consists of several sets of segments, Cut Slope and Fill Slope.

The segment consists of an Offset and a Vertical Distance or a Slope (% or 1/n). The offset value is allowed only positive, and it is away from a center. The vertical distance is from an edge of the previous segment to an edge of the current segment.

The *X-Sect Templates* screen displays a list of the existing templates in the upper part of the screen and a plot of the highlighted template in the lower part.

![Figure 3-17. X-sect Templates](image)

The list contains four columns: *Name* (the name of the template), *Num Segs* (the number of segments), *Cut Slope* and *Fill Slope* values.

- **Delete**: deletes the template from the list.
- **Edit**: opens the properties of the selected template in the *X-Sect Templates* screen.
- **Add**: opens the blank *X-Sect Templates* screen.
- **Close**: saves the changes and returns to the main screen.
The **X-Sect Templates** screen contains parameters for the template.

![Figure 3-18. Edit X-Sect Template](image)

- **Name**: the name of the template.
- **Slope**: the Cut and Fill parameter values (Run values for cut and fill for a unit rise). These values represent the horizontal increment of the slope for a unit vertical increment. The Cut slope is used when the road surface is below the terrain, and the Fill Slope is used when the road surface is above the terrain.

Also the screen contains a list of segments comprising the template and a plot of the template. A list of segments consists of three columns: **Code** (the code of the segment), **Hz** (the horizontal offset), **Vert** (the vertical offset).

- **Delete**: deletes the segment from the template.
- **Edit**: opens the **Segment** screen with the parameters of the highlighted segment.
- **Insert**: opens the blank **Segment** screen. The added segment is inserted in the list above the currently highlighted segment.
- **Add**: opens the blank **Segment** screen. The added segment will be attached after the last segment in the list.
- **OK**: saves the changes and returns to the **X-Sect Templates** screen.
The Segment screen contains the parameters of the segment.

![Segment Screen](image)

**Figure 3-19. Segment**

- **Code**: the code of the segment. Select the code from the drop-down list or type a new code.

- **Offset**: the horizontal and vertical offsets. Press the Down/Up/Grade button to select the type and value of the vertical offset. Being input as Grade (in %), the vertical offset will be recalculated to meters (or other selected units) after the OK button is pressed.

**TIP**

The "hand" symbol means the function is selectable.

- **OK**: saves the changes being made and closes the screen.

Repeat the procedure for adding segments until the template is ready for work.
Roads

The road as an object can be described through the horizontal and vertical projections of the center line, called *alignments*, and the line describing the surface of the road and lying in the plane perpendicular to the center line, called a *cross section*.

The alignment can be divided into sections, each described with the help of algebraic functions. The horizontal alignment can be described through *lines, spirals, arcs* and *intersection points*. *Intersection point* is defined as the intersection of the two lines tangential to the 'incoming' and 'exiting' spirals, or to the central curve at the PC and PT points, if spirals are not specified.

The vertical alignment can be described through *vertical grades* and *parabolas, or long sections*. The cross section can be described using templates (see “X-Sect Templates” on page 3-14 for details).

The *Roads* screen displays a list of the created roads, and plots of the horizontal and vertical alignments for each road.

![Roads](image)

Figure 3-20. Roads

The left part of the screen displays the list of created roads. The right part shows the corresponding plots of alignments.

- **Delete**: deletes the road from the job.
- **Edit**: opens the *Edit Road* screen, displaying the parameters of the selected road.
- **Add**: opens the *Add Road* screen.
The first *Add Road* screen sets the name of the road and select the VAL (vertical alignment) type of the created road.

![Figure 3-21. Add Road – VAL Type Selection](image)

There are two ways of creating roads.

- **Long Section**: select Long Section to create the road by sections. The vertical alignment is presented as a set of sections between the stations where the heights are known (usually these are the extremes of the vertical alignment line), and the interval around the station where the vertical alignment line has a parabolic shape.

- **Elements**: select Element to create the road element by element, finishing wherever desired and starting again.

- **OK**: opens the second *Add Road* screen.

The second *Add Road* screen contains the features of the road.
Start Point

The Start Pt tab displays the parameters of the road’s starting point.

![Figure 3-22. Add Road – Start Pt Tab](image)

- **Point**: the point name. Can be entered manually (if a new point name is entered, the point will be created with the coordinates entered in the North, East and Height fields), chosen from the map, selected or from the list.
- **Code**: the point code. Can be entered manually or chosen from the drop-down list. The code of an existing point cannot be edited.
- ![Attributes List bitmap](image)
- **North, East, Height**: the local coordinates of the point.
- **Start Stn/ Start Chain**: the starting station number with distance to it, or the starting chain distance.
- **Stn Interval**: the interval between the points where the road related computations are made.
**Horizontal Alignment**

The $Hz$ tab shows the list of horizontal alignment elements, the horizontal alignment plot and the starting station (or chainage) of each element.

The element list has the following columns:

- **Element**: the icon and the name of the element: line, spiral, curve, or intersection point.
- **Length**: the length of the element.
- **Azimuth**: the azimuth at the beginning of the element.
- **Radius**: the radius of the curve, spiral or intersection point (the radius of the spiral is the radius at the end of the 'incoming' spiral or at the beginning of the 'exiting' spiral; the radius of the intersection point is the radius of the corresponding curve).
- **Delete**: deletes the element from the road.
- **Edit**: opens a screen with properties of the selected element.
- **Insert**: displays a floating menu from which to select elements for insertion at the selected location in the list.
- **Add**: displays a floating menu from which to select elements for addition after the last element.
Line

To add a line, press the Insert or Add buttons in the Hz tab of the Add Road screen and select the Line item from the floating menu. The Line screen will open.

![Figure 3-24. Line](image)

The plot at the bottom-left corner will show the element’s appearance.

- **Length**: the length of the line element.
- **Azimuth**: by default, the azimuth is set tangent to the previous element. This field is editable only for the starting element of the road. To change the azimuth of all other elements, the check mark from the Tangent to Previous Item menu on the bitmap in the upper-left corner of the screen should be removed.

**NOTICE**

Caution should be exercised when setting the azimuth, since road elements are usually tangential to each other.

- **OK**: saves the element to the Road and returns to the Add Road screen.
Curve

To add a curve, press the **Insert** or **Add** buttons in the **Hz** tab of the **Add Road** screen and select the **Curve** item from the floating menu. The **Curve** screen will open.

![Figure 3-25. Curve](image)

The plot in the bottom-left corner will show the element's appearance.

- **Radius/ Deg Chord/ Deg Curve**: the radius of the curve, or one of the two parameters unambiguously defining the radius: degree of chord, or degree of curve.

  Using the degree of chord (DCH) or degree of curve (DCV) parameters, the radius can be calculated as follows:

  \[ R = \frac{50}{\sin\left(\frac{DCH}{2} \times \frac{\pi}{180}\right)} \]

  \[ R = \frac{100 \times 180}{\pi} \times \frac{1}{DCV} \]

- **Length/Chord/Tangent/Mid Ord/Delta**: the length of the curve element, or one of four parameters unambiguously defining the curve length: chord, tangent, middle ordinate (the distance from the midpoint of a chord to the midpoint of the corresponding curve), or delta (the angle between the radii corresponding to the curve).

- **Azimuth**: by default, the azimuth is set tangent to the previous element. This field is editable only for the starting element of the road. To change the azimuth of all other elements, the check mark from the **Tangent to Previous Item** menu on the bitmap in the upper-left corner of the screen should be removed.
**NOTICE**

*Caution should be exercised when setting the azimuth, since road elements are usually tangential to each other.*

- **Turn:** the direction of turn. The *Right* value stands for clockwise direction, the *Left* value for counter-clockwise direction.
- **OK:** saves the element to the road and returns to the *Add Road* screen.

**Spiral**

To add a spiral, press the **Insert** or **Add** buttons in the *Hz* tab of the *Add Road* screen and select the *Spiral* item from the floating menu. The *Spiral* screen will open.

![Spiral Screen](image)

**Figure 3-26. Spiral**

The plot in the bottom-left corner displays the element’s appearance.

- **Radius/ Deg Chord/ Deg Curve:** the radius of the curve, or one of two parameters unambiguously defining the radius: degree of chord, or degree of curve (as shown in “Curve” on page 3-22).
- **Length/Sp Const:** the parameter is the square root of the product of the length and the radius of the spiral, as defined above. Consequently, the spiral constant has the units of length.
- **Azimuth:** by default, the azimuth is set tangent to the previous element. This field is editable only for the starting element of the road. To change the azimuth of all other elements, the check mark from the *Tangent to Previous Item* menu on the bitmap in the upper-left corner of the screen should be removed.
Caution should be exercised when setting the azimuth, since road elements are usually tangential to each other.

- **Turn**: the direction of turn. The *Right* value stands for clockwise direction, the *Left* value for counter-clockwise direction.
- **Dir**: the direction of movement along the spiral, TS to SC (entering the turn), or CS to ST (exiting the turn).
- **OK**: saves the element to the road and returns to the *Add Road* screen.

**Intersection Point**

To add an intersection point, press the **Insert** or **Add** buttons in the *Hz* tab of the *Add Road* screen and select the *Intersection Point* item from the floating menu. The *Intersection Point* screen will open.

![Intersection Point screen]

- **Point**: the name of the intersection point. Either enter the name manually (with the coordinates specified in the *North* and *East* fields and a height of zero), or select it from the map or the list.
- **North, East**: the local coordinates of the intersection point; cannot be changed for an existing point.

---

1. The traverse points on the turn have the following markers: TS - traverse-spiral; SC - spiral-circle; CS - circle-spiral; and ST - spiral traverse.
- **Radius/ Deg Chord/ Deg Curve**: the radius of the corresponding curve, or the parameter, unambiguously defining the radius, degree of chord, or degree of curve as shown in “Curve” on page 3-22.
- **Length1/Sp Const 1, Length2/Sp Const 2**: the length of the corresponding spiral elements, or the spirals constants. The spiral constants are defined as shown in “Spiral” on page 3-23.
- **OK**: saves the element to the road and returns to the Add Road screen.

**Vertical Alignment**

The Vert tab shows the list of vertical alignment elements, or long sections (for the Long Section vertical alignment type), the vertical alignment plot, and the starting station (or chainage) at each element.

In the case of the Element vertical alignment type, the element list has the following columns:

- **Element**: the icon and the name of the element: vertical grade or parabola.
- **Length**: the length of the element.
- **Start Grade, End Grade**: the grades of the element, in percentage, at the starting and ending points. For a Vertical grade element this values are the same.
In the case of the Long Sections vertical alignment type, the element list has the following columns:

- **Long Section**: the name of the element.
- **Station**: the station distance.
- **Elevation**: the elevation value on the station.
- **VC Length**: the vertical curve length is the length of the interval near the station, where the alignment has a parabolic shape.
- **Delete**: deletes the element from the road.
- **Edit**: opens a screen with properties of the selected element.
- **Insert**: displays a menu of elements for the Elements vertical alignment type or the blank Long Section screen, to insert an element at the selected location in the list.
- **Add**: displays a menu of elements for the Elements vertical alignment type, or displays the blank Long Section screen, for addition to the end of the list.

**Vertical Grade**

To add a vertical grade, press the **Insert** or **Add** buttons in the **Vert** tab of the Add Road screen and select the **Vertical Grade** item from the floating menu. The Vertical Grade screen will open.

![Vertical Grade Screen](image)

**Figure 3-29. Vertical Grade**

The plot in the bottom-left corner will show the element’s appearance.

- **Length**: the length of the vertical grade element.
• **Grade**: the grade of the element, in percents. If the grade is falling, the value should be set negative.

• **OK**: saves the element to the road and returns to the *Add Road* screen.

**Parabola**

To add a parabola, press the **Insert** or **Add** buttons in the **Vert** tab of the *Add Road* screen and select the **Parabola** item from the floating menu. The **Parabola** screen will open.

![Figure 3-30. Parabola](image)

The plot in the bottom-left corner will show the element appearance.

• **Length**: the length of the parabola element.

• **Start Grade, End Grade**: the starting and ending grades of the element, in percents. If the grade is falling, the value should be set negative.

• **OK**: saves the element to the road and returns to the *Add Road* screen.
Long Section

The *Long Section* screen contains parameters of the section.

![Figure 3-31. Long Section](image)

The plot in the bottom-left corner will show the element appearance.

- *Station*: the station distance from the beginning of the road.
- *Height*: the height at the station.
- *VC length*: the length of the vertical curve at the station. (It is assumed that the station is located in the middle of the interval.)
- **OK**: saves the element to the road and returns to the *Add Road* screen.
**X-Section**

The X-Section tab contains a list of stations, where cross section templates are applied. It also displays a general view of the cross section.

![Figure 3-32. Add Road – X-Section Tab](image)

The list of templates contains the following columns:

- **Station**: the station where the template is applied.
- **Left X Section, Right X Section**: the names of the templates for the left and right parts of the road relative to the center line. The left and right cross sections can be different.

**NOTICE**

*If two or more templates are defined, the intermediate cross sections are calculated using interpolation.*

- **Delete**: deletes the station from the list.
- **Edit**: opens the X-Section screen with properties of the selected cross section.
- **Add**: opens a blank X-Section screen.
The \textit{X-section} screen contains the parameters of the cross section.

![X-section screenshot](image)

- \textit{Station}: the station distance.
- \textit{Left X-Section, Right X-Section}: the cross section templates for the left and right parts of the road. These can be chosen only from the existing cross section templates.
- \textit{OK}: saves the X-section in the list and returns to the \textit{Add Road} screen.

**Properties**

The \textit{Properties} tab for now contains only the name of the road.

![Properties tab screenshot](image)

- \textit{OK}: saves the road and return to the \textit{Roads} screen.
After the Road is created, calculate the road points. The bitmap displays the menu of the following items:

- **Calculate Road Points**: opens the Calculate Road Points screen.
- **Edit Points**: opens the Points screen (see “Points” on page 3-2).
- **Help**: accesses the Help files.

## Calculate Road Points

The Calculate Road Points screen generates points along, to the right and to the left of the center line of the road, along all its entire length.

- **Points to Generate**: defines the points to generate - center line points, the points to the right of the center line, and/or the points to the left of the center line. Also, if it is desired to include the transition points, place the check mark in the corresponding field and select a prefix/suffix for them, if necessary, in the appearing field below.

- **Station Interval**: sets the interval between the generated points. By default it is the Station Interval set in the Start Pt tab in the Roads screen.

- **Next**: opens the CL Points Params screen.
The **CL Points Params** screen displays the parameters of points to be computed along the center line.

![Figure 3-36. CL Points Params](image)

- **First Point**: the name of the first point.
- **Code**: the code of the points being generated; enter manually or select from the drop-down list.
- **Code-Attributes**: accesses the attributes of the chosen code and opens the **Code-Attributes** screen (see “Code-Attributes” on page 3-7).
- **Prefix/Suffix**: when chosen, sets the prefix or suffix to be added to the generated point name.
- **Save points to Point List**: check if it is necessary to save the generated points to a separate points list. When checked, a field appears where the name for the list can be set.
- **Back**: returns to the previous screen.
- **Next**: opens the **Right Offset Points Params** screen.
The **Right Offset Points Params** screen displays the parameters of points to be computed to the right of the center line.

![Right Offset Points Params](image)

**Figure 3-37. Right Offset Points Params**

- **First Point**: the name of the first point.
- **Code**: the code of the points being generated; enter manually or chose from the drop-down list.
- **Code Attributes**: accesses the attributes of the chosen code and opens the **Code-Attributes** screen (for details see “Code-Attributes” on page 3-7).
- **Prefix/Suffix**: when chosen, sets the prefix or suffix to be added to the generated point name.
- **Save points to Point List**: check if it is necessary to save the generated points to a separate points list. When checked, a field appears where the name for the list can be set.
- **Offsets**: set the offset of the point from the center line along two dimensions: horizontal (the **Right** field) and vertical (the **Up/Down** field) relative to the surface (**Surface Offset** type) or to the horizontal line (**Flat Offset** type).
• **Back**: returns to the previous screen.
• **Next**: opens the *Left Offset Points Params* screen.

The *Left Offset Point Params* screen is similar to the *Right Offset Points Params* screen, except for the direction of the offset.

![Figure 3-38. Left Offset Points Params](image)

- **Calc**: calculates the points and stores them to the data set.

**Raw Data**

To edit raw data, click **Edit > Raw Data**.

![Figure 3-39. Raw Data](image)

This screen has the following columns:

- **Name**: point name and the icon displaying the type of the point
- **Type**: the type of measurement
- **Codes**: codes for the point
• *HI*: for the TS mode, the height of the instrument; or *Ant Ht*: for the GPS+ mode, the antenna height
• *Coordinates*: coordinates of the point
• *Ctrl Code*: control code
• *Notes*
• *Local Time*
• *First* and *Last*: moves the cursor to the first or last point.
• *Edit*: opens the *Edit Raw Data* screen to edit user-entered raw data.
• *Recompute*: recomputes the point coordinates after editing the point’s raw data.
• *Find by Point*: finds a point by its name or a part of its name.
• *Find by Code*: finds a point by its code or by a part of the code.
• *Find Next*: finds the next point that satisfies the same conditions as the previous found point.
• *Close*: closes the screen.

The button in the upper-left corner of the screen enables the menu of three items:

• *Job Info*: displays the *Job Info* screen.
• *Show Raw GPS+/TS*: toggles between displaying GPS+ raw data and TS raw data.
• *Help*: opens the Help files.


**Edit Raw Data**

The *Edit Raw Data* screen is used to edit the name and code of the surveyed point, and the antenna/instrument height at this point. The title of the first tab is the survey type for the point being edited.

The *Data* tab displays information on the point’s measurements.

---

*Figure 3-40. Edit Raw Data*

*Figure 3-41. Edit Raw Data – Data Tab*
NOTICE

For the base station, the Edit button opens the Coordinate screen to display the base coordinates available for editing.

Figure 3-42. Base Station Coordinates

Sessions

To create or edit session of the automatic survey for the post-processing, select Edit ‣ Sessions.

Figure 3-43. Sessions

- Sessions: a list of the available sessions. The table contains the following columns: ID, Type, Start Day, Start Time, End Day, End Time, and End Date.
Receivers: the list of the available receivers and their session plans. To hide/display the session plans of the receiver, tap on the “-/+” sign located near the receiver name.

Edit: press to edit the existing session. The Session Setup screen opens.

Add: (left) press to create a new session. The blank Session Setup screen opens.

Add: (right) press to add a receiver. Enter the receiver name in the Receiver Name screen being opened.

: use to put the session to the session plan of the receiver. In the Sessions screen highlight the desired session in the left panel and the necessary receiver in the right and press this button.

: use to delete the session from the sessions list or the receiver.

Press OK to save the changes and close the screen.

**Session Setup**

The Session Setup screen contains the parameters of the session.

![Figure 3-44. Session Setup](image)

- **Site Name**: the name of the occupation point.
- **Type**: the type of the session survey, static or kinematic.
- **Start Time, End Time**: the time and date of the start and end
- **Interval**: the interval between measurements,
• *Min SVs:* the minimum satellites available for the survey
• *Ant Type:* the type of the antenna.
• *Ant Ht:* the value and type of the antenna height.
• **OK:** saves the changes and returns to the Sessions screen.
The View menu contains the following menu items:

- Enable
- Zoom In
- Zoom Out
- Zoom Window
- Zoom All
- Zoom To Point
- Toolbar
- Properties

Figure 4-1. View Menu
Enable

To display the job map on the main screen, click View > Enable.

Zoom In/Out/Window

For display customizing, click View > Zoom In, or View > Zoom Out, or View > Zoom Window to zoom the plot inwards, or outwards, or scales the plot to fit it the screen, respectively.

Zoom All

To return the map to the initial view, click View > Zoom All.

Zoom To Point

To select a point for centering, click View > Zoom To Point and choose the point in the Select point screen.

Figure 4-2. Select Point
**Toolbar**

To display the bar of control buttons of viewing options, click View ▶ Toolbar.

![Toolbar Diagram]

**Figure 4-3. Toolbar**

- 🔫: zooms in
- 🔫: zooms out
- 🔫: selects a frame for display
- 🔫: displays all points in the job
- 🔫: opens the *Points* screen
- 🔫: opens the *Map Properties* screen
Properties

The Map Properties screen customizes the map view by adding properties to the points (names, codes, heights, etc.), displays the Auto Topo points, or sets the application to adjust the scale automatically (the Autoscale field).

![Figure 4-4. Map Properties](image)

To enable the points displaying, place a check mark in the Show Points field. Along with the points their names, codes, icons, heights, and/or auto topo points can be displayed.

Also it is possible to display alignments, turn on the linework on the map, perform autoscaling and start each time from the current position. Checking the Current Position field also means that if the current position moves off the edge of the map it will automatically snap back to the center.

Most TopSURV functions can be performed with the help of the Map view (Figure 4-5 on page 4-5). Depending upon the task, the appearance of the view changes. Mostly it duplicates the controls located on the main task page. But it also contains some controls that do not depend on the function being performed. These controls correspond to the viewing options and display customizing.
Figure 4-5. Topo – Map
GPS Survey

The Survey menu appearance depends upon the survey type selected and can include the following menu items:

- Status
- Start Base
- Init mmGPS+ (only for mmGPS+ RTK)
- Topo
- Auto Topo
- Known Point Init
- X-Section
- Find Station
- Tape Dimension
- Static Occupation (only for PP Static)
- Localization

Figure 5-1. RTK Survey Menu
Status

To check the status of a GPS+ survey, click Survey ▶ Status.

The Status screen contains information about the position of the receiver, RTK status, and the satellite constellation.

The bitmap in the upper-left corner of the screen displays a floating menu of the following items (if available):

- **Rover Antenna Setup**: opens the Antenna Setup Screen (see “Config: Rover Antenna” on page 2-36).
- **Config Radio**: opens the Configure Radio screen (see “Config: Rover Radio” on page 2-30).
- **Reset RTK**: reinitializes the receiver.
- **mmGPS+ Options**: opens the mmGPS+ Options screen.
- **Help**: accesses the Help files.

The Position tab displays the following information:

- **Total number of available satellites**: The lock icon signifies the number of the satellites tracked, the star icon shows the number of satellites used in position determination.
- **UTC**: the current UTC time.

![Figure 5-2. Status – Position](image)
- **WGS84**: the coordinates of the antenna in the selected coordinate system; this field changes its name based on the chosen value in the Coordinate System screen (see “Coordinate System” on page 2-5), Display screen (see “Display” on page 2-11), and the chosen distance units (see “Units” on page 2-9).

- **PDOP**: the PDOP value; a factor depending solely on satellite geometry describing how the uncertainty in the coordinates will depend on the measurement errors. PDOP is proportional to the estimated position uncertainty.

- **H and V**: stand for HRMS and VRMS, the RMS\(^1\) values of the horizontal and vertical coordinates, respectively.

- **Base Dist**: slope distance to base antenna. The field is empty if no differential corrections are received.

The **System** tab displays information about the current state of RTK measurements.

- **Position Type**: the type of the position calculation method: Autonomous, Fixed, Float, Code Differential.

- **Common Sats**: the number of satellites common to the base and rover.

- **Initialized Sats**: the number of satellites contributing to the solution.

\[1\] RMS means Root Mean Square – a factor that characterizes the precision of the collected coordinates.
• **Radio Link**: the quality of the radio link  
• **RTK Age**: the number of seconds since the last RTK message was received from the base.  
• **Receiver Memory**: the remaining memory of the receiver.  
• **Receiver Power**: the current receiver power value.  
• **Controller Memory**: the available memory in the controller.  
• **Controller Power**: the current controller power value.  
• **Settings**: opens the *Elevation Mask* screen.

**Elevation Mask**

The *Elevation mask* screen sets the value for the minimum threshold; data from satellites below this elevation angle will not be used.

![Elevation Mask](image)

- **Elevation Mask for**: sets the device of elevation mask application.  
- **Elevation Mask**: the value of the elevation mask.  
- **Set**: sends the current elevation mask to the base or rover receiver as chosen above.

The *Scatter Plots* tab (Figure 5-4 on page 5-4) displays the current receiver position changing in time: either the current receiver vertical position or the horizontal position relative to the position in a local (northing, easting) coordinate system.
Figure 5-5. Status - Scatter Plots

- : zooms the plot inwards.
- : zooms the plot outwards.
- : switches the vertical scatter plot to the horizontal one.
- : switches the horizontal scatter plot to the vertical one.
- "a": opens the Properties screen (Figure 5-6 on page 5-6) from which to set graphical features for the scatter plots.
GPS Survey

5-6

TopSURV Reference Manual

Figure 5-6. Properties

– *Time Window*: duration in seconds for the time axis.
– *Show Grid*: if checked, displays the local coordinate axes
– *Auto Zoom*: if checked, automatically scales the horizontal scatter plot to fit into the screen.

The *SVs* tab of the *Status* screen displays the graphical position of the satellites on the sky.

Figure 5-7. Status – SVs Plot

- *Show GPS*: shows/hides the GPS satellites images.
- *Show GLNS*: shows/hides the GLONASS satellite images.
  GLONASS satellites are marked with a “+” sign.
• **SNR**: toggles the appearance of the screen to a table displaying the signal-to-noise ratio of each of the satellites.

![Figure 5-8. Status – SVs SNR](image1)

• **List**: toggles the appearance of the screen to the table displaying the table of the satellites parameters.

![Figure 5-9. Status – SVs List](image2)

• **PRN**: shows the number of the satellite.
• **H/U**: shows whether healthy or unhealthy.
• **EL**: shows the elevation angle of the satellite.
• **AZ**: shows the azimuth of the satellite.
• **SNR1**: L1 signal to noise ratio.
• **SNR2**: L2 signal to noise ratio.
• **Back**: toggles between this screen and the sky plot view.
• **Close**: closes the screen.
NOTICE

The absence of “wings” on the satellite image means that the signal from this satellite is not used in the positioning for some reason (for example, below elevation cutoff).

Start Base

To start a Base survey, click Survey > Start Base.

The Start Base screen contains information about the Base receiver and can be used for the Base Receiver setting.

- **Point**: selects the name of the point of the Base receiver location from a map or list, or enter it manually.
- **Code**: the code of the point. Can be selected from the list, or entered manually. Also the attributes can be selected with the help of the Attributes List bitmap. The bitmap next to the Attributes List bitmap displays the list of additional features: String and Note. For details, see “Topo” on page 5-20.
- **WGS84**: (for RTK mode) the coordinates of the antenna in the selected coordinate system. Changes its name based on the chosen value in the Coordinate System screen; that is, WGS84 or Local (see “Coordinate System” on page 2-5), the Display screen (see “Display” on page 2-11), and the chosen distance units (see “Units” on page 2-9).
• **Auto Pos** (for RTK mode): measures the position of the current point. Once pressed, the button becomes a Stop button; press it to stop position averaging. The average of the coordinates displays and the *Pos* field appears with the number of measurements used for averaging.

• **Ant Ht**: the antenna height and type of measurement (vertical or slant).

• **Duration** and **Remaining Time** (for PP Kinematic mode): displays the time passed and remained since the beginning of the survey.

• **Start Base**: sets the receiver as a Base transmitting data.

The bitmap on the upper-left corner displays the pop-up menu which can display the following items depending on the survey type chosen:

• **Status**: opens the *Status* screen (see “Status” on page 5-2).

• **String**: toggles on the *String* field to enter a string for the code.

  Also, the 8 sign appears.

• **Base Antenna Setup**: opens the *Antenna Setup* Screen (see “Config: Rover Antenna” on page 2-36).

• **Config Radio** (for RTK mode): opens the *Configure Radio* screen. For details, see “Config: Rover Radio” on page 2-30.

• **Multi Base** (for RTK survey type): opens the *Multi Base* screen.
**Multi Base**

The *Multi Base* screen sets the multi base mode for RTK survey.

![Multi Base Screen](image)

- *Base Station ID*: the number of the current base station.
- *Transmit Delay*: signal transmission delay from the current base.
- *Use Multi Base*: enables multi base mode for surveying.

**Init mmGPS+**

To setup mmGPS+ system for RTK surveying, tap *Survey ➤ Init mmGPS+*.

The *Init mmGPS+* screen contains information about the calibration of the laser transmitter and initialization of the sensor.

The *Trans Data* tab (Figure 5-12 on page 5-11) calibrates the transmitter with the correct channel and communication port:
**Figure 5-12. Initialize mmGPS - Data Tab**

- **Name:** the name of the transmitter.
- **ID:** the ID that corresponds to the channel of the transmitter.
- **Data:** the status of calibration data.
- **Add:** opens the Transmitter screen to get the transmitter data.
- **Edit:** opens the Transmitter screen to change the information on the transmitter.
- **Delete:** removes the transmitter from the list.

The bitmap in the upper-left corner of the screen displays a floating menu of the following items:

- **Field Calibration:** opens the Calibration screen to set the transmitter to calibrate (that is, to fix errors in incline in the self-leveling mechanism of the transmitter).
- **Known Point Offset:** opens the Known Point screen.
- **Help:** accesses the Help files.
Transmitter

The Transmitter screen sets the transmitter parameters.

- **Name**: the name of the transmitter.
- **Com Port**: the communication port of the transmitter.
- **ID**: the channel of the transmitter.
- **Calibration Data**: the status of calibration data.
- **Clear Data**: clears the ID and Calibration Data fields.
- **Get Data**: retrieves the transmitter’s data.
- **OK**: returns to the Init mmGPS+ screen with the calibration data shown.

The Trans Pos tab allows setting up the transmitter’s height and location at the jobsite.
- **Name**: the name of the transmitter.
- **ID**: the channel of the transmitter.
- **Point**: the point over which the transmitter is setup.
- **Resect**: opens the *Resect* screen to perform resection for an unknown transmitter location.
- **Edit**: opens the *Known Point* screen to select the point over which the transmitter is setup.
- **Delete**: removes the transmitter from the list.

The *Sensor* tab uploads transmitter calibration information to the sensor and sets up the sensor for receiving the transmitter’s laser beam.

- **Receiver Port**: the receiver port that connects the receiver and sensor.
- **Transmitter ID**: the transmitter’s channel. The ANY selection will allow the sensor to independently select the transmitter with the smallest error rate.
- **Sensor Gain**: sets the sensitivity of the sensor to the transmitter’s laser beam.
- **Init Time Improvement**: check this box to improve the RTK fix time for the receiver.
- **Init Sensor**: starts the initialization process.
Resection

The Resect mmGPS+ screen is used to measure an unknown transmitter location using the rover and three or more points.

The Sensor tab is identical with the title tab on the Init mmGPS+ screen and used to set up the sensor.

- **Receiver Port**: sets the receiver port that connects the receiver and sensor.
- **Transmitter ID**: displays the channel of the transmitter.
- **Sensor Gain**: sets the sensitivity of the sensor to the transmitter’s laser beam.
- **Init Sensor**: starts the initialization of the sensor.
- **Init Time Improvement**: select to improve the RTK fix time for the receiver.
- **Known Trans Horz Pos**: if selected, then after pressing the Init Sensor button, the Known Point screen displays. Select the point over which the transmitter is setup.
Known Point

The Known Point screen is used to select the known point over which the transmitter is setup and enter the transmitter height.

![Known Point screen](image)

- **Point**: the point the transmitter is installed over. It can be selected using the map or list buttons.

- **Transmitter**:
  - **Name**: displays the name of the transmitter.
  - **ID**: displays the transmitter’s channel.
  - **Ht and m**: sets the height of the transmitter from the ground to the mark on the transmitter’s side and the method of height measurement.
  - **2m Fixed Tripod**: this box can be checked if using a 2 meter fixed tripod.

- **OK**: uploads the transmitter calibration information to the sensor.
The *Resect* tab is used to perform the resection calculation from the rover point to the point over which the transmitter is installed.

The upper-right corner of the screen displays information about the current state of measurement:

- ****: the mmGPS icon displays the sensor receives the transmitter’s beam.
- ****: the quality of the radio link.
- ****: the type of the position calculation method.
- **H 0.021 V 0.021**: the RMS errors for horizontal and vertical coordinates, respectively.
- ****: the number of the satellites tracked and used in position calculation, respectively.
- **Meas**: the number of measurement.
- **Known Point**: enable this when occupying a known point, and select a point to occupy using the map and list buttons.
- $H_t$ and $m$: the antenna’s height and method of height measurement.

- **Start**: starts the measurement process. After pressing, the button changes its name to **Stop**, and the counter of the epochs collected appears.

- **Logging**: displays the number of GPS epochs used in the resection calculation during the measurement.

The **Data** tab is used to view the results of resection measurements. Data will display only after three or more points have been measured.

![Figure 5-19. Resection - Data Tab](image)

- **Re-Meas**: clears all data and restarts the resection process.

- **Accept**: opens the **Add Point** screen to view the point information for the transmitter.
Add Point

The *Add Point* screen is used to view and save the transmitter location.

![Figure 5-20. Add Point](image)

Calibration

The *Calibration* screen selects the transmitter for field calibration.

![Figure 5-21. Calibration](image)

- *Transmitter Name*: the name of the transmitter to calibrate
- *Next*: starts the process of auto-leveling.
- **Next**: opens the *Calibrate* screen with instructions to follow.

After the auto-leveling process completes, pressing the *Calibrate* button collects calibration data.
Topo

To set up a survey with topo points, click **Survey ▶ Topo**.

The **Topo** screen records stop and go survey.

The **Topo** tab contains the initial data for the survey and displays the progress of the survey. The upper-right corner of the screen displays the status of information on the **Status** screen. For details, see “Status” on page 5-2.

- The bitmap on the upper-left corner displays the following pop-up menu:

  - **Status**: opens the **Status** screen (see “Status” on page 5-2).

    In the multi-base mode a new **Multi Base** tab (Figure 5-25 on page 5-21) appears.

    The table displays a list of the bases with their parameters (age, link quality, type, etc.) from which to select the base to use by placing a check mark in the **Use** column in corresponding string.
– **Rover Antenna Setup**: opens the *Antenna Setup* screen (see “Config: Rover Antenna” on page 2-36).

– **Config Radio**: opens the *Configure Radio* screen. For details, see “Config: Rover Radio” on page 2-30.

– **Reset RTK**: resets the ambiguities and sets the receiver in the Rover RTK mode. The settings being used are based on the selections in the survey configuration.

– **Notes**: opens the *Notes* screen (see below).

– **Edit Points**: opens the *Points* screen.

– **Inverse**: opens the *Two-Point Inverse* COGO task screen. For details see “Inverse” on page 8-2.

– **PTL Mode**: switches on the PTL (Point-To-Line) Mode. (The screen changes its appearance to *Topo (PTL).*.) For details see “PTL Mode” on page 6-16.

– **Help**: accesses the Help files.

- **Point**: displays the current point name.
- **Code**: displays the current point code. Can be entered manually or chosen from the drop-down list.

- : click on this icon to open the *Code-Attributes* screen to set the attributes for the selected code.
The **Code-Attributes** screen sets attributes for the selected code.

![Code-Attributes Screen](image)

- **Code**: shows the code selected.
- **Ctrl Code**: shows all the control codes used. The Control Code is a special type of code that can be used by the graphic tool for the interpretation of the survey results.
- The field below shows the available attributes with a field to enter its value.
- **Attrib Range**: opens the **Attribute Ranges** screen.

![Attribute Ranges Screen](image)

- **Multiple Codes**: opens the **Multiple Code-Attributes** screen (Figure 5-28 on page 5-23).

To add several codes, attributes and control codes to an object, use the Multiple Codes tool.
– **Add/Edit**: opens the *Code-Attributes* screen to add/edit a code string to the table.

– **Delete**: removes the code string from the table.

– **OK**: saves the changes and returns to the *Topo* screen.

The String and Ctrl Code fields appear only if the *String* and *Show Second Ctrl Code* options have been enabled, respectively, in the pop-up menu opened by the bitmap in the upper-left corner of the screen.

- The bitmap next to the *Attributes List* bitmap displays the following list:

  – **String**: toggles on the *String* field on the *Topo* tab. Also, the sign appears.

![Figure 5-28. Multiple Code - Attributes](image)

![Figure 5-29. Topo – String](image)
– **Note**: opens the **Note** screen. The **Note** screen is used for additional information. The text of the note should be typed in the **Note** field. Press **OK** to store the Note.

![Figure 5-30. Note](image)

- **Ant Ht**: sets the antenna height and its type (slant or vertical).
- **Epoch count**: shows the number of accepted epochs.
- **Rem Time**: shows remaining time to stop logging when in PP Kinematic or PP DGPS mode.
- **String** is a specifying parameter for a code for grouping of objects with one code according to some specified attribute. For example, the code “tree” also has “Jones” string. When processing the points, only trees with the Jones string will be taken into consideration, not any other trees.
- **Start**: starts the survey process. After pressing, the button changes its name on **Accept** and a new button **Cancel** appears along with the counter of the epochs collected (Figure 5-31 on page 5-25).
- **Settings**: opens the *Survey Parameters* screen. See “Config: Survey Parms” on page 2-38.

- **Start Log** (for RTK&PP, PP Kinematic, and PP DGPS): starts logging file in the receiver. When pressed, the button changes its appearance to **Stop Log**.

In the PP Kinematic mode, instead of an icon displaying the RTK status, the symbol ![log_file_icon] displays, showing the status of the log file. If the file is opened, it changes its appearance to ![opened_log_file_icon] .

When file logging is started, the **Status** screen also displays the **Log History** tab.

The **Log History** tab graphically displays the usage of satellites over time. The field is divided to 5-minute portions along dotted lines with the starting time and each next hour marked.
If the base is started in autonomous mode, and an observed Topo point has known coordinates stored in the job, the *Duplicate Points* screen displays additional options to correct the base coordinates.

- **Overwrite**: overwriting is not available in this case.
- **Rename**: the point will be renamed. The new name is noted in the field. It will be the point with observed coordinates.
- **Store As Check Point?**: if selected, the observed point will be stored as check point.
- **Correct Base**: if selected, the existing coordinates of the observed point will not be replaced by the coordinates of the observed point. Instead the known coordinates of this point will be used to correct the Base coordinates. After either closing the Topo screen or moving to another tab, recomputations are performed and the coordinates of all points are updated using the new Base coordinates.
The *Data* tab shows the result of the survey.

![Figure 5-34. Topo – Data](image)

The *Map* tab shows the stored point graphically and performs the same actions as the *Topo* tab. For a detailed description of the Map view see “Properties” on page 4-4.

![Figure 5-35. Topo – Map](image)

The icons displayed stand for the following fields:

- ![icon](image): the name of a point.
- ![icon](image): the code of a point.
- ![icon](image): attributes for the code.
• **Start**: toggles between the Start button and status icons on the right part of the screen. When pressed, changes its appearance to .

The Offsets tab sets the offset point for the measurement.

![Figure 5-36. Topo – Offsets](image)

- **Line**: opens the Line screen to define a point, set by the offset from a line.
- **Az Dis Ht**: opens the Azimuth-Distance-Height screen to define a point specified by the offset from a point.
- **Laser**: only available when a laser has been added in the Config Survey, opens either the Config Laser screen or the Laser BS Meas screen to define a point specified through a backsight.
- **Settings**: opens the Survey Parameters screen. See “Config: Survey Parms” on page 2-38.
Line

The **Line** screen is used to enter the parameters defining a point that are not available physically relative to some reference line.

![Diagram of Line screen](image)

**Figure 5-37. Line**

- **Reference Line**: a line is specified by two known or measured points. They can be selected from the map, from the list or measured directly.

- **Meas**: starts measuring the current location point.

- **Offset point**: sets the parameters of the offset point:
  - the name of a point
  - the code of a point (can be typed manually or chosen from the drop-down list)
  - the attributes of the code (can be entered through the **Attributes List** bitmap, see “Code-Attributes” on page 3-7 for details)
  - The bitmap next to the **Attributes List** bitmap displays the following list:
    - **String**: switches on the **String** field. (The sign also appears.)
    - **Note**: opens the **Notes** screen (see “Note” on page 5-24).

- **Offsets**: the offset values:
  - **Forward/Backward**: the distance from Point 2 to the projection of the target point along the **Line of Sight**.
– **Right/Left**: the distance from the target point to the line of sight, either to the left or right of the line.

– **Up/Down**: the height difference from the target point.

- **Store**: calculates the coordinates of the offset point and saves the point to the database.

- The bitmap on the upper-left corner displays the following popup menu:
  
  – **Antenna Setup**: opens the *Antenna Setup* screen (see “Config: Base (Static) Antenna” on page 2-26)

  – **Help**: accesses the Help files

- **Settings**: opens the *Survey Parameters* screen. See “Config: Survey Parms” on page 2-38.

### Azimuth-Distance-Height

The *Azimuth-Distance-Height* screen defines an offset point using the current point as a reference.

![Figure 5-38. Azimuth-Distance-Height](image)

- **Start Pt**: the starting point of the offset measurement.

- **Point**: the name of the new point.

- **Code**: the code of the new point. Can be entered manually or chosen from the drop-down list.
- The Attributes List bitmap opens the **Code-Attributes** screen (see “Code-Attributes” on page 3-7).

- The bitmap next to the Attributes List bitmap displays the following list:
  - **String**: enables the String field. (The ✂️ sign also appears.)
  - **Note**: opens the Notes screen (see “Note” on page 5-24).

- **Azimuth/Az to Pt**: sets the azimuth to the target point by value or by point.

- **Zenith Angle/Elev Ang/Vert Dist**: sets the zenith angle (zenith distance) to the target point, or vertical distance.

- **Horizontal Dist**: sets the horizontal distance between the current and the target point.

- **Store**: calculates and stores the point. The next screen shows the parameters of the current point, the PDOP value, the Sigma values, and the epochs logged counter.

- The bitmap on the upper-left corner displays the following pop-up menu:
  - **Antenna Setup**: opens the Antenna Setup screen (see “Config: Rover Antenna” on page 2-36).
  - **Help**: accesses the Help files.

- **Settings**: opens the Survey Parameters screen (see “Config: Survey Paras” on page 2-38).
**Laser BS Meas**

When the selected laser has an Encoder, the *Laser BS Meas* screen defines an occupation point and backsight azimuth or point.

![](image)

**Figure 5-39. Laser BS Meas**

- *Occ Point*: enter an occupation or select an occupation using the map or list buttons.
- *BS Azimuth / BS Point*: enter either a BS azimuth value or select a BS point using the map or list buttons.
- *OK*: saves the settings and opens the *Config Laser* screen for lasers with an Encoder.

**Config Laser**

For lasers with an Encoder, the *Config Laser* screen defines the laser height and point information.

![](image)

**Figure 5-40. Config Laser**
• **Occ Point**: enter an occupation or select an occupation using the map or list buttons.

• **BS Azimuth / BS Point**: enter either a BS azimuth value or select a BS point using the map or list buttons.

• **Laser HI**: enter the height of the device above the occupation point.

• **Point**: enter the name of the point being measured. Also, the sign appears.

• **Code**: displays the current point code. Can be entered manually or chosen from the drop-down list.

• **BS Meas**: returns to the Laser BS Meas screen to set up a new BS.

• **OK**: saves the settings and returns to the Topo screen.

**Config Laser**

When the selected laser does not have an Encoder, the Config Laser screen defines an occupation point and backsight azimuth or point, as well as defines the laser height and point information.

![Config Laser](image)

**Figure 5-41. Laser BS Meas**

• **Occ Point**: enter an occupation or select an occupation using the map or list buttons.

• **BS Azimuth / BS Point**: enter either a BS azimuth value or select a BS point using the map or list buttons.
- *Laser HI*: enter the height of the device above the occupation point.

- *Point*: enter the name of the point being measured. Also, the sign appears.

- *Code*: displays the current point code. Can be entered manually or chosen from the drop-down list.

- *OK*: saves the settings and returns to the *Topo* screen.

## Auto Topo Survey

To set up a survey with automatic topo points, click **Survey ➤ Auto Topo**.

The *Auto Topo* initiates a kinematic survey.

The *Auto Topo* tab contains the initial data for the survey and displays the progress of the survey. The upper-right corner of the screen displays the status of information on the *Status* screen. For details see “Status” on page 5-2.

- The bitmap on the upper-left corner displays the following pop-up menu:
  - *Status*: opens the *Status* screen (see “Status” on page 5-2).
  - *Topo*: opens the Topo screen (see “Topo” on page 5-20).
Auto Topo Survey

- **Rover Antenna Setup**: opens the **Antenna Setup** screen (see “Config: Rover Antenna” on page 2-36).

- **Config Radio**: opens the **Configure Radio** screen (see “Config: Rover Radio” on page 2-30).

- **Reset RTK**: resets the ambiguities and sets the receiver in the rover RTK mode. The settings being used are based on selections in the survey configuration.

- **Note**: opens the **Notes** screen (see “Note” on page 5-24).

- **Edit Points**: opens the Points screen (see “Points” on page 3-2).

- **PTL Mode**: switches on the PTL (Point-To-Line) Mode. (The screen changes its appearance to **Auto Topo (PTL)**.) For details see “PTL Mode” on page 6-16.

- **Point**: displays the current point name.

- **Code**: displays the current point code. Can be entered manually or chosen from the drop-down list.

- **Attributes List**: the Attributes List bitmap, opens the **Code-Attributes** screen (for details see “Code-Attributes” on page 3-7).

- The bitmap next to the Attributes List bitmap displays the following list:
  - **String**: switches on the String field. (The ¦ sign also appears.)
  - **Note**: opens the **Note** screen (see “Note” on page 5-24).

- **Ant Ht**: sets the antenna height and its type (slant or vertical).

- **Log Now**: immediately stores the current position of the receiver antenna.

- **Pause**: interrupts the survey. After pressing, the button changes its name to **Resume**.

- **Start**: starts the survey process. After pressing, the button changes its name to **Stop** and the **Pause** button becomes available.
• **Settings**: opens the *Survey Parameters* screen. See “Config: Survey Parms” on page 2-38.

![Figure 5-43. Auto Topo – Start](image)

The *Data* tab shows the properties of the last stored point: the Point name and its coordinates.

![Figure 5-44. Auto Topo – Data](image)
The Map tab shows the stored points graphically. All survey processes can be done through this page, as well as from the Auto Topo tab, as all the controls are duplicated.

![Auto Topo Map](image)

**Figure 5-45. Auto Topo – Map**

The icons displayed stand for the following fields:

- : the name of a point.
- : the code of a point.
- : the Attributes List bitmap, opens the Code-Attributes screen (for details, see “Code-Attributes” on page 3-7).
- : toggles between the buttons and status icons on the right part of the screen. When pressed, changes its appearance to .

For a detailed description of the Map view, see “Properties” on page 4-4.
Known Point Init

To set up a survey with known points, click Survey ▶ Known Point Init.

The Known Point Init screen initializes the receiver using known coordinates for the Rover station. It is used with single frequency receivers, and for quality control on dual frequency receivers.

![Known Point Init Screen](image)

- **Point**: sets the name of the point, and can be selected from a list or from a map.
- **WGS84**: the coordinates of the point in the current coordinate system. (Use the Job ▶ Config ▶ Coord Sys menu selection to change the system and the name of the field, its contents will also change.)
- **Ant Ht**: the height of the antenna reference point (ARP) above the mark, and the type of the height measurement (vertical or slant).
- **Initialize**: sends the information to the rover receiver.
- The bitmap on the upper-left corner displays the following pop-up menu:
  - **Status**: opens the Status screen (see “Status” on page 5-2).
  - **Rover Antenna Setup**: opens the Antenna Setup Screen (see “Config: Rover Antenna” on page 2-36).
  - **Config Radio**: opens the Configure Radio screen (see “Config: Rover Radio” on page 2-30).
  - **Help**: accesses the Help files.
X-Section
The X-Section function is similar to that of the Total Station mode, except for the measurement screens, which are the corresponding GPS+ measurement screens. For details, see “Cross-Section” on page 6-29 and “Topo” on page 5-20.

Find Station
The Find Station function is similar to that of the Total Station mode, except for the measurement screens, which are the corresponding GPS+ measurement screens. For details, see “Find Station” on page 6-31 and “Topo” on page 5-20.

Tape Dimension
The function is similar to that of the Total Station mode, except for the measurement screens, which are the corresponding GPS+ measurement screens. For details, see “Tape Dimension” on page 6-33 and “Topo” on page 5-20.
Static Occupation

In the PP Static mode of GPS survey, the Survey menu contains only two items: Status and Static Occupation. The Status screen is discussed in “Status” on page 5-2.

To open the Static Occupation screen, choose the PP Static configuration in the Select Survey Config screen (Job ➤ Config ➤ Survey) and select Survey ➤ Static Occupation.

![Figure 5-47. Static Occupation](image)

- The bitmap on the upper-left corner displays a floating menu of the following items:
  - Status: opens the Status screen (see “Status” on page 5-2).
  - Static Antenna Setup: opens the Antenna Setup Screen (see “Config: Rover Antenna” on page 2-36).
  - Help: accesses the Help files.
- Point: displays the current point name, which can be entered manually or chosen from the map or point list.
- Code: displays the current point code, which can be entered manually or chosen from the drop-down list.
- Code-Attributes: the Attributes List bitmap, opens the Code-Attributes screen (for details, see “Code-Attributes” on page 3-7).
- The bitmap next to the **Attributes List** bitmap displays the following list:
  - **String**: switches on the **String** field. (The \[8\] sign also appears.)
  - **Note**: opens the **Note** screen, (see “Note” on page 5-24.)
- **Ant Ht**: sets the antenna height and its type (slant or vertical).
- **Duration**: displays the time passed from the beginning of survey.
- **Settings**: opens the Static Receiver screen. (For details, see “Config: Base (Static) Receiver” on page 2-19.)
- **Start Occ**: starts the survey in the static occupation mode. When pressed, changes its appearance on **Stop Occ**.

## Localization

To set up a survey with localization, click **Survey** ➤ **Localization**.

Localization is used for transforming coordinates between a local system and a WGS84 system.

![Localization Screen](image)

The **Localization** screen contains a list of points used for localization, called control points. Their coordinates are known in both systems: Local and WGS84. Each point has a level of reliability specified with the values of the residuals along the horizontal and the vertical axes and the Control parameters, that shows the status of the point. The horizontal and vertical use of any of the control points can be changed.
by selecting the line and then clicking on the header of the H Control or V Control. This will toggle the display between “used” and “not used”.

- The bitmap on the upper-left corner displays a floating menu of the following items:
  - **Config Radio**: opens the Configure Radio screen. (For details, see “Config: Rover Radio” on page 1-28).
  - **Help**: accesses the Help files.
- **Keep scale 1.000**: preserves localization from scale transformation.
- **Details**: opens the *Localization Results* screen.
- **Remove**: removes the highlighted points.
- **Edit**: creates localization parameters, using the localization points.
- **Add**: opens the *Add Localization Point* screen to add a point to use in localization.
- **Settings**: opens the Survey parameters screen. For details, see “Config: Survey Parms” on page 2-38.

**TIP**

The more localization points used, the more precise the localization.
Add Localization Point

The Add Localization Point screen contains the coordinates of the control points.

The Local Point field contains the name and coordinates of the point in the local coordinate system.

- **Point**: sets the name of the control point. Select a point from the map, or from the list, or enter a new point name.
- **Use Horizontal**: specifies that a point should be used for the horizontal localization.
- **Use Vertical**: set if the point should be used for the vertical localization.

The WGS84 Point field contains the name and global coordinates of the control points.

- **Point**: sets the name of the control point. Enter a new point name, select a point from the map or from the list.

**Start Meas**: sets the control point to the current location. The Epoch Count field shows the number of the accepted epochs. The parameters of the logging are set through the Survey Parameters screen. If a point with such name already exists, the application will open the Point Check notification screen. Overwrite, rename, or store the point as a check point.

**OK**: saves the point and opens the Localization screen with a newly added point being displayed.
Localization Results

The Localization Results screen contains the calculated parameters of the localization: the global coordinates, the corresponding local coordinates, the scale parameter, the azimuth, and the plane slope angles (deflections) corresponding to north and east directions.

![Localization Results Screen]

Figure 5-50. Localization Results
Chapter 6

Total Station Survey

The Survey menu includes the following menu items for Total Station surveys:

- Occ/BS Setup
- Observations
- Resection
- Elevation
- X-Section
- Find Station
- Tape Dimension
- Missing Line (optional)
- Auto Topo (for Robotic Total Stations)
- Scanning (for Robotic Total Stations)
- Remote Control (for Robotic Total Stations)

Figure 6-1. TS Survey Menu
Occupations and Backsight Survey Setup

To set up a survey with localization, click Survey ▶ Occ/BS Setup.

Backsight Survey

The Backsight Survey screen contains Backsight station parameters. The BS Setup tab contains following parameters:

- **Occ. Point**: the name of the point where the total station is located.

- **Map**: opens the map for choosing the occupation point.

- The bitmap next to the Map icon in the Occ. Point field opens a floating menu of four items:
  - **From List**: opens the list of points.
  - **Resection**: opens the **Resection** screen from which to determine the occupation point coordinates by solving the resection task, using the known point’s coordinates.
  - **Elevation**: opens the **Elevation** screen.
  - **Properties**: opens the **Add/Edit Point** screen that displays the properties of the current point, or can create a new point if no point is chosen yet.
- **HI**: sets the height of the instrument above or below the mark (the HR value can be negative so points above the prism, such as those on a bridge, can be measured from below).

- **HR**: sets the height of the target above the mark.

- **BS Point (BS Azimuth)**: sets the backsight point location, or the direction to it.

- The bitmap next to the Map icon in the BS Point field displays the following list:
  - **From List**: opens the list of points.
  - **Multiple BS**: opens the Multi-Point BS screen, to involve several Backsight points for performing survey.
  - **Properties**: opens the Add/Edit Point screen that displays the properties of the current point, or suggests to create a new point if no point is chosen yet.

- **BS Circle**: displays the horizontal circle reading corresponding to the backsight point.

- The bitmap next to the BS Circle field displays the floating menu that suggests to set the BS Circle value to zero, azimuth, or to change the value by +/- 90 or 180 degrees.

- **Measure distance to BS**: set if the distance to backsight point should be measured.

- **Fixed HR at BS**: set if the height of the backsight point is fixed for the whole set of measurements. When checked, an additional HR box appears. This is useful when one target is mounted at the BS for the duration of an occupation and another is used for the sideshots.

- **Battery Status**: shows the battery and memory status for the controller.

- **Battery Status**: shows the battery status for the total station.

- **Communication Status**: shows the status of communication between the controller and total station.

- **Check BS**: opens the Check Backsight screen for the backsight point checking.
• **HC Set**: sets the horizontal circle as defined in the *BS Circle* field.

• **Meas BS**: measures the Backsight point.

• **Settings**: opens the *Mode* screen (see “Config: Survey Parms” on page 2-38).

• The bitmap on the upper-left corner displays the following pop-up menu:
  
  – *Edit Points*: opens the *Points* list (see “Points” on page 3-2).
  
  – *Edit Raw*: opens the *Raw Data* screen (see “Raw Data” on page 3-34).
  
  – *Remote Control* (for Robotic mode only): opens the *Remote Control* screen (see “Remote Control” on page 6-40).
  
  – *Config Link* (only for the Robotic mode): opens the *Configure Link* screen (see “Configure Link” on page 7-7).
  
  – *Inverse*: opens the *Inverse* COGO screen (see “Inverse” on page 8-2).

  – *Intersection*: opens the *Intersection* COGO screen (see “Intersection” on page 8-7).

  – *Help*: opens the Help files.

The *Data* tab displays the available values of the backsight point parameters.

![Figure 6-3. Backsight – Data](image)

- **HR** (Height of Rod/target) and **HA** (Horizontal Angle)
- **VA** (Vertical Angle) and **SD** (Slope Distance)
There are two fields in the top of the page that display the height of the instrument and the azimuth.

The *Map* tab shows all points in a graphic mode. For details on map properties and customizing, see “Properties” on page 4-4.

![Figure 6-4. Backsight – Map](image)

**Resection**

To access the *Resection* screen, click **Survey » Occ/BS Setup**, press the bitmap next to the Map icon in the *Occ. Point* field and select the *Resection* item.

The method of resection computes the coordinates of a point using measurements from two (or more) points with known coordinates.

![Figure 6-5. Resection](image)

- *Point*: the known point name. Can be selected from the map or from the list.
- *Code*: the known point code.
• **HR**: the height of the rod (target).

• **Meas**: takes the sideshot to the point.

• **Settings**: opens the **Mode** screen (see “Config: Survey Parms” on page 2-38).

• The bitmap on the upper-left corner displays the following pop-up menu:
  
  – **Edit Points**: opens the **Points** list (see “Points” on page 3-2).
  
  – **Inverse**: opens the **Inverse** COGO screen (see “Inverse” on page 8-2).
  
  – **Notes**: opens the **Note** screen for adding notes to the measurement session.
  
  – **PTL Mode**: switches on the PTL (Point-To-Line) Mode. (The screen changes its appearance to **Points (PTL)**.) For details, see “PTL Mode” on page 6-16.
  
  – **Remote Settings** (for Robotic mode only): opens the **Search/Track Parameters** screen (see “Config: Stakeout Parms” on page 2-55).
  
  – **Config Link**: (only for the Robotic mode): opens the **Configure Link** screen (see “Configure Link” on page 7-7).
  
  – **Options**: opens the Resection Options screen, that calculates along the scale factor and set the resection type: whether to calculate the height (3-D) or just the horizontal coordinates (2-D).
  
  – **Help**: opens the Help files.

The **Data** tab shows the results of the current measurement and the scale factor and standard deviations of the coordinates.

The **Map** tab shows all points in a graphic mode. For details on map properties and customizing, see “Properties” on page 4-4.
The Meas Set tab displays the result of the sideshots being done during one set.

- **Sd N, Sd E, Sd H**: displays Standard deviations for North, East and Height, respectively.
- **Ground to Grid**: displays the calculated scale factor.
- **Use Ctrl**: toggles through specific measurements in the resection, for example the horizontal angle, but not the vertical, or vice versa. The used measurements are listed in the Use column. For example, HVSD indicates that the Horizontal angle, Vertical angle and the Slope Distance were used.
- **Re-Meas**: replaces the current measurement with a new measurement.
- **Accept**: stores the new coordinates in the database.
**Elevation**

To access the *Elevation* screen, click **Survey ▶ Occ/BS Setup**, press the bitmap next to the Map icon in the *Occ. Point* field, and select the *Elevation* item.

Computation or estimation of elevation (vertical coordinate) will typically use measurements from two or more points with known coordinates.

![Figure 6-7. Elevation](image)

- **Point**: the known point name, which can be selected from the map or from the list.
- **Code**: the known point code.
- **HR**: the height of the rod (target).
- **Meas**: takes the sideshot to the point.
- **Settings**: opens the *Mode* screen (see “Config: Survey Parameters” on page 2-52).

- The bitmap on the upper-left corner displays the same pop-up menu, as for the Resection task.

The *Data* tab shows the results of the current measurement and the scale factor and standard deviations of the coordinates.

The *Map* tab shows all points in a graphic mode. For details on map properties and customizing, see “Properties” on page 4-4.
The *Meas Set* tab displays the results of the sideshots being done during one set, the same as for the *Resection* task.

![Figure 6-8. Elevation – Meas Set Tab](image)

The table represents the result list of the measurements being made: the residuals of the vertical and horizontal angles, the measured and initial parameters (HR, HA, VA, etc.) The *Ht Diff* column represents the difference between the calculated height and the height of that measurement.

- **Use Ctrl**: toggles through specific measurements in the resection, for example the horizontal angle, but not the vertical, or vice versa.
- **Re-Meas**: replaces the current measurement with a new measurement.
- **Accept**: stores the new coordinates in the database.
**Multi-Point Backsight**

To access the *Multi-Point BS* screen, click **Survey ➤ Occ/BS Setup**, press the bitmap next to the Map icon in the *BS Point* field and select the *Multiple BS* item.

Multiple backsight points can generate more precise measurements.

![](image)

**Figure 6-9. Multi-Point BS**

- **Point**: the known point name. Can be selected from the map or from the list.
- **Code**: the known point code.
- **HR**: the height of the rod (target).
- **Meas**: takes the sideshot to the point.
- **Settings**: opens the *Mode* screen (see “Config: Survey Parameters” on page 2-52).
  - The bitmap on the upper-left corner displays the same pop-up menu as for the Resection task.

The *Data* tab shows the results of the current measurement and the scale factor and standard deviations of the coordinates.

The *Map* tab shows all points in graphic mode. For details on map properties and customizing, see “Properties” on page 4-4.
The **Meas Set** tab displays the result of the sideshots being done during one set.

![Figure 6-10. Multi Point BS – Meas Set Tab](image)

The table represents the result list of the measurements being made: the residuals of the horizontal angles, the measured and initial parameters (HR, HA, etc.)

- **Use Ctrl**: toggles through specific measurements in the resection; for example the horizontal angle, but not the vertical, or vice versa.
- **Re-Meas**: replaces the current measurement with a new measurement.
- **Accept**: stores the new coordinates in the database.
Check Backsight

The *Check Backsight* screen contains information about the backsight point errors. Note, that HD and VD will not appear if only an azimuth (direction) has been entered for the backsight.

![Check Backsight Screen](image)

There are two fields in the top of the page for the height of the instrument and the azimuth.

- **Turn To BS** (available only for the Robotic mode): check to turn the total station to Backsight Point.
- **Check distance to BS**: set if necessary to check the distance to backsight point along with the angle measurement (when pressing the *Check* button).
- **Check**: checks the errors in angle and distance measurements and displays them on the screen.
- **HC Set**: sets the horizontal circle to the selected value.
Observations

Toggling between the sideshot modes is performed from the Measurement Method field in the two Mode screens opened by the Settings button in the Sideshot-Dir (Sideshot Sets-Dir/Rev, or Ang/dist Sets-Dir/Rev) screen (for a description of other parameters on this screen, see “Config: Survey Parms” on page 2-38):

- **Sideshot-Dir**: defines that the measurement to a single point is taken using the Direct position of the Total Station.

- **Sideshot Sets-Dir/Rev**: defines that the measurement to a single point is taken using the Direct Position and the Reverse Position of the Total Station (i.e., Plunge - Flip and Rotate the Total station by 180 degrees to get the reverse measurement). One set consists of one direct and one reverse measurement. These measurements are used to eliminate the Vertical and Horizontal circle centering errors. This measurement method is known as Multiple, in which case the word Multiple appears in the title of the sideshot screen.

- **Ang/dist sets-Dir/Rev**: defines that during the measurement, the instrument will use the specified Angle sequence to perform repeated measurements. The sequence of four measurements constitutes one set. One measurement is the backsight in Direct face or the Foresight in Reverse face in two positions of the Total Station. These measurements are used to eliminate centering errors in the horizontal and vertical circles.
Sideshot - Direct

The *Measurement* tab of the *Sideshot-Dir* screen contains the initial data for the performing single sideshots and displays the information during survey.

![Sideshot-Dir - Measurement Tab](image)

- **Point**: sets the current point name. During the survey the numerical part of the name changes automatically by one.
- **Code**: sets the Code for the current point. Can be entered manually or chosen from the drop-down list.
- **HR**: accesses the attributes of the chosen code, opens the *Code-Attributes* screen (for details see “Code-Attributes” on page 3-7).
- The bitmap next to the *Attributes List* bitmap displays the following list:
  - **String**: adds a string to the point (see “Topo” on page 5-20).
  - **Note**: opens the *Notes* screen (see “Note” on page 5-24).
- **BS Setup**: sets the height of the target above the mark (rod height).
- **BS Setup**: opens the *Backsight Survey* screen for setting the backsight point. The information displayed is the same as has been entered.
• The bitmap on the upper-left corner of the screen displays the following pop-up menu:
  – *Adv*: (Advance) opens the *Backsight Survey* screen for setting the next traverse point as the next occupation point. The current occupation point becomes the next backsight point.
  – *Edit Points*: opens the *Points* list
  – *Inverse*: opens the *Inverse* COGO screen
  – *Notes*: opens the *Notes* screen.
  – *PTL Mode*: opens the *PTL Mode* screen (see “PTL Mode” on page 6-16).
  – *Help*: opens the Help files.

• *Traverse Point*: if checked, opens the screen to set the coordinates of the point manually.

**TIP**

If more than two points have been tagged as Traverse Points, the ADV button displays a list box with all tagged Traverse points from which to select the next occupation point. Upon selecting OK, the Backsight screen displays and automatically updates, as in the case when one TP point is available.

• *Meas*: takes the sideshot to the point. The result is given in the information window.

• *Settings*: opens the *Mode* screen (see “Config: Survey Parms” on page 2-38).
PTL Mode

The Point-To-Line mode (PTL) is a method of interpretation of the point coordinates. The coordinates are defined through the two reference points. The line trace through these points is set as one axis and its perpendicular as another.

- **Start Ref Point, End Ref Point**: the names of the reference points. Select these points from the map or select from the list of points.
- **PTL Mode On**: enables the PTL mode.
- **OK**: saves the changes and returns to the previous screen.

The Data tab contains the results of the measurements along with the initial data.
The *Map* tab performs sideshots in the graphic mode. The buttons on the right duplicate the controls on the first page.

![Figure 6-16. Sideshot-Dir – Map Tab](image)

For details on map properties and customizing, see “Properties” on page 4-4.

In the *Sideshot Sets-Dir/Rev* and *Ang/dist Sets-Dir/Rev* modes a new *Meas Set* tab appears.

The page contains the data collected during the measurements, grouped by sets: one set for Multiple mode contains two measurements; one set of the Repeat mode contains four measurements).

![Figure 6-17. Ang/dist Sets-Dir/Rev – Meas Set Tab](image)

- The columns are:
  - Point: the name of the point.
  - Res HA: Difference of each HA measurement within the set from the average of all the HA’s in the set.
– Res VA: Difference of each VA measurement within the set from the average of all the VA's in the set.

– Res SD: Difference of each SD measurement within the set from the average of all the SD's in the set.

– HR: the height of the rod (target).

– HA: Horizontal Angle measurement within the corresponding set.

– VA: Vertical Angle measurement within the corresponding set.

– SD: Slope Distance measurement within the corresponding set.

- **Remove**: deletes all measurements from the set.

- **Re-Meas**: displays the sideshot page to measure a new set of angles.

- **Accept**: saves the measured point.

- **Settings**: opens the *Mode* screen (see “Config: Survey Parms” on page 2-38).

### Offsets

The *Offsets* tab contains a set of tools for defining the offsets.

![Figure 6-18. Offsets](Image)

- **Hz Angle**: defines a point using the horizontal angle from one point and the distance to another.
• **Hz-Vt Angle**: defines a point using the horizontal and vertical angles.

• **Dist. Offset**: defines a point giving the ability to add or subtract distances, horizontally and vertically.

• **2 Line ISection**: determines a point by the intersection of the two lines. Each line is defined by two points or two measurements.

• **Line & Corner**: determines a point on the corner using one line defined by two points and horizontal angle measurement.

• **Line & Offset**: determines a point distant from a line defined by two points.

• **Plane & Corner**: determines a point (Corner) by a plane defined by three points and horizontal and vertical angle measurements.

### Horizontal Angle Offset

The **Measurement** tab of the **Horizontal Angle Offset** screen contains data for definition of a point using the horizontal angle from one point and the distance to another.

![Figure 6-19. Horizontal Angle Offset – Measurement Tab](image)

- **Point**: name for the offset point to be stored.

- **Code**: code for the offset point to be stored. Can be entered manually or chosen from the drop-down list.

- **Attributes List**: the **Attributes List** bitmap, opens the list of available attributes (for details see “Code-Attributes” on page 3-7).
• The bitmap next to the Attributes List bitmap displays the following list:
  – String: switches on the String field on the Topo tab (for details, see “Topo” on page 5-20).
  – Note: opens the Notes screen (see “Note” on page 5-24).
• HR: sets the target height above the mark (rod height).
• Settings: opens the Mode screen for setting the backsight point.
• Side and Center: take measurements to Center and obtain vertical angle and horizontal angle measurements, then a Side measurement provides VA, HA, and distance measurements. With these two sets of measurements, the computation can be made for point at center of a tree; for example, when taking measurements, a comment will appear on the screen.
• The bitmap on the upper-left corner of the screen displays the following pop-up menu:
  – Edit Points: opens the Points list.
  – Edit Raw: opens the Raw TS screen (see “Raw Data” on page 3-34).
  – Inverse: opens the Inverse COGO screen (see “Inverse” on page 8-2).
  – Intersection: opens the Intersection COGO screen (see “Intersection” on page 8-7).
  – Note: opens the Notes screen. (See “Note” on page 5-24.)
  – Adv (Advance): opens the Backsight Survey screen for setting the next traverse point as the next occupation point. The current occupation point becomes the next backsight point.
  – PTL Mode: opens the PTL Mode screen (see “PTL Mode” on page 6-16).
  – Help: opens the Help files.
The following three tabs are similar to the Offset tasks:

- The *Data* tab contains the data collected during the offset measurement.

![Figure 6-20. Horizontal Angle Offset – Data Tab](image)

- The *Map* tab contains the graphic view and duplicated controls from the *Measurement* tab. For the details on viewing properties customizing, see “Properties” on page 4-4.

![Figure 6-21. Horizontal Angle Offset – Map Tab](image)

- The *Offsets* tab switches to another offset task.
Horizontal/Vertical Angle

The Measurement tab in the Horizontal/Vertical Angle mode contains data for definition of a point using the horizontal and vertical angles.

- **Point**: name for the offset point to be stored.
- **Code**: code for the offset point to be stored, which can be entered manually or chosen from the drop-down list.
- **HR**: sets the target height (Rod Height).
- **Prism**: stores horizontal distance and horizontal angle measurements (to prism).
- **VA**: combines vertical angle measurement with Prism mode measurements to determine point location.
- **HA/VA**: combines horizontal angle and zenith angle measurements with horizontal distance logged in Prism step to determine point location.
- **Settings**: opens the Mode screen for setting the backsight point.

The Data, Map and Offsets tabs are similar to that of the Horizontal Angle Offset measurement.
Distance Offset

The Measurement tab of the Distance Offset screen contains the data for definition of a point giving the ability to add or subtract distances, horizontally and vertically.

![Distance Offset - Measurement Tab](image)

Figure 6-23. Distance Offset – Measurement Tab

- **Point**: name for the offset point to be stored.
- **Code**: code for the offset point to be stored. Can be entered manually or chosen from the drop-down list.
- **Attributes List**: The Attributes List bitmap, opens the list of available attributes.
- The bitmap next to the Attributes List bitmap displays the same list as for the Horizontal Angle Offset task.
- **HR**: sets the target height above the mark (rod height).
- **Battery Status**: shows the battery and memory status for the controller.

After the sideshot is taken, the Enter Distance Offsets screen will be displayed. It contains the three parameters of the offset:

- **Forward/Backward**: sets the distance between the current point and the projection of the offset point on the line of sight.
- **Up/Down**: sets the height of the point relatively to the current position.
- **Right/Left**: sets the distance between the offset point and its projection, taking into consideration its location relative to the line of sight.
• **Meas**: performs the measurement.
• **Settings**: opens the *Mode* screen for setting the backsight point.
• The *Data*, *Map* and *Offsets* tabs are similar to that of the *Horizontal Angle Offset* measurement.

### Hidden Point

The *Measurement* tab of the *Hidden Point* screen defines a point on the ground surface, with a slanted rod touching the ground point. The rod has two targets.

![Figure 6-24. Hidden Point – Measurement Tab](image)

- **Point**: name for the offset point to be stored.
- **Code**: code for the offset point to be stored. Can be entered manually or chosen from the drop-down list.
- **HR**: the *Attributes List* bitmap, opens a list of available attributes.
- The bitmap next to the *Attributes List* bitmap displays the same list as for the *Horizontal Angle Offset* task.
- **Single**: toggles between the *Single* and *Repeat* sideshot modes.
- **Fine**: toggles between the *Fine* and *Coarse* sideshot modes.
- **Rod Pt1**: measures the first target on the rod.
- **Rod Pt2**: measures the second target on the rod.
Two Line Intersection

The Measurement tab of the Two Line Intersection screen contains data for determination of a point by the intersection of the two lines. Each line is defined by two points or two measurements.

![Two Line Intersection](image)

**Figure 6-25. Two Line Intersection – Measurement Tab**

- **Point**: name for the offset point to be stored.
- **Code**: code for the offset point to be stored. Can be entered manually or chosen from the drop-down list.
- **HR**: sets the target height above the mark (rod height).
- **Line 1 Pt1** and **Line 1 Pt2**: obtains measurements to determine the first and second points defining first line.
- **Line 2 Pt 1** and **Line 2 Pt 2**: obtains measurements to determine the first and second points defining second line.
- **Settings**: opens the Mode screen for setting the backsight point.

The Data, Map and Offsets tabs are similar to that of the Horizontal Angle Offset measurement.
**Line and Corner**

The *Measurement* tab of the *Line and Corner* screen contains data for determination of a point on the corner using one line defined by two points.

![Figure 6-26. Line and Corner – Measurement Tab](image)

- **Point**: name for the offset point to be stored.
- **Code**: code for the offset point to be stored. Can be entered manually or chosen from the drop-down list.
- ![Attributes List](image): the *Attributes List* bitmap, opens a list of available attributes.
- The bitmap next to the *Attributes List* bitmap displays the same list as for the *Horizontal Angle Offset* task.
- **HR**: sets the target height above the mark (rod height).
- **Line Pt1**: obtain measurements to determine first point defining a line.
- **Line Pt2**: obtain measurements to determine first point defining a line.
- **Corner**: obtain horizontal angle to locate point on line at corner.
- **Settings**: opens the *Mode* screen for setting the backsight point.

The *Data*, *Map* and *Offsets* tabs are similar to that of the *Horizontal Angle Offset* measurement.
Line and Offset

The Measurement tab of the Line and Offset screen contains data for determination of a point distant from a line defined by two points.

- **Point**: name for the offset point to be stored.
- **Code**: code for the offset point to be stored. Can be entered manually or chosen from the drop-down list.
- ![Attributes List bitmap]: the Attributes List bitmap, opens a list of available attributes.
- The bitmap next to the Attributes List bitmap displays the same list as for the Horizontal Angle Offset task.
- **HR**: sets the target height above the mark (rod height).
- **Line Pt1**: obtains measurements to first point on a line.
- **Line Pt2**: obtains measurements to second point on a line.
- **Settings**: opens the Mode screen for setting the backsight point.

After the lines are measured, the Enter Distance Offsets screen will be displayed. It contains the three parameters of the offset:

- **Forward/Backward**: sets the distance between the current point and the projection of the offset point on the line of sight.
- **Up/Down**: sets the height of the point relatively to the current position.
• **Right/Left**: sets the distance between the offset point and its projection, taking into consideration its location relative to the line of sight.

The *Data, Map and Offsets* tabs are similar to that of the *Horizontal Angle Offset* measurement.

### Plane and Corner

The *Measurement* tab of the *Plane and Corner* screen helps determine a point (Corner) using a plane defined with three points and an angle measurement.

![Figure 6-28. Plane and Corner – Measurement Tab](image)

- **Point**: name for the offset point to be stored.
- **Code**: code for the offset point to be stored. Can be entered manually or chosen from the drop-down list.
- **HR**: sets the target (rod) height above the mark.
- **Plane 1**: obtains measurements to determine first point in a plane.
- **Plane 2**: obtains measurements to determine second point in a plane.
- **Plane 3**: obtains measurements to determine third point in a plane.
• **Corner**: obtains horizontal and vertical angle measurements to determine corner point in a plane.

**NOTICE**

*The three points defining a plane must be not be collinear (all on the same line).*

• **Settings**: opens the *Mode* screen for setting the backsight point. The *Data, Map* and *Offsets* tabs are similar to that of the *Horizontal Angle Offset* measurement.

---

**Cross-Section**

The Cross-Section task surveys of the cross section. To start working, select the *Survey > X-Section*.

The *Cross Section* screen contains the settings of the station, where the cross section survey is to be performed.

![Cross Section Screen](image)

**Figure 6-29. Cross Section**

• **Road**: select the road from the drop-down menu, or from the list, if the road is not present in the *Roads* list.

• **Cl Code**: the code of the center line points. Insert manually, or select one from the drop-down list.

• ****: the *Attributes List* bitmap, opens the list of available attributes (for details see “Code-Attributes” on page 3-7).
The bitmap next to the Attributes List bitmap displays the following list:

- **String**: switches on the String field (see “Topo” on page 5-20).

*Station*: sets the station where the cross section is surveyed. For the first cross section, this field is shown only if the road is set.

*Interval*: the increment of distance towards the next station.

**NOTICE**

The Station and Interval fields appear only if the road is chosen.

*The bitmap in the upper-left corner of the screen displays the menu of two items:*

- **Edit Roads**: enables the Roads screen. See “Roads” on page 3-17.
- **Help**: opens Help files.

*OK*: saves the changes and opens the XSec-Direct screen.

The XSec-Direct screen performs the usual observation work relative to the cross section.

![Figure 6-30. XSec-Direct](image)

The survey is performed from one side of the road to another in a plane perpendicular to the center line. If the road has not been set, define the plane.
On the first station the survey is performed so that each next point has a different code, for example A, B, C, cl, D, E, F. After the Close button is pressed, the station number automatically changes. The application will suggest that the survey on the next station using the same codes in the opposite order: F, E, D, cl, C, B, A. The line will be created along the points with “cl” code.

For a detailed description of the survey process, see “Observations” on page 6-13. The only difference lies in the presence of the Cur Stn button. Similar to the Meas button, it makes the measurement, but does not store the point to the data set.

**Find Station**

To start working, select **Survey ▶ Find Station**.

The **Measurement** tab of the **Find Station** screen is used for the identification of the station by computing the distance from the beginning of the road to the projection of the station to the road, and the offset of the station from the center line of the road.

![Figure 6-31. Find Station – Measurement Tab](image)

- **Road**: type the name for the road, or select it from the list.
- **Point**: the name of the point.
- **Code**: the code. Can be entered manually or chosen from the drop-down list.
The Attributes List bitmap, opens a list of available attributes (for details, see “Code-Attributes” on page 3-7).

The battery and memory status for the controller.

The bitmap next to the Attributes List bitmap displays the following list:
  – String: switches on the String field (see “Topo” on page 5-20)
  – Note: opens the Notes screen (see “Topo” on page 5-20).

HR: sets the target height above the mark (rod height).

BS Setup: opens the Backsight Survey screen for setting the backsight point. The information displayed is the same as has been entered.

Pt Stn: computes the result.

Cur Stn: computes the result, takes the sideshot to the point, and stores the point to the data set.

Meas: computes the result and takes the sideshot to the point. The result reflects in the Result tab.

Settings: opens the Mode screen (see “Total Station Configuration” on page 2-43).

The bitmap in the upper-left corner of the screen displays the following pop-up menu:
  – Edit Points: opens the Points list (see “Points” on page 3-2).
  – Inverse: opens the Inverse COGO screen (see “Inverse” on page 8-2).
  – Notes: opens the Notes screen (see “Observations” on page 6-13).
  – PTL Mode: opens the PTL Mode screen (see “PTL Mode” on page 6-16).
  – Help: opens the Help files.

The Result tab shows the results of the computation.
The Map tab shows all points in a graphic mode and duplicates the button controls from the first tab. For details on map properties and customizing, see “Properties” on page 4-4.

The Meas Set tab (if available) displays the result of the sideshots being done during one set.

**Tape Dimension**

To start working, select Survey ▶ Tape Dimension.

The Tape Dimension screen calculates the periphery of structures such as buildings that have features perpendicular to each other. This is done using tape measurements, relative to the two known points that belong to one side of the structure (wall of the building), forming the so called *reference line*.

The Ref Line tab contains information about the two points comprising the reference line.

![Figure 6-32. Tape Dimension Ref Line Tab](image)

- **Start Pt**: contains properties of the starting point: the name (can be entered manually or chosen from the map or list) and code. Also, the point can be measured by pressing the Meas button.

- **End Pt**: contains properties of the ending point: the name (can be entered manually or chosen from the map or list) and code. Also, the point can be measured by pressing the Meas button.
The *Tape Dim* tab contains the settings for performing the survey.

![Tape Dimension – Tape Dim Tab](image)

- **Point**: the name of the next point in the survey.
- **Code**: the code of the point. Can be entered manually or chosen from the drop-down list.
- **Attributes List** : the *Attributes List* bitmap, opens the list of available attributes (for details see “Code-Attributes” on page 3-7).
- The bitmap next to the *Attributes List* bitmap displays the following list:
  - **String**: switches on the *String* field (see “Topo” on page 5-20).
  - **Note**: opens the *Notes* screen (see “Topo” on page 5-20).
- **Dist Left**: toggles between *Dist Left* and *Dist Right* values. These set the direction of the next movement, relative to the previous direction. The field below sets the distance to move.
- **Accept**: applies the taped distance to the perimeter line.
- **Finish**: opens the floating menu of two items:
  - **Close Polygon**: connects the first and the last two points with a line.
  - **Calc Closure**: calculates the difference between the last and the first points.
- The bitmap in the lower-left corner of the screen shows the plot of the already taped perimeter.
The Data tab shows the initial data and current results of the measurements.

The Map tab displays the plot of the already made measurements.

**Missing Line**

To start working, select **Survey ▶ Missing Line**.

The Missing Line screen emulates the total station measurement from one point to another and stores the result to the Raw Data database.

- The Start and End points can be entered manually, chosen from the map or from the list, or measured through the Meas button.

The Data tab displays the results of the measurements.

The same results are reflected in the Raw Data screen.

The Map tab shows the relative position of the points and the measured line.
Auto Topo

This function is activated only with Robotic instruments, and collects points by Time and Distance. To open the Auto Topo screen, select Survey → Auto Topo in the Robotic mode.

![Auto Topo Screen]

Figure 6-36. Auto Topo

The bitmap on the upper-left corner displays the following pop-up menu:

- *Edit Points*: opens the *Points* list.
- *Inverse*: opens the *Inverse* COGO screen.
- *Notes*: opens the *Notes* screen.
- *PTL Mode*: opens the *PTL Mode* screen (see “PTL Mode” on page 6-16).
- *Remote settings*: opens the *Search/Track Parameters* screen (see “Config: Stakeout Parms” on page 2-55).
- *Config Link*: opens the *Configure Link* screen (see “Configure Link” on page 7-7).
- *BS Setup*: opens the *Backsight Survey* screen (see “Backsight Survey” on page 6-2).
- *Help*: opens the Help files.

The *Measurement* tab contains the initial data for the survey:

- *Point*: displays the current point name.
- *Code*: displays the current point code. Can be entered manually or chosen from the drop-down list.
•  ₪ : selects attributes for the indicated code.

• The bitmap next to the Attributes List bitmap displays the following list:
  – String: switches on the String field. (The ₪ sign also appears.)
  – Note: opens the Notes screen (see “Note” on page 5-24).

• HR: the height of the rod (target).

• Log Now: immediately stores the current position.

• Start: starts the survey process. After pressing, the button changes it name to Stop.

• Qlock: sends the “Quicklock” or “Turn Around” command which will cause the Total Station to search for the RC-2.

• Search: make the instrument search for the prism.

• Lock: lock onto the prism or “track” it.

• Turn: opens the Rotate screen which allows the Total station to turn to various angles or points.

• Stop: makes the total station to stop tracking the prism and go into “Standby” mode.

---

1. RC-2 is the Remote Control System 2 for optical communications. For instructions of how to operate the RC-2 device, consult the instruction manual for RC-2.
• **Settings**: opens the **Mode** screen. Press **Next** to access the Auto Topo settings:

![Mode Screen](image)

- **Method**: sets the method of data collection; either **By Time**, **By Horizontal Distance**, or **By Slope Distance**.
- **Interval**: the time interval for the data collection.

• Press **Finish** to save the changes and return to the **Auto Topo** screen.

The **Data** tab displays the data being surveyed.

The **Map** tab shows the surveyed data graphically and duplicates the controls from the **Measurement** tab to perform the survey to work in the map mode.
Scanning

This function is activated only with Robotic instruments, and scans with Robotic Total Stations. To open the Scanning screen, select Survey ▶ Scanning in the Robotic mode.

![Figure 6-38. Scanning – Init](image)

This screen contains initial data for scanning:

- **Point**: displays the name of the point, which can be chosen from the map or drop-down list.
- **Code**: displays the point code.
- **Orientation**: selects the type of plane (Horizontal, Vertical or Inclined in which to perform scanning.
- **Next**: opens another Scanning screen to set spacing and start scanning.

![Figure 6-39. Scanning – Start](image)
Remote Control

To set up a survey with remote control, click Survey ➤ Remote Control.

If one person performs the survey process with a motorized instrument, the remote control transmits commands from the controller to the total station. The radio modems need to be set and connected to the controller and the instrument.

Remote Control

The Remote Control tab controls the total station through the radio.

![Remote Control Tab](image)

Figure 6-40. Remote Control

The Remote Control tab shows the current values of the total station measurements and provides a set of tools for control:

- **Switches the keyboard control on and off, shows the current status of the switch.**
- **Shows the battery status for the total station.**
- **Shows the status of communication between the controller and total station.**
- **Sends the “Quicklock” or “Turn Around” command which will cause the Total Station to search for the RC-2.**
- **Search:** make the instrument search for the prism.
Remote Control

- **Lock**: lock onto the prism or “track” it.
- **Turn**: opens the *Rotate* screen which allows the Total station to turn to various angles or points.
- **Stop**: makes the total station to stop tracking the prism and go into “Standby” mode.
- The Data Indicator above the **Qlock** button shows the current state of the Total Station. There are four types: no data, querying status, turning, and receiving data.
- All the observations can be done in the remote mode as well if the instrument chosen is robotic.
- The bitmap on the upper-left corner displays the following pop-up menu:
  - **Edit Points**: opens the Points list.
  - **Inverse**: opens the Inverse COGO screen.
  - **Notes**: opens the Notes screen (see “Note” on page 5-24).
  - **PTL Mode**: opens the PTL Mode screen (see “PTL Mode” on page 6-16).
  - **Remote Settings**: opens the Search/Track screen.
  - **Config Link**: opens the Configure Link screen (for details, see “Configure Link” on page 7-7).
  - **Help**: opens the Help files.

The Map tab shows all points in a graphic mode. For details, on map properties and customizing, see “Properties” on page 4-4.

When the Robotic total station operates in the Remote Control Mode, some of the screens change their appearance, the remote control tools appear on the Measurement tab (see Figure 6-41 on page 6-42 for an example).

---

1. RC-2 is the Remote Control System 2 for optical communications. For instructions of how to operate the RC-2 device, consult the instruction manual for RC-2.
The *Rotate* screen contains settings for the remote total station rotation.

- *Rotation Angles*: sets the values of the horizontal and vertical rotation angles.
- *Turn*: sends the data to the total station.
- *Rotate to Point*: selects a point by typing its name, selecting it from the map or a list, inserting the HR value (height of rod or target), and pressing the *Turn* button.
- *Plunge TS*: press to plunge the instrument (rotate the telescope and the body by 180 degrees).
Stake

The Stake menu includes the following menu items:

- Points
- Point in Direction
- Point List
- Lines
- Offsets
- Roads
- DTM
- CodeStrings

Figure 7-1. Stake Menu
Points

To stakeout a point, click Stake ▶ Points.

Stakeout Point

The Stakeout Point screen contains initial data for the stakeout point.

![Stakeout Point Screen](image)

**Figure 7-2. Stakeout Point**

- For GPS stakeouts, the bitmap in the upper-left corner displays the following pop-up menu:
  - *Status*: opens the Status screen (see “Status” on page 5-2).
  - *Rover Antenna Setup*: opens the Antenna Setup screen (see “Config: Rover Antenna” on page 2-36).
  - *Config Radio*: opens the Configure Radio screen (see “Config: Rover Radio” on page 2-30).
  - *Edit Points*: opens the Points screen (see “Points” on page 3-2).
  - *PTL Mode*: switches on the PTL (Point-To-Line) Mode. (The screen changes its appearance to Stakeout Point (PTL).) For details, see “PTL Mode” on page 6-16.
- For Total Station stakeouts, the bitmap in the upper-left corner displays the following pop-up menu:
  - *BS Setup*: opens the BS Setup screen (see “Backsight Survey” on page 6-2).
– **Config Link** (for Robotic mode only): opens the **Configure Link** screen.

– **Remote Control** (for Robotic mode only): opens the **Remote Control** screen (see “Remote Control” on page 6-40).

– **Edit Points**: opens the **Points** screen (see “Points” on page 3-2).

– **PTL Mode**: switches on the PTL (Point-To-Line) Mode. (The screen changes its appearance to **Stakeout Point (PTL)**.) For details, see “PTL Mode” on page 6-16.

• **Design Point**: sets the identifier of the design point. Choose it from a map, from the list, or add a new point.

• **Antenna Ht** (for GPS mode): sets the height of the antenna reference point (ARP) above the mark. Also the measurement type for the height needs to be specified: slant or vertical.

• **HR** (for TS mode): the height of the rod (target).

• **Settings**: opens the **Stakeout Parameters** screen (see “Config: Stakeout Parms” on page 2-40).

• **Stakeout**: opens the **Stakeout** screen.
GPS+ Stakeout

The Stakeout screen assists in the stakeout process. The graphic shows the north direction, the reference direction, and the target point, if the distance to it is less than horizontal distance tolerance. If the distance is greater than three meters, the arrow will point to it, showing the direction of movement. As soon as the target becomes closer than the Horizon Distance Tolerance value, the graphic shows a bull’s-eye target point on the screen. The panel on the right displays the parameters of the target.

- **Store**: saves the location. Check the parameters of the stored point in the *Add/Edit point* screen.
- **Next Pt**: moves to the next point in the list.
- **Close**: closes the screen and returns to the *Stakeout Point* screen.
Configure Radio

The *Configure Radio* screen contains parameters for the radio modem.

- *Radio Connected to*: selects the type of the receiver where the radio is connected, *Rover* or *Base*.
- *Type*: shows the current modem type set for the current survey configuration. To change the modem, use the *Job > Config > Survey* menu.
**TS Stakeout**

The *Stakeout* screen reflects the progress of the stakeout, displaying the current point name (in the upper-left corner of the screen), the layout of the target and current position, the direction, and the values of the distances to the target.

- **EDM**: displays the menu with two choices: Coarse and Fine. Selecting one of them sets a check mark in the menu.
- **Next Pt**: switches to the next target.
- **Meas**: takes a measurement and stores the current position as a point.
- **Cur Pos**: causes a measurement to be made and displays the result on the screen.
- **Store**: performs the measurement, then displays and stores the point.
- **Search**: for robotic Total Stations, starts autotracking and instructs the TS to search for the prism. This function is useful for setting the stake and measuring the final position.
- **Stop**: for robotic Total Stations, stops autotracking. This function is useful for moving the pole to set the stake in the ground.
- **Close**: closes the screen.
Configure Link

The *Configure Link* screen contains parameters for the radio modem.

- **Conn Mode**: the connection mode, *Cable* or *Radios Only*.
- **Type**: shows the current modem type set for the current survey configuration. To change the modem, use the **Job > Config > Survey** menu.
- **Radio Port, Model, Channel, Frequency**: parameters for the radio connection.

Staked out points are listed as observed points on the *Points* screen.
Point in Direction

To perform the Point and Direction stakeout, select Stake ▶ Point in Direction.

Point in Direction

The Point in Direction screen performs the stakeout of a point, using known point, the azimuth, and the offsets from the azimuth line.

- **From Point**: the starting point. Type the name manually or select it from the list or from the map.
- **Azimuth/Az to Pt**: the azimuth can be set by value, or as the direction to another known point.
- **Angle Offset**: the angle offset from the azimuth line.
- **Hz Dist**: the distance offset along the angle offset line.
- **Vert Dist**: the height offset.
- **Store Pt**: check this field if it is desired to store the computed point to the data set.
- **Antenna Ht** (for the GPS mode): sets the height of the antenna reference point (ARP) above the mark. Also, specify the measurement type: slant or vertical.
- **HR** (for the TS mode): the height of the rod (target).
- **Stakeout**: opens the Stakeout screen to perform the stakeout.

![Figure 7-8. Stakeout Point & Direction](image)
• **Settings:** opens the *Stakeout Parameters* screen. See “Config” on page 2-13.

• For a GPS stakeout, the bitmap at the upper-left corner displays the following pop-up menu:
  – *Status:* opens the *Status* screen (see “Status” on page 5-2).
  – *Rover Antenna Setup:* opens the *Antenna Setup* screen (see “Config: Rover Antenna” on page 2-36).
  – *Config Radio:* opens the *Configure Radio* screen (see “Config: Rover Radio” on page 2-30).
  – *Edit Points:* opens the *Points* screen (see “Points” on page 3-2).

• For a Total Station stakeout, the bitmap on the upper-left corner displays the following pop-up menu:
  – *BS Setup:* opens the *BS Setup* screen (see “Backsight Survey” on page 6-2).
  – *Config Link* (for Robotic mode only): opens the *Configure Link* screen.
  – *Remote Control* (for Robotic mode only): opens the *Remote Control* screen (see “Remote Control” on page 6-40).
  – *Edit Points:* opens the *Points* screen (see “Points” on page 3-2).
**GPS+ Stakeout**

The *Stakeout* screen reflects the progress of the stakeout, displaying the current point name (in the upper-left corner of the screen), the layout of the target and current position, the desired direction, and the values of the distances to the target.

![Figure 7-9. Point in Direction – Stakeout](image)

- **Store**: performs the measurement and stores the point to the data set.
- **Close**: saves the changes and closes the screen.

**TS Stakeout**

The *Stakeout* screen reflects the progress of the stakeout, displaying the current point name (in the upper-left corner of the screen), the layout of the target and current position, the necessary direction, and the values of the distances to the target.

![Figure 7-10. Point in Direction – Stakeout](image)
- **EDM**: displays a menu with two choices: Coarse and Fine. Selecting one of them sets the check mark in the menu.
- **Meas**: takes a measurement and stores the current position as a point.
- **Cur Pos**: causes a measurement to be made and displays the result on the screen.
- **Close**: saves the changes and closes the screen.

## Point List

To stakeout points from a list, select **Stake ▶ Point List**.

## Stakeout Point List

The **Stakeout Point List** screen performs a stakeout of existing points, creates a pointlist to stakeout, selects the starting stakeout point, and stakeouts in direct or reverse order.

![Stakeout Point List](image)

**Figure 7-11. Stakeout Point List**

- **Point List**: the preexisting points list. Can be chosen from the list or entered manually.
- **List of Points**: the list of currently selected points.
- Up and down arrows moves the highlighted point up and down in the order of the points.
• ⌈ ⌉: if activated, uses the up/down arrows on the keyboard to move the highlighted point up and down.

• ✗: deletes the highlighted point from the list.

• ➡: closes the scheme of the polygon. Only the list of points will be available.

• Ant Ht (for GPS mode): sets the height of the antenna reference point (ARP) above the mark. Also, specify the measurement type for the height: slant or vertical.

• HR (for the TS mode): the height of the rod (target).

• Stakeout in Reverse Order: check to perform stakeout starting from the end of the Point List.

• Stakeout: opens the Stakeout screen.

• For GPS stakeouts, the bitmap at the upper-left corner displays the following pop-up menu:
  – Status: opens the Status screen (see “Status” on page 5-2).
  – Rover Antenna Setup: opens the Antenna Setup Screen (see “Config: Rover Antenna” on page 2-36).
  – Config Radio: opens the Configure Radio screen (see “Config: Rover Radio” on page 2-30).
  – Edit Point Lists: opens the Point Lists screen (see “Point Lists” on page 3-11).

• For Total Station stakeouts, the bitmap on the upper-left corner displays the following pop-up menu:
  – BS Setup: opens the BS Setup screen (see “Backsight Survey” on page 6-2).
  – Config Link (for Robotic mode only): opens the Configure Link screen.
  – Remote Control (for Robotic mode only): opens the Remote Control screen (see “Remote Control” on page 6-40).
  – Edit Point Lists: opens the Point Lists screen (see “Point Lists” on page 3-11).
Stakeout (GPS and TS)

The GPS or TS Stakeout is performed in the same way as in “Stakeout Point” on page 7-2. Here, points can be staked out in any order by selecting the next stakeout point using the bitmap in the upper left corner, which has the following items:

- **Select Stakeout Point**: opens the **Select Point** screen to select a stakeout point from the list.
- **Help**: accesses the Help files.

Select Point

The **Select Point** screen displays the Point List being staked, from which points can be randomly chosen to continue the stakeout.

The new starting point can be selected from the list, or by double-clicking a point on the map to the right of the list.

- **Show Remaining Points**: check to show all the points that have not yet been staked out.
- **Show Staked Points**: check/uncheck to display the points in the list that have already been staked out.
- **Reverse Order**: check to stakeout the points from last point in the list to first.
- **OK**: saves changes and closes the screen.


**Lines**

To stakeout a line, select Stake ➤ Lines.

**Stakeout Line**

The Line screen contains the initial data for the line stakeout.

- The bitmap on the upper-left corner displays the same pop-up menu as for the Stakeout Points & Direction screen (see “Point in Direction” on page 7-8).

![Figure 7-13. Stakeout Line](image)

- **Start Point**: sets the starting point of the reference line.
- **End Point/Azimuth**: sets the direction of the reference line thorough another point, or azimuth.
- **Ht Comp**: the type of height computations for the stakeout point. Can be one of the following:
  - **Ht of Start Pt** (height of starting point): the stakeout point will have the same height as the starting point of the line.
  - **Interpolate Ht**: the height of the stakeout point will be computed through linear interpolation using the height of the starting and ending points of the line.
- **Antenna Ht** (for GPS mode): sets the height of the antenna reference point (ARP) above the mark. Also, specify the measurement type for the height: slant or vertical.
- **HR** (for TS mode): the height of the rod (target).
• **Stakeout**: opens the *Stakeout Line* screen, assisting in the stakeout process.

• **Settings**: opens the *Stakeout Parameters* screen. For details, see “Stakeout Point” on page 7-2.

**GPS+ Stakeout**

The graphics on the *Stakeout Line* screen shows the north direction, the reference direction, the movement direction, the target line. The panel on the right displays the parameters of the target.

![Figure 7-14. Stakeout Line](image)

• **Store**: saves the location. Check the parameters of the stored point in the *Add/Edit point* screen.

• **Close**: closes the screen and returns to the *Stakeout Line* screen.
The **Stakeout** screen displays the stakeout process, displaying the current point name (in the upper-left corner of the screen), the layout of the target and current position, the direction, and the values of the distances to the target.

- **Turn TS**: opens the Turn TS screen that shows the horizontal angle of the total station turn.
- **Meas**: takes a measurement and stores the current position as a point.
- **Cur Pos**: causes a measurement to be made and displays the result on the screen.
- **Close**: returns to the line screen.
Offsets

The Offsets submenu contains four items:

- Line & Offsets
- Intersection & Offsets
- Curve & Offsets
- Spiral & Offsets

Line & Offset

To stakeout Line & Offset, select Stake ▶ Offsets ▶ Line & Offsets.

Stakeout Line & Offset

The Stakeout Line & Offset screen performs a stakeout of a line with offsets in the Horizontal and Vertical directions.

![Stakeout Line & Offset Screen](image)

- **Start Point**: the starting point of the line. The line is defined, by its azimuth, azimuth to another point, or the End point of the line.
- **End Point/Azimuth**: the direction of the line. It can be set through the azimuth of the line, or the ending point of the line.
- **Ht Comp**: the type of height computations for the stakeout point. Can be one of the following:
  - **Ht of Start Pr**: the stakeout point will have the same height as the starting point of the line.
– **Interpolate Ht**: the height of the stakeout point will be computed through linear interpolation using the height of the starting and ending points of the line.

- **Num Subs**: designates the number of subdivisions if it is desired to subdivide the line. For instance, a value of 3, indicates that the user wants to stakeout four points by subdividing the line in three equal segments.

- **Start Stn**: The starting station (chainage) of the line.

- **Next**: opens the **Station & Offsets** screen.

- **Settings**: opens the **Stakeout Parameters** screen. See “Config” on page 2-13.

- For GPS stakeouts, the bitmap at the upper-left corner displays the following pop-up menu:
  - **Status**: opens the **Status** screen (see “Status” on page 5-2).
  - **Rover Antenna Setup**: opens the **Antenna Setup** screen (see “Config: Rover Antenna” on page 2-36).
  - **Config Radio**: opens the **Configure Radio** screen (see “Config: Rover Radio” on page 2-30).
  - **Edit Points**: opens the **Points** screen (see “Points” on page 3-2).
  - **Help**: accesses Help files.

- For Total Station stakeouts, the bitmap on the upper-left corner displays the following pop-up menu:
  - **BS Setup**: opens the **BS Setup** screen (see “Backsight Survey” on page 6-2).
  - **Config Link** (for Robotic mode only): opens the **Configure Link** screen.
  - **Remote Control** (for Robotic mode only): opens the **Remote Control** screen (see “Remote Control” on page 6-40).
  - **Edit Points**: opens the **Points** screen (see “Points” on page 3-2).
  - **Help**: accesses Help files.
Station & Offsets

The Station & Offsets screen contains the settings for the stakeout session.

![Station & Offsets Diagram]

Figure 7-17. Stakeout

- **Station**: The station along the line being staked. The two arrows to the right decrease or increase the station by the interval specified in the Stn Interval shown in the next line.

- **Stn Interval**: the station staking interval.

- **Right Offset/Left Offset**: the right or left offset of the stakeout point with respect to the line at the station shown on the Station field.

- **Up/Down**: the Up or Down Height offset with respect to the height of the line at the station.

- **Antenna Ht** (for GPS mode): sets the height of the antenna reference point (ARP) above the mark. Also the measurement type for the height needs to be specified: slant or vertical.

- **HR** (for TS mode): the height of the rod (target).

- **Back**: returns to the previous screen.

- **Stakeout**: opens the Initial Point Name screen.
Initial Point Name

The Initial Point Name screen specifies the starting name for the points calculated for the stakeout task.

- **First Point**: the name of the first point.
- **Code**: the code of the points; selected from the list or entered manually.
- ****: accesses the attributes of the chosen code, opens the Code-Attributes screen (see “Code-Attributes” on page 3-7).
- The bitmap next to the Attributes List bitmap displays the following list:
  - **String**: toggles on the String field. Also, the sign appears. For details, see “Topo” on page 5-20.
  - **Note**: opens the Notes screen. For details, see “Topo” on page 5-20.
- **OK**: saves the changes and opens the Stakeout screen.
GPS+ Stakeout

The graphics on the Stakeout screen show the north direction, and the relative position of the antenna and target. The panel on the right displays the parameters of the target.

![Stakeout Screen](image)

Figure 7-19. Stakeout

- **NextSta**: advances the station by the specified Station Interval for staking out points at the Next station.
- **Store**: saves the location. Check the parameters of the stored point in the Add/Edit point screen.
- **Close**: closes the screen and returns to the Stakeout Line screen.
**TS Stakeout**

The *Stakeout* screen reflects the progress of the stakeout, displaying the current station (in the upper-left corner of the screen), the layout of the target and current position, the necessary direction, and the values of the distances to the target.

![Stakeout Screen](image)

- **Stn**: displays the current station. Clicking in the field toggles between Station and Offset.
- **EDM**: displays the menu of two items: Coarse and Fine. Selecting one of them sets the check mark in the menu.
- **Stop**: instructs the Robotic Total Station to stop tracking and go into “Stand By” mode.
- **Search**: instructs the Robotic Total Station to start searching for the prism.
- **NextSta**: advances the station by the specified Station Interval for staking out points at the Next station.
- **Meas**: takes a measurement and stores the current position as a point.
- **Cur Pos**: causes a measurement to be made and displays the result on the screen.
- **Close**: saves the changes and closes the screen.
Intersection & Offsets

To stakeout Intersection & Offsets, select Stake ▶ Offsets ▶ Intersection & Offsets.

Intersection & Offsets

The Intersection & Offsets screen stakeouts out the intersection point of two lines parallel to two other lines at specified offsets. The first screen defines one line (Line 1) and the offset of the first parallel line. The second screen field defines another line (Line 2) and the offset of the second parallel line. The intersection point of these two parallel lines defines the stakeout point.

The first screen contains parameters for the first line.

![Intersection & Offsets – Line 1](image)

- **From Point**: starting point of the Line 1.
- **Az to Pt/Azimuth**: the direction of the line. It can be set through the azimuth of the line, azimuth from the start point to the point selected.
- **Right Offset/Left Offset**: the right or left offset of the stakeout point with respect to the line.
- **Next**: opens the second Intersection&Offsets screen.
- **Settings**: opens the Stakeout Parameters screen. See “Config” on page 2-13.
The bitmap on the upper-left corner displays the same pop-up menu as the **Points in Direction** screen (see “Point in Direction” on page 7-8).

The second screen contains the parameters of the second line.

![Intersection & Offsets – Line 2](image)

**Figure 7-22. Intersection & Offsets – Line 2**

- **From Point**: starting point of the Line 2.
- **Az to Pt/Azimuth**: the direction of the line; set through the azimuth of the line, azimuth from the start point to the point selected.
- **Right Offset/Left Offset**: the right or left offset of the stakeout point with respect to the corresponding line.
- **Intersect Ht**: the height of the intersection point.
- **Store Point**: the name of the intersection point.
- **Ant Ht** (for GPS mode): the height of the antenna.
- **HR** (for TS mode): the height of the rod (target).
- **Stakeout**: opens the **Stakeout** screen.
- **Settings**: opens the **Stakeout Parameters** screen. See “Config” on page 2-13.
GPS+ Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying the current point name (in the upper-left corner of the screen), the layout of the target and current position, the desired direction, and the values of the distances to the target.

![Stakeout Screen](image)

- **Store**: saves the location. Check the parameters of the stored point in the *Add/Edit point* screen.
- **Close**: closes the screen and returns to the *Stakeout Line* screen.

**TS Stakeout**

The Stakeout screen reflects the progress of the stakeout, displaying the current station (in the upper-left corner of the screen), the necessary direction, and the values of the distances to the target.

![Stakeout Screen](image)

- **EDM**: displays a menu of two items: Coarse and Fine. Selecting one of them sets the check mark in the menu.
Stake

- **Meas**: takes a measurement and stores the current position as a point.
- **Cur Pos**: causes a measurement to be made and displays the result on the screen.
- **Close**: saves the changes and closes the screen.

**Curve & Offsets**

To stakeout Curve & Offsets, select Stake ▶ Offsets ▶ Curve & Offsets.

**Curve & Offsets**

The Curve & Offsets screen function performs a stakeout of a curve (section of an arc) at a specified horizontal and vertical offset from the curve.

![Figure 7-25. Stakeout Curve & Offset](image)

- **PC Point**: the Point of Curve, the starting point of the arc.
- **Tangent Azi**: the azimuth of the Tangent of the curve (arc) at the PC point.
- **Radius/ Deg Curve/ Deg Chord**: the radius parameters of the curve.
- **Length/Chord/Tangent/Mid Ord/Extern/Delta**: the length parameter of the curve. For the description of the curve (arc) parameters, see “Curve Solution” on page 8-15.
- **SS**: The starting station (chainage) of the line.
• **Next:** opens the *Station and Offsets* screen (see “Station & Offsets” on page 7-19).

• **Settings:** opens the *Stakeout Parameters* screen (see “Config” on page 2-13).

• The bitmap on the upper-left corner displays the same pop-up menu as for the *Line & Offsets* screen (see “Line & Offset” on page 7-17).

**Spiral & Offset**

To stakeout Spiral & Offset, select **Stake ▶ Offsets ▶ Spiral & Offset**.

**Stakeout Spiral & Offset**

The *Stakeout Spiral & Offset* screen is used to stakeout points at specified Horizontal and Vertical offsets with respect to a specified spiral.

![Stakeout Spiral & Offset Screen](image)

**Figure 7-26. Stakeout Spiral & Offset**

- **TS Point**: Tangent to Spiral point. This is the starting point of the spiral.

- **Tangent Azi**: the azimuth of the tangent to the spiral at the point TS.

- **Radius/Deg Chord/Deg Curve**: the radius parameter of the spiral at the ending point.

- **Length/Sp Const**: the length of the spiral at the ending point, or the *Spiral Constant*, the constant of the spiral.
For any spiral point \( R \times Length = (SpiralConst)^2 \), where \( R \) is the Radius, and \( Length \) is the length of the spiral, both at the same specified point.

- **Turn**: specifies whether the spiral turns right or left:
- **Dir**: the direction of “moving”:
  - \( TS \rightarrow SC \) = Tangent Spiral->Spiral Circle. This is the incoming spiral to the internal circle.
  - \( CS \rightarrow ST \) = Circle Spiral->Spiral Tangent. The outgoing spiral from the circle to the Tangent.
- **SS**: the starting station (chainage) of the line.
- **Next**: opens the **Station & Offsets** screen (see “Station & Offsets” on page 7-19).
- **Settings**: opens the **Stakeout Parameters** screen (see “Config” on page 2-13).
- The bitmap on the upper-left corner displays the same pop-up menu as for the **Line & Offsets** screen (see “Line & Offset” on page 7-17).

### Roads

The Roads submenu contains three items:

- Road
- Slope
- Real Time Road

### Stakeout Road

To start the Road stakeout, select **Stake ▶ Roads ▶ Road**.

The **Stakeout Road** screen (Figure 7-27 on page 7-29) selects the road for stakeout and displays the plan of the chosen road.

The bitmap in the upper-left corner displays the same pop-up menu as the **Line & Offsets** screen (see “Line & Offset” on page 7-17).
• **Road**: the road to be staked-out. Can be entered manually or chosen from the list.

• **Start Stn**: the starting point of the stakeout, the distance from the beginning of the road.

• **Antenna (for GPS+)**: the antenna height.

• **HR (for TS)**: the rod (target) height.

• **Include transition point**: set a check mark if the transition point should be included in spite of the station distance.

• **Settings**: opens the **Stakeout Parameters** screen (see “Config: Stakeout Parms” on page 2-40).

• **Next**: opens the second **Stakeout Road** screen.

The second **Stakeout Road** screen is used to set the offsets from CL for the stakeout points.
• **Next**: opens the third *Stakeout Road* screen.

The third *Stakeout Road* screen displays the properties of the cross section on the stakeout station and performs the stakeout of all the desired points.

![Figure 7-29. Stakeout Road](image)

- **Station**: the station where the stakeout is performed. The arrow buttons change the station number by the value of Station Interval.

- **Stn Interval**: the interval of the station increment.

- **Segment Pt**: the point code of the current segment. The arrow buttons in this field move the current segment point along the cross section. This will reflect on the scheme in the bottom of this screen.

- **Right/Left Offset**: the horizontal offset from the current segment point.

- **Up/Down Offset**: the vertical offset from the current segment point.

- **Flat/Surface Offset**: the reference line for offsets, the horizontal plane or the surface of the road.

- ![Key Switch](image): switches on/off the keyboard arrow keys. The upper button stands for the station increment/decrement, the lower button - for the current segment point location. Only one button can be enabled at a time.
• **Back**: returns to the first *Stakeout Road* screen.

• **Stakeout**: opens the *Initial Point Name* screen.

• **Settings**: opens the *Stakeout Parameters* screen (see “Config: Stakeout Parms” on page 2-40).

**Initial Point Name**

The *Initial Point Name* screen specifies the starting name for the points calculated for the stakeout task.

![Figure 7-30. Initial Point Name](image)

• **OK**: opens the *Stakeout* screen.

**GPS+ Stakeout**

The graphics on the *Stakeout* screen show the relative position of the antenna and target. The panel on the right displays the parameters of the target.

![Figure 7-31. Stakeout](image)
• **NextSta**: advances the station by the specified Station Interval for staking out points at the Next station.

• **Store**: saves the location. Check the parameters of the stored point in the *Add/Edit Point* screen.

• **Close**: closes the screen and returns to the *Stakeout Roads* screen.

**TS Stakeout**

The *Stakeout* screen reflects the progress of the stakeout, displaying the current point name (in the upper-left corner of the screen), the layout of the target and current position, the necessary direction, and the values of the distances to the target.

![Figure 7-32. Stakeout Road – Stakeout](image)

By tapping in the *Stn* string, enable the floating information screen to display the station number and the offset value of the current point.

• **EDM**: displays the menu of two items: Coarse and Fine. Selecting one of them sets the check mark in the menu.

• **Next Sta**: moves to the next station.

• **Meas**: takes a measurement and stores the current position as a point.

• **Cur Pos**: causes a measurement to be made and displays the result on the screen.

• **Close**: saves the changes and closes the screen.
**Stakeout Slope**

To start the slope stakeout, select **Stake ▶ Roads ▶ Slope**.

The **Stakeout Slope** screen selects a road, which slope should be staked-out.

The bitmap on the upper-left corner displays the same pop-up menu as for the **Line & Offsets** screen (see “Line & Offset” on page 7-17).

- **Road**: the road to be staked-out. Can be entered manually, or chosen from the list.
- **Start Stn**: the starting point of the stakeout, the distance from the beginning of the road.
- **Antenna** (for GPS+): the antenna height.
- **HR** (for TS): the rod height.
- **Include transition point**: set the check mark if the transition point should be included in spite of the station distance.
- **Settings**: opens the **Stakeout Parameters** screen (see “Config” on page 2-13).
- **Next**: opens the **Stakeout Alignment** screen.
**Stakeout Alignment**

The *Stakeout Alignment* screen displays the properties of the cross section at the stakeout station and helps to perform the stakeout of the catch point (the point where the slope crosses the surface of the terrain) and/or the offset of the catch point.

![Figure 7-34. Stakeout Alignment](image)

- **Station**: the station where the stakeout is performed. The arrow buttons change the station number on the value of Station Interval.
- **Stn Interval**: the interval of the station increment.
- **Hinge Point**: the hinge point code. The hinge point is a point of rotation of the Cut/Fill Slopes. The arrow buttons in this field move the hinge point along the cross section. This will reflect on the scheme in the bottom of this screen.
- **Offset from CP**: the offset from the catch point.
- **Right/Left Slope Cut/Fill**: the values of the Cut and Fill Slope parameters, applied to the hinge point.
- ****: switches on/off the keyboard arrow keys. The upper button stands for the station increment/decrement, the lower button stands for the current hinge point location. Only one button can be enabled at a time.
- **Back**: returns to the *Slope Stakeout* screen.
- **Stakeout**: opens the *Stakeout* screen.
- **Settings**: opens the *Stakeout Parameters* screen (see “Config” on page 2-13).

**GPS+ Stakeout**

The graphics on the *Stakeout Catch Point* screen shows the direction to target. The panel on the right displays the parameters of the target.

![Stakeout Catch Point Screen](image)

**Figure 7-35. Stakeout Catch Point**

- **NextSta**: advances the station by the specified Station Interval for staking out points at the Next station.

- **Store**: saves the location. Check the parameters of the stored point in the *Add/Edit Point* screen.

- **Close**: closes the screen and returns to the *Stakeout Roads* screen.
TS Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying the current station (in the upper-left corner of the screen), the layout of the target and current position, and the parameters of the stakeout.

![Stakeout Screen](image)

**Figure 7-36. Stakeout Slope – Stakeout Catch Point**

By tapping in the *Stn* string, enable the floating information screen to display the station number and the offset value and side (right or left) of the current point.

- **HA**: Horizontal Angle.
- **To**: the direction of movement.
- **C/F CP**: Cut/Fill with respect to the Catch Point.
- **Away**: distance away from the catch point.
- **Along**: distance along the center line.
- **EDM**: displays the menu of two items: *Coarse* and *Fine*. Selecting one of them sets the check mark in the menu.
- **Next Sta**: moves to the next station.
- **Meas**: takes a measurement and stores the current position as a point.
- **Cur Pos**: causes a measurement to be made and displays the result on the screen.
- **Close**: saves the changes and closes the screen.
Stakeout Real Time Road

To start the road stakeout in real time, select Stake ▶ Roads ▶ Real Time Road.

The Stakeout Road screen selects a road for stakeout and displays the plan of the chosen road.

The bitmap on the upper-left corner displays the same pop-up menu as for the Line & Offsets screen (see “Line & Offset” on page 7-17).

**Figure 7-37. Stakeout Road**

- **Road**: the road to be staked-out. Can be entered manually or chosen from the list.
- **Start Stn**: the starting point of the stakeout, the distance from the beginning of the road.
- **Antenna** (for GPS+): the antenna height.
- **HR** (for TS): the rod (target) height.
- **Include transition point**: set a check mark if the transition point should be included in spite of the station distance.
- **Settings**: opens the Stakeout Parameters screen (see “Config: Stakeout Parms” on page 2-40).
- **Next**: opens the second *Stakeout Road* screen to set the offsets from CL for the stakeout points.

![Figure 7-38. Stakeout Road](image)

- **Next**: opens the third *Stakeout Road* screen to set *Cut/Fill Slope* parameters.

![Figure 7-39. Stakeout Road – Cut/Fill](image)

- **Stakeout**: opens the *Initial Point Name* screen.
**Initial Point Name**

The *Initial Point Name* screen specifies the starting name for the points calculated for the stakeout task.

![Figure 7-40. Initial Point Name](image)

- **OK**: opens the *Stakeout* screen.
  
  The *Stakeout* screen reports the cut/fill values computed for the current observed point. The design elevation of the road is automatically calculated for the observed point using the alignment and the templates.

**GPS+ Stakeout**

The graphics on the *Stakeout* screen show the relative position of CL and antenna. The panel on the right displays the parameters of the antenna.

![Figure 7-41. Stakeout](image)

- **Store**: saves the location. Check the parameters of the stored point in the *Add/Edit Point* screen.
**TS Stakeout**

The *Stakeout* screen reflects the relative position of CL and target. The panel on the right displays the current point name (in the upper-left corner of the screen) and the parameters of the target.

- **Cur Pos**: measures the target.

**DTM**

To start the DTM (Digital Terrain Model) stakeout, select Stake ➤ DTM.

- **DTM name**: the name of the TN3 file, which is stored at the disk.
- **Ant Ht and m**: for GPS+ stakeout, the antenna height and method of height measurement.
- **HR**: for TS stakeout, the height of reflector.
• **Use Alignment**: if checked, stations and offsets will be reported.

• **Create TIN**: if checked, a TIN (TN3 file) cut/sheet model can be generated.

• **Stakeout**: opens the *Initial Point Name* screen (see Figure 7-18 on page 7-20) and then the *Stakeout* screen by pressing **OK**.

![Figure 7-44. Stakeout -DTM](image)

**CodeStrings**

To start a CodeString stakeout, select **Stake ▶ CodeStrings**.

![Figure 7-45. CodeStrings](image)

• For GPS stakeouts, the bitmap at the upper-left corner displays the following pop-up menu:
  
  – **Status**: opens the *Status* screen (see “Status” on page 5-2).
  
  – **Rover Antenna Setup**: opens the *Antenna Setup Screen* (see “Config: Rover Antenna” on page 2-36).
– Config Radio: opens the Configure Radio screen (see “Config: Rover Radio” on page 2-30).

- For Total Station stakeouts, the bitmap on the upper-left corner displays the following pop-up menu:
  – BS Setup: opens the BS Setup screen (see “Backsight Survey” on page 6-2).
  – Config Link (for Robotic mode only): opens the Configure Link screen.
  – Remote Control (for Robotic mode only): opens the Remote Control screen (see “Remote Control” on page 6-40).

- Antenna Ht (for GPS mode): sets the height of the antenna reference point (ARP) above the mark. Also, specifies the measurement type for the height: slant or vertical.

- HR (for TS mode): the height of the rod (target).

- Settings: opens the Stakeout Parameters screen. For details see “Config: Stakeout Parms” on page 2-40.

- Stakeout: opens the Stakeout screen, assisting in the stakeout process. The Stakeout screen for CodeStrings is similar to the Stakeout screen for Points (see the Stakeout screen on page 7-4).
COGO

The COGO menu includes the following menu items:

- Inverse
- Inverse Pt to Pts List
- Intersection
- Inverse Pt to Line
- Point in Direction (optional)
- Traverse
- Curve Solutions (optional)
- Area
- Known Area (optional)
- Transformations (optional)
Inverse

To open the Inverse screen, click COGO ▶ Inverse.

The Two-Point Inverse task computes the inverse between two known points. Inverse comprises of the azimuth from one point to the other, and the distance between these points.

The Inverse tab contains initial data for the task:

- **From Point**: the first point name; entered manually or chosen from the map or from the list.
- **To Point**: the second point name; entered manually or chosen from the map or from the list.
- **Calc**: calculates the inverse.

The Results tab shows the initial data (From Point, To Point) and results of the calculation (Figure 8-3 on page 8-3). The display of the results can vary, based on the whether a geodesic display system is selected or not.

When Grid or Ground is the selected display system, the results tab has the below described fields.
When selecting a geodesic display system, the following fields display.

- **Azimuth** or **Bearing**: to the second point from the first point.
- **Horizontal Distance (HDist)**: from one point to another.
- **Vertical distance (VDist)**: the “-” sign means that the height of the second point is lower than the height of the first point.
- **dNorth**: the increment of the North coordinate.
- **dEast**: the increment of the East coordinate.
- **dHeight**: the increment of the height.
- **Grade(Slope)**: the increment of the height in percent.
- **Slope distance**: the computed distance between two points.

- **Forward Azimuth**: the forward geodesic azimuth.
• **Backward Azimuth**: the backward geodesic azimuth.

• **Geodesic Dist**: the shortest distance between two points on an ellipsoid.

• **Ground Dist From**: the horizontal distance on the geodetic horizon plane, at the height of the From Point.

• **Ground Dist To**: the horizontal distance on the geodetic horizon plane, at the height of the To Point.

• **Delta Ell ht**: the difference in ellipsoidal heights.

The *Map* tab shows the illustration for the results.

![Figure 8-5. Two-Point Inverse – Map](image)

For a description of the buttons see “Toolbar” on page 4-3.
Inverse Point to Points List

To perform the Inverse Point to Point List task, select COGO ▶ Inverse Pt to Pts List.

The Inverse Point to Point List tab calculates the inverse for all the points in the Points list with respect to a known point.

Figure 8-6. Inverse Point to Point List

- **Point**: sets the known point name; entered manually or selected from the map or from the list.
- **Point List**: the Point List name. Can be selected from the list of Point Lists or entered manually.
- **List of Points**: the list of currently selected points. For details see “Point Lists” on page 3-11.
- **Close**: closes the plot of the polygon. Only the list of points will be available.
- **Calc**: calculate the inverse and displays the results on the Results tab.
The *Results* tab shows the initial data and the results of the calculation: closest point, azimuth, distance, height, slope and grade.

![Figure 8-7. Inverse Point to Point List – Results Tab](image)

The *Map* tab shows the results graphically.

![Figure 8-8. Inverse Point to Point List – Map Tab](image)
Intersection

To perform the Intersection task, click COGO ➤ Intersection.

The Intersection screen computes the intersection point or points when given two known points and either the direction or distance from the known points.

![Intersection Screen](image)

The Intersection tab contains initial data for the Intersection task.

- **Point 1**: the first point; entered manually, chosen from the map, or chosen from the list.

- **Azimuth/Distance/Az to Pt**: sets the direction from the first point to the unknown point or the distance between the two. The button changes the text when pressed.

- **Point 2**: the second point; entered manually, chosen from the map, or chosen from the list.

- **Azimuth/Distance/Az to Pt**: sets the direction from the second point to the unknown point or the distance between the two. The button changes the text when pressed.

- **COGO Pt**: set the name and code for the resulting point of the calculation. The code can be selected from the menu or entered manually. Also, the Attributes can be selected through the Attribute List bitmap.

- **Calc**: starts calculation process.
The *Results* tab shows the results of the calculation.

![Figure 8-10. Intersection – Results Tab](image)

- **North**: the North local coordinate of the corresponding point.
- **East**: the East local coordinate of the corresponding point.
- **Height**: the height of the first corresponding point.
- **Save**: saves the result of the calculation.

The *Map* tab shows the graphic solution of the task. As seen here, there are two solutions for the Intersection calculation.

![Figure 8-11. Intersection – Map Tab](image)

For a detailed description of the Map view, see Chapter 4.
Inverse Point to Line

To perform the Inverse Point to Line task, select COGO » Inverse Point to Line.

The Inverse Point to Line screen calculates the station of the known point inverse to the known line.

![Figure 8-12. Inverse Point to Line](image)

- **Point**: sets the current point name. Can be entered manually, or selected from the map or from the list.
- **Code**: is not available for changing.
- **Start Point**: the starting point of the reference line.
- **Azimuth/Az to Pt**: the azimuth of the reference line.
- **Start Stn**: the starting station of the reference line.
- **Store PTL Point**: store the point as PTL point (see “PTL Mode” on page 6-16).
- **Calc**: calculate the inverse and displays the results on the Results tab.
The *Results* tab shows the initial data and the results of the calculation: station, offset and height

![Figure 8-13. Inverse Point to Line – Results Tab](image)

The *Map* tab shows the results graphically.

![Figure 8-14. Inverse Point to Line – Map Tab](image)
Point in Direction

To perform the Point and Direction task, select COGO ► Point in Direction.

The Point & Direction tab calculates the coordinates of a point, using known point, the azimuth, the angle offset from the azimuth line and the distance offsets from the From Point.

![Figure 8-15. Point & Direction](image)

- **From Point**: the starting point. Type the name manually or select it from the list or from the map.
- **Azimuth/Az to Pt**: the azimuth can be set by value, or as a direction to another known point.
- **Angle Offset**: the angle offset from the azimuth line.
- **Hz Dist**: the distance offset along the angle offset line.
- **Vert Dist**: the height offset.
- **Cogo Pt**: the computed point name.
- **Code**: the computed point code.
- **Calc**: calculates the coordinates and displays the results on the Results tab.
The *Results* tab shows the initial data and results of the calculation.

![Figure 8-16. Point & Direction – Results Tab](image)

- **Save**: saves the results of the calculation.

The *Map* tab shows the results graphically.

![Figure 8-17. Point & Direction – Map Tab](image)
This function is used to calculate Traverse, and Sideshot points, based horizontal, and Vertical Offsets along a direction which is defined by an azimuth, or right, left or deflection angles. To start Traverse task, select COGO ➤ Traverse.

The Traverse Calc tab displays the initial data for the traverse task.

- **From Point**: indicates the occupation (the traverse point), and can be manually entered, or chosen from the map or list.

- **Azimuth/Angle Right/Angle Left/Deflection**: determines the azimuth from the known point to the calculated point (To Point). The azimuth can be entered as is, or can be computed from the right or left angles, or deflection entered in this field and Backsight information.

- **Angle to the right**: is the angle at the known point from the backsight point to the calculated point in a clockwise direction.

- **Angle to the left**: is the angle at the known point from the backsight point to the calculated point in a counterclockwise direction.

- **Deflection**: is the angle at the known point between the prolongation of the line from the backsight point and the line to the calculated point.

- **Hz Dist**: the Horizontal Distance along the azimuth line.

- **Vert Dist**: the Vertical Distance along the azimuth line.
• **To Point**: the name of the calculated point.
• **Code**: the code associated with the calculated point.

• **BS Point**: displays the *BS Point* screen for entering the Backsight Point or Backsight Azimuth. If a BS point has not been entered, an Azimuth is required. In this case, if an angle value is entered as *Angle Right, Angle Left, or Deflection*, this value will be considered as azimuth.

**BS Point**

The *BS Point* screen enters the Backsight Point or Backsight Azimuth. The parameter is chosen by pressing the **BS Point/BS Azimuth** button.

![BS Point Screen](image)

**Figure 8-19. BS Point**

In the **BS Azimuth** mode either the azimuth is set directly, or a point can be chosen from the list or map, then the azimuth to this point will be calculated and input as the BS Azimuth. Press **OK** to return to the **Traverse Calc** screen.

• **SideShot**: if pressed, the coordinates of the To Point will be calculated based on the entered values for Azimuth/Angle Right/Angle Left/Deflection, Horizontal and Vertical distances. The From Point does not change, and To Point is incremented to the next new Point in the database.

• **Traverse**: if pressed, the coordinates of the To Point will be calculated based on the entered values for (Azimuth/Angle Right/Angle Left/Deflection), Horizontal and Vertical distances. The
From Point changes to the To Point, and the To Point changes to the next new name in the database.

**Curve Solutions**

A Curve is a part of a circle and thus can be described through the center point (also called as Radius Point), the radius value and the starting and ending points on the circle, also called as PC (Point of Curvature) and PT (Point of Tangency). Using these values, find other Curve parameters.

**Curve Solution**

The Curve Solution COGO task calculates the full set of parameters for any curve, given one of each of the curvature parameter and the length parameter of the curve. To start the Curve Solution task, select COGO ➤ Curve Solutions ➤ Curve Solution.

The Curve Solution tab screen contains the initial data and a window for the curve plan.

![Curve Solution](image)

- **Radius/Deg Chord/Deg Curve**: the curvature parameter of the curve.
- **Length/Chord/Tangent/Mid Ord**: the length parameter of the curve.
- **Turn**: the direction of turn relative to the starting point.
- **Calc**: press to calculate the parameters of the curve.
The **Results** tab shows the calculated parameters.

The first three parameters displayed are the radius and length of the curve and the length of the chord connecting the PC and PT points.

- **Chord**: PC-PT length. If the Chord is defined, then taking into account, that

\[
\sin \frac{\Delta}{2} = \frac{\text{Chord}}{2(R)}
\]

the Length can be calculated as \( \text{Length} = R \times \Delta \) (note that delta is the angle subtended at the center).

The **Degree Curve** defines the angle in degrees which is used to compute the radius of a curve with a length of 100 units:

\[
\frac{\text{DegreeCurve} \times \pi}{180} = \frac{100}{R}
\]

where \( R \) is Radius.

The **Degree Chord** defines the angle in degrees which is used to compute the radius of curve whose chord is 100 units long. So

\[
\sin \frac{\text{DegreeChord} \times \pi}{180} = \left(\frac{100}{2 \times R}\right)
\]

where \( R \) is Radius.

- **Delta**: internal angle from center to tangent points (PC-RP-PT).
• **Tangent**: the PI-PT length, where PI is the Point of Intersection. If the Tangent is defined, then taking into account, that:
\[
\tan \frac{\Delta}{2} = \frac{\text{Tangent}}{R}
\]

where R is Radius, the Length is \( \text{Length} = R \times \Delta \).

*Mid Ord*: mid ordinate, the piece of PI-RP section from the curve to the chord. If the Mid Ord is known, then assuming that:
\[
\cos \frac{\Delta}{2} = \frac{R - \text{MidOrd}}{R}
\]

where R is Radius, the Length is \( \text{Length} = R \times \Delta \).

• **External**: the piece of PI-RP section from PI to the curve. If the External is defined, then assuming that:
\[
\cos \frac{\Delta}{2} = \frac{R + \text{External}}{R}
\]

where R is Radius, the Length is \( \text{Length} = R \times \Delta \).

• **Sector**: the area of a circle bounded by two radii and the minor arc they determine.

• **Segment**: the area of a circle bounded by a chord and the minor arc that it cuts off.

• **Fillet**: the area between the arc of a circle and the two tangents at the end points of the arc.

The **Map** tab shows graphically the results of the calculation.
**PI & Tangents**

The PI & Tangents task computes the PC point, the PT point, and the center (Radius Point) of a Curve, given the Point of Intersection (PI), the radius, and the azimuths from the PI point to the PC, and PT points respectively. To start the PI & Tangents task, select **COGO ➤ Curve Solutions ➤ PT & Tangents**.

The *PI & Tangents* tab contains the initial data.

- **PI Point**: the Point of Intersection. Can be manually entered, or chosen from the map or from the list.
- **Az PI to PC**: the azimuth from the PI point to the starting curve point.
- **Az PI to PT**: the azimuth from the PI point to the ending curve point.
- **Radius/ Deg Curve/Deg Chord/Tangent**: the radius parameter of the curve.
- **PC Point**: the name and the code for the calculated starting curve point.
- **PT Point**: the name and the code for the calculated ending curve point.
- **RP Point**: the name and the code for the calculated radius point.
- **Calc**: calculates the parameters of the curve and the coordinates of the PC, PT and RP points.
The *Results* tab shows the results of the calculation.

![Figure 8-24. PI & Tangents – Results Tab](image)

Check the points that are needed to be saved and press the **Save** button.

The *Map* tab shows graphically the results of the calculation.

![Figure 8-25. PI & Tangents – Map Tab](image)
Three Pt Curve

The Three Pt Curve task defines the curve using three points: PC point, any curve point and PT point; or the RP, PC and PT points. To start the Three PT curve task, select **COGO > Curve Solutions > Three Pt Curve**.

The Three Points Curve tab displays the initial data. The screen changes its appearance depending upon the first point chosen. Manually enter, or select from list or from map the, the following sets of points:

- **PC Point, Curve Point, PT Point**, or
- **RP Point, PC Point, PT Point**.

In the first case the coordinates for the RP Point will be calculated along with curve parameters. The name and the code for this calculated point can be set.

In the second case the distance between RP Point and PC point should be equal to distance between RP Point and PT point. The radius, and the PC and PT points define two curves, one with delta less than or equal to 180 degrees (Small curve), and the other with delta greater than or equal to 180 degrees (Large curve). Values of Small or Large can be selected from the **Curve** drop-down box to indicate which of these two curves should be used for computations.

- **Calc**: press to calculate the curve parameters.
The *Results* tab displays the results of the calculation.

![Figure 8-27. Three Pt Curve – Results Tab](image)

For the description of curve parameters see “Curve Solution” on page 8-15.

- **Save**: press to store the point being found.

The *Map* tab displays the results of the calculation graphically.

![Figure 8-28. Three Pt Curve – Map Tab](image)
**Radius & Points**

The Radius & Points task defines a curve using the PC and PT points, and a radius parameter. To start the Radius & Points task, select **COGO ▶ Curve Solutions ▶ Radius & Points**.

The *Radius & Point* tab contains the initial data for the task.

- **PC Point**: the Point of Curvature. Can be manually entered, or selected from the map or from the list of points.
- **PT Point**: the Point of Tangency. Can be manually entered, or selected from the map or from the list of points.
- **Radius/Deg Curve/Deg Chord**: the radius parameter of the curve.
- **Turn**: the direction of turn, relative to the PC Point.
- **Curve**: defines the curve in circle that should be considered. The radius, and the PC and PT points define two curves, one with delta less than or equal to 180 degrees (Small curve), and the other with delta greater than or equal to 180 degrees (Large curve).
- **RP Point**: the point to be defined. Type the name and select the code, if necessary.
- **Calc**: press to calculate the curve parameters.
The *Results* tab displays the results of the calculation.

![Figure 8-30. Radius & Points – Results Tab](image)

For the description of curve parameters see “Curve Solution” on page 8-15.

- **Save**: press to store the point being found.

The *Map* tab displays the results of the calculation graphically.

![Figure 8-31. Radius & Points – Map Tab](image)
**Area**

To calculate the area of a polygon, select **COGO ▶ Area**. The **Area** tab contains the list of points, vertices of the polygon, and the plot of the polygon.

![Figure 8-32. Area](image)

- **Point List**: the Point List name. Can be selected from the list of Point Lists or entered manually.
- **List of Points**: the list of currently selected vertices of the polygon.
- Up and down arrows move the highlighted point up and down in the order of the points.

**NOTICE**

*For the correct operation of the application, the sides of the polygon should not cross each other.*

- `∥`: switches on/off the keyboard arrow keys that duplicate the operation of the arrows on the screen.
- `☆`: closes the plot of the polygon. Only the list of points will be available.
- `Calc`: calculates the area of the polygon and displays it on the **Results** tab.
The Results tab shows the results of the calculation.

![Figure 8-33. Area – Results Tab](image)

The Map tab shows a view of the polygon.

![Figure 8-34. Area – Map Tab](image)
**Known Area**

The Known Area task calculates the coordinate of a point/points that after being added to Point List form a polygon of known area. There are two methods: *Hinge* and *Line*.

**Hinge**

The Hinge method calculates the coordinates of a point, that meets the following conditions:

- it is located on a known azimuth taken from the first point of Point List;
- being added to the Point List between the first and the last points, forms a polygon of a known area.

To start the Hinge task, select **COGO > Known Area > Hinge**.

**Known Area - Hinge**

The *Area* tab contains the initial data of the Hinge task.

- *Point List*: the Point List name. Can be selected from the list of Point Lists or entered manually.
- *List of Points*: the list of currently selected vertices of the polygon.
- Up and down arrows move the highlighted point up and down in the order of the points.
**NOTICE**

*For the correct operation of the application, the sides of the polygon should not cross each other.*

- **$:** switches on/off the keyboard arrow keys that duplicate the arrows on the screen.
- **$:** closes the plot of the polygon. Only the list of points will be available.
- **Next:** opens the second screen under *Area* tab.

![Figure 8-36. Known Area - Hinge – Area Tab 2](image)

- **Azimuth:** the known azimuth from the first point in the list, where the hinge point is located.
- **Area:** the known area.
- **Sq. (Job Units)/Acres:** press to set the area units.
- **Cogo Point:** the name of the new point.
- **Code:** select the code from the drop-down menu, or press the button to open the list of available attributes.
- **Back:** returns to the first *Area* tab.
- **Calc:** calculates the coordinates of the hinge point and displays it on the *Results* tab.
The *Results* tab shows the results of the calculation.

![Figure 8-37. Known Area - Hinge – Results Tab](image)

The *Map* tab shows the view of the polygon.

![Figure 8-38. Known Area - Hinge – Map Tab](image)
**Line**

The Line method computes the coordinates of two points that along with two other known points form a quadrilateral of known area.

To start the Line task, select COGO ▶ Known Area ▶ Line.

**Known Area - Line**

The Area tab contains the initial data of the Line task.

- **Start Pt, End Pt**: the known starting and the ending points of the quadrilateral.
- **Az1, Az 2**: the azimuths of the lines emanating from the Start and the End points (Line 1 and Line 2), to the calculated points, COGO Pt 1 and COGO Pt 2, respectively.
- **Area**: the known area.
- **Sq. (Job Units)/Acres**: press to set the area units.
- **Azimuth/Parallel**: the azimuth of a line that will intersect Line1 at COGO Pt 1 and Line2 at COGO Pt 2 with an area of the quadrilateral equal to the known area. If Parallel is set, the line COGO Pt 1 -> COGO Pt 2 will be parallel to the line defined by the Start and End Points.
- **COGO Pt1, COGO Pt2**: the names of the points.
- **Code** field: in the Code field. Select the code from the drop-down menu, or press the button to open the list of available attributes.
• **Calc**: calculates the coordinates of the line points and displays it on the *Results* tab.

The *Results* tab shows the results of the calculation.

![Figure 8-40. Known Area - Line – Results Tab](image)

The *Map* tab shows the view of the quadrilateral.

![Figure 8-41. Known Area - Line – Map Tab](image)
Transformations

The transformations include the three tasks: Rotate, Translate and Scale.

Rotate

To rotate points, click COGO ▶ Transformations ▶ Rotate.

The Rotate task rotates the selected points around a specific point.

- **Select points**: select points for Rotation from the map or the list, or by setting the point range. The point range can be set in the Select Points by Range screen opened by the By Range button. For a description of the Select Points by Range screen see “Select Points by Range” on page 8-34.

- **Rotation Point**: sets the center of rotation.

- **Rotation Method**: sets if the rotation angle will be input directly (the Rot. Angle entry), or as a difference between the new and old azimuths/bearings.

- **Rotation Angle**: sets the value of the rotation angle.

- **Old Azimuth**: sets the value of the old azimuth.

- **New Azimuth**: sets the value of the new azimuth.

- **Calc**: press to rotate the selected points.
**Translate**

To translate a set of points, click **COGO > Transformations > Translate**.

The *Translate* task moves a group of points.

![Figure 8-43. Translate](image)

- **Select points**: select points for the translation from the map or the list or by setting the point range. The point range can be set in the *Select Points by Range* screen, opened by the **By Range** button. Description of the *Select Points by Range* screen see “Select Points by Range” on page 8-34.

- **Translate By**: sets the method of translating, either **Coords/Pts** or **Az/Brg, Dist, Ht**.

  - **Coords/Pts**: all the selected points will be moved in the same direction and distance as between the points (locations), set by the next two fields: **From Pt (From Crd)** and **To Pt (To Crd)**. In the first case, define only the point name; in the second case, the local coordinates and the height of the location.

  - **Azimuth/Bearing**: all the selected points will be moved in the specified direction by a specified distance. These parameters are set through the **Bearing (Azimuth)** field, **Hz Dist** and **Vert Dist** fields.

- **Calc**: press to translate the selected points.
Scale

To scale a set of points, click COGO ➤ Transformations ➤ Scale.

The Scale task scales the distances of a range of points relative to a Base Point.

![Scale Window](image)

**Figure 8-44. Scale**

- **Select points**: select points for scaling from the map or the list, or by setting the point range. The point range can be set in the Select Points by Range screen opened by the By Range button. Description of the Select Points by Range screen see “Select Points by Range” on page 8-34.

- **Base Point**: sets the point that is the reference point for the scale transformation. Can be manually entered or, chosen from the map or from the list.

- **Scale Factor**: the scale factor for the coordinate transformation.

- **Scale Heights**: check this field if the height values should be scaled also.

- **Calc**: press to scale the selected points.
Select Points by Range

In the Range of Points field, the range can be set by enumeration of the points separated by commas, or by specifying the first and the last included point in the range. Press the Select button to save the specified range. The number of the selected points display on the corresponding task screen under the Select Points field.

![Select Points by Range](image)

*Figure 8-45. Select Points*
File Formats

The following sections describe the formats used in the import/export of files.

Point Coordinate Formats

The files used to import/export point data can be in different formats: text formats such as DXF, MOSS and many others, or binary formats such as DWG and CR5.

**FC-4**

The FC-4 format is as follows:

Name, Northing, Easting, Elevation, Code

**Example:**

```
101
12.32000
45.10000
23.12000
a
102
34.20000
9.40000
3.22000

103
2.33400
8.45000
45.00000
```
File Formats

b
104
78.60000
45.00000
56.60000

**FC-5**

Example:

**OutPut**

```
+BS_f+012500000m_g+011500000m_h+000050000m+PJ1_
f+012000000m_g+011002106m_h+000049970m+PJ11_f+012000000m_
g+011002106m_0063
h+000049970m+PJ12_f+011994478m_g+011004703m_
h+000050025m+PJ13_f+011990588m_g+011003698m_
h+000049863m+PJ2_f+011994476m1051
```

**InPut**

```
+BS_x+012500000m_y+011500000m_z+000050000m+PJ1_
f+012000000m_g+011002106m_h+000049970m+PJ11_f+012000000m_
g+011002106m_0063
h+000049970m+PJ12_f+011994478m_g+011004703m_
h+000050025m+PJ13_f+011990588m_g+011003698m_
h+000049863m+PJ2_f+011994476m1051
```

**GTS-6**

GTS-6 coordinate input and output is the same format.

Refer to the GTS-6 interface manual to confirm details.

The format of GTS-6 is the same as FC-5 coordinate input.
**FC-6/GTS-7**

The format of FC-6 is the same as GTS-7 coordinate format. The GTS-7 format is as follows:

ptno, X(easting), Y(northing), Z(elevation)

**Example:**

- 1, 1000.0000, 1000.0000, 100.0000
- 2, 990.0000, 1010.0000, 100.0000
- 101, 994.8159, 1000.9684, 100.1130
- 102, 993.9304, 1007.7991, 100.8000
- 103, 998.5150, 1009.6329, 100.4026
- 104, 1002.0648, 1002.5682, 100.3421
- 1001, 1004.7210, 997.6496, 100.1153
- 1002, 1003.7027, 990.8382, 100.7989
- 1003, 998.7911, 990.3286, 100.4033
- 1004, 997.3111, 998.0951, 100.3421

**GTS-7 with strings**

The GTS-7 with strings format is as follows:

ptno, X(easting), Y(northing), Z(elevation), pt code, string

**Example:**

- 1, 1000.0000, 1000.0000, 100.0000, STN, 001
- 2, 990.0000, 1010.0000, 100.0000, STN, 001
- 101, 994.8159, 1000.9684, 100.1130, STN, 002
- 102, 993.9304, 1007.7991, 100.8000, STN, 001
- 103, 998.5150, 1009.6329, 100.4026, STN, 002
- 104, 1002.0648, 1002.5682, 100.3421, STN, 001
- 1001, 1004.7210, 997.6496, 100.1153, PT, 09
- 1002, 1003.7027, 990.8382, 100.7989, PT, 05
- 1003, 998.7911, 990.3286, 100.4033, PT, 09
- 1004, 997.3111, 998.0951, 100.3421, PT, 05
File Formats

**GT**

The GT Format is as follows:

0 Code Name North East Elev 0 0

Example:

```
0               a     101        12.320        45.100        23.120     0 0
0                     102        34.200         9.400         3.220     0 0
0               b     103         2.334         8.450        45.000     0 0
0                     104        78.600        45.000        56.600     0 0
```

**DXF**

The AutoCAD® DXF (Drawing eXchange Format) format is the native vector file format of Autodesk's AutoCAD application. Refer to Autodesk’s Website for details:

http://usa.autodesk.com/adsk/servlet/item?id=752569&siteID=123112

**SHP**

SHP is an ArcView® GIS data format used to represent a set of geographic features.

Refer to the following website for details:

http://dl1.maptools.org/dl/shapelib/shapefile.pdf

**Land XML**

LandXML is a standard data exchange format.

Refer to LandXML Website for details:

http://www.landxml.org/schema/landxml-1.0/Documentation/LandXMLDoc.htm
CR5

It's a file format of TDS-48 Coordinate file. The TDS Coordinate File is a binary file consisting of a 38 byte header, followed by coordinate point records 45 bytes in length.

CR-5 format is as follows:

Header:
- Bytes 1- 10 is the file name in ASCII
- Bytes 11- 20 are not used
- Bytes 21- 34 is the starting point number in MS long integer format. This record is -1 if the file is non-sequential
- Bytes 35- 38 is the last point number in MS long integer format

Coordinate Point Records:
- Bytes 1- 4 is the point number in MS long integer format. This record is -1 if the point is unused (sequential files only)
- Bytes 5- 12 is the northing of the point in MS double precision real
- Bytes 13- 20 is the easting of the point in MS double precision real
- Bytes 21- 28 is the elevation of the point in MS double precision real
- Bytes 29- 45 is the point descriptor in ASCII
MOSS GENIO

Example:

GENIO D:\J0119A
001,FORMAT(3F14.4)
003,ORDR,4=1,1,2,3
080,PT01,7=3
  1002.6092  1013.9337  2.3165
  1007.5266   992.8522  1.9564
       0.0000       0.0000       0.0000
080,PT02,7=3
   991.2378   1002.7609  1.5545
   993.2974  1014.3845  2.3475
       0.0000       0.0000       0.0000
080,CD02,7=3
  1002.6079  1013.9361  2.3148
       0.0000       0.0000       0.0000
080,CD03,7=3
  1007.5318   992.8488  1.9562
       0.0000       0.0000       0.0000
080,OCC,7=3
  1000.0000   1000.0000  0.0000
       0.0000       0.0000       0.0000
080,PT01,7=3
  1002.6079  1013.9361  2.3148
  1007.5318   992.8488  1.9562
  991.2376  1002.7602  1.5557
  993.2994  1014.3841  2.3509
       0.0000       0.0000       0.0000
999
FINISH
NEZ

NEZ format is as follows:
Name, North, East, Elev, Code

Example:
101, 12.3200, 45.1000, 23.1200, a
102, 34.2000, 9.4000, 3.2200,
103, 2.3340, 8.4500, 45.0000, b
104, 78.6000, 45.0000, 56.6000,

It is also possible for PTL coordinate system. In this case the NEZ format is:
Name, North, East, Elev, Code, First Reference Point Name, Second Reference Point Name

NEZ with strings

The NEZ with strings coordinate format is as follows:
Name, North, East, Elev, Code, String

Example:
101, 12.3200, 45.1000, 23.1200, a, 123
102, 34.2000, 9.4000, 3.2200, ,
103, 2.3340, 8.4500, 45.0000, b, ,
104, 78.6000, 45.0000, 56.6000, ,

It is also possible for PTL coordinate system. In this case the format is:
Name, North, East, Elev, Code, String, First Reference Point Name, Second Reference Point Name
**Cut Sheet Standard**

Cut Sheet Standard format is as follows:

**Header:**
- Date
- Time
- Job Name
- Dist Units (Meter, US. Feet, Int. Feet, US. Inches, Int. Inches)

**Design Point Record:**
- Point Name
- Code
- North East Elev

**Stakeout Station Record:**
- Station Name
- North East Elev
- deltaNorth deltaEast deltaElev Cut

**Cut Sheet User Defined**

It's a user defined set of the fields in the user defined order.

The following fields are available:
- Design Point
- Code
- Staked Point
- Cut
- Fill
- Cut(Fill)
- Time Stamp
- Station
- Offset Direction
Offset Distance
Design North
Design East
Design Elevation
Station North
Station East
Station Elevation
Delta North
Delta East
Delta Elevation

**Check Sheet**

Check Sheet format is as follows:

**Header:**
- Date
- Time
- Job Name
- Dist Units (Meter, US. Feet, Int. Feet, US. Inches, Int. Inches)

**Observed Point Record:**
- Point Name
- Code
- North East Elev

**Check Station Record:**
- Station Name
- North East Elev
deltaNorth deltaEast deltaElev
PTL Sheet

PTL Sheet format is as follows:

Header:
- Date
- Time
- Job Name
- Dist Units (Meter, US. Feet, Int. Feet, US. Inches, Int. Inches)

Point Record:
- PointName North East Elev Code FirstReferencePointName
- SecondReferencePointName

Code Libraries

The following sections describe the code formats used in the import/export code libraries.

Topcon Data Dictionary (TDD) Format

Topcon's Data Dictionary Format supports String, Integer, Float and List types for code fields. All exported codes are stored in the one file. Each code definition is placed to a new line as follows:

CodeName#1(field#1(FIELD_TYPE),...,field#N(FIELD_TYPE))
CodeName#2(field#1(FIELD_TYPE),...,field#N(FIELD_TYPE))

Comments:
- FIELD_TYPE can be: String, Integer, Float, List.

For FIELD_TYPE List we use next format:
- List(item#1,...,item#N).

Example:
- test_code(menu_item(List(blue,green,red)), text_item(String),
  int_item(Integer), real_item(Float))
- test_code2(text_item2(String))
XML Format

The XML Code Library format supports String, Integer, Float and List types as code fields. All exported codes are stored in the one file. The syntax of the XML format is as follows:

Example:

```xml
<?xml version="1.0" ?>
<!DOCTYPE DATADICTIONARY [
<!ELEMENT DATADICTIONARY (ATTRIBUTE)>]
<!ELEMENT ATTRIBUTE (ATTNAME, FIELD) >
<!ELEMENT ATTNAME (#PCDATA)>
<!ELEMENT FIELD (NAME, TYPE) >
<!ELEMENT NAME (#PCDATA)>
<!ELEMENT TYPE (List | String | Integer | Float) >
<!ELEMENT List (VALUE)> 
<!ELEMENT VALUE (#PCDATA)> 
<!ELEMENT String (#PCDATA)> 
<!ELEMENT Integer (#PCDATA)> 
<!ELEMENT Float (#PCDATA)> ]>
<DATADICTIONARY>
<ATTRIBUTE>
<ATTNAME>test_code</ATTNAME>
  <FIELD>
    <NAME>menu_item</NAME>
    <TYPE>List
      <VALUE>blue</VALUE>
      <VALUE>green</VALUE>
      <VALUE>red</VALUE>
    </TYPE>
  </FIELD>
  <FIELD>
    <NAME>text_item</NAME>
</ATTRIBUTE>
</DATADICTIONARY>
```
Data Base Format (DBF)

This format is ArcInfo's DBF format for code libraries supporting String, Integer, Float types as fields of the codes. The List type is unsupported. All exported codes are stored separate files.
Roads Formats

The following sections describe the road formats used in the import/export of road data.

SSS Road

Alignments are uploaded as elements, and start with the START definition which includes the starting chainage and a coordinate. The elements are: PT, STRAIGHT, ARC or TRANSITION.

The general format for each record is:

```
KEYWORD nnnn, nnnn [,nnnn]
where:
START             chainage, easting, northing
STRAIGHT          bearing, distance
ARC                radius, length
SPIRAL             radius, length
PT                 easting, northing[, radius[, A1, A2: clothoid length]]
```

Example 1:

```
START 1000.000, 8.8888, 199.1200
STRAIGHT 25.0000, 48.420
SPIRAL 20.000, 20.000
ARC 20.000, 23.141
SPIRAL 20.000, 20.000
STRAIGHT 148.3000, 54.678
```

Example 2:

```
START 1000, 1050, 1100
PT 1750, 1300, 100, 80, 80
PT 1400, 1750, 200
PT 1800, 2000
```
TDS Road

TDS road file has a file extension of ".RD5". It is divided into eight sections. Each section is started with a line that has a two letter code and is followed by exactly 50 ‘+’ characters. These section header lines have to be included in the file even if there is no definition under them. For example, super-elevation and widening are not required, but their header lines must exist. Each header line may be followed by component definitions of that section.

Section codes:

HR : Start Horizontal alignment
VR : Start Vertical alignment
XR : Start Right Template
XL : Start Left Template
SR : Start Right Super Elevation
SL : Start Left Super Elevation
WR : Start Right Widening
WL : Start Left Widening

Example:

HR+++++++++++++++++++++++++++++++++++++++++++++++++++
HL,.25.49380,630.000
HS,-1.000000,1000.000,200.000,R,T
HC,-1.000000,1000.000,895.900,R
HS,-1.000000,1000.000,200.000,R,C
HL,-1.000000,250.000
VR+++++++++++++++++++++++++++++++++++++++++++++++++++
VG,.271.840,-2.000
VC,.500.000,-2.000,1.800
VG,.1254.060,1.800
VG,.150.000,1.800
XR+++++++++++++++++++++++++++++++++++++++++++++++++++
RT,.100.000,0.000,NORMAL
XL++++++++++++++++++++++++++++++++++++++++++++++++++
LT,100.0,0.000,NORMAL
SR++++++++++++++++++++++++++++++++++++++++++++++++++
RS,106,30.0,108,30.0,-2.0,0.000,0.000
RS,117,25.9,119,25.9,-6.0,0.000,0.000
SL++++++++++++++++++++++++++++++++++++++++++++++++++
LS,104,30.0,108,30.0,-2.0,6.0,0.000,0.000
LS,117,25.9,121,25.9,6.0,0.000,0.000
WR++++++++++++++++++++++++++++++++++++++++++++++++++
RW,104,35.0,105,35.0,22.0,14.0,0
RW,106,35.0,107,35.0,14.0,22.0,0
WL++++++++++++++++++++++++++++++++++++++++++++++++++
LW,104,35.0,105,35.0,22.0,14.0,0
LW,106,35.0,107,35.0,14.0,22.0,0

Component definitions:

Horizontal Alignments
HL,%lf,%3f Horizontal Line
Azimuth of line (DMS) %lf
(-1 if tangent to previous segment)
Horiz distance of line (ft or meter) %3f

HC,%lf,%3f,%3f,%c Horizontal Curve
Tangent azimuth %lf
(-1 if tangent to previous segment)
Radius %.3f
Arc length %.3f
Turn ( R-Right or L-Left ) %c

HS,%lf,%3f,%3f,%c,%c Horizontal Spiral
Tangent azimuth %lf
(-1 if tangent to previous segment)
Radius %.3f
### File Formats

<table>
<thead>
<tr>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arc length</td>
<td>%.3f</td>
</tr>
<tr>
<td>Turn</td>
<td>%c     ( R-Right or L-Left )</td>
</tr>
<tr>
<td>Direction</td>
<td>%c     (T-Tangent or C-Curve)</td>
</tr>
</tbody>
</table>

**Vertical Alignments**

<table>
<thead>
<tr>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>VG, %.3f, %.3f</td>
<td>Vertical Grade</td>
</tr>
<tr>
<td>Horiz distance</td>
<td>%.3f</td>
</tr>
<tr>
<td>Grade</td>
<td>%.3f</td>
</tr>
<tr>
<td>VC, %.3f, %.3f, %.3f</td>
<td>Vertical Parabolic Curvature</td>
</tr>
<tr>
<td>Horiz distance</td>
<td>%.3f</td>
</tr>
<tr>
<td>Begin grade</td>
<td>%.3f</td>
</tr>
<tr>
<td>End grade</td>
<td>%.3f</td>
</tr>
</tbody>
</table>

**Cross section Templates**

<table>
<thead>
<tr>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>RT, %d, %.3f, %s</td>
<td>Right or Left Cross Section Template</td>
</tr>
<tr>
<td>LT, %d, %.3f, %s</td>
<td></td>
</tr>
<tr>
<td>Station number</td>
<td>%d</td>
</tr>
<tr>
<td>Station offset</td>
<td>%.3f</td>
</tr>
<tr>
<td>Template name</td>
<td>%s</td>
</tr>
</tbody>
</table>

**Super Elevation**

<table>
<thead>
<tr>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right or Left Super Elevation</td>
<td></td>
</tr>
<tr>
<td>RS, %d, %.3f, %d, %.3f, %.3f, %.3f, %c, %c, %.3f, %c, %.3f</td>
<td></td>
</tr>
<tr>
<td>LS, %d, %.3f, %d, %.3f, %.3f, %.3f, %c, %c, %.3f, %c, %.3f, %.3f</td>
<td></td>
</tr>
<tr>
<td>Start Station number</td>
<td>%d</td>
</tr>
<tr>
<td>Start Station offset</td>
<td>%.3f</td>
</tr>
<tr>
<td>End Station number</td>
<td>%d</td>
</tr>
<tr>
<td>End Station offset</td>
<td>%.3f</td>
</tr>
<tr>
<td>Start slope</td>
<td>%.3f</td>
</tr>
<tr>
<td>End slope</td>
<td>%.3f</td>
</tr>
<tr>
<td>End of SE flag</td>
<td>%c</td>
</tr>
</tbody>
</table>
(0-End station number and End station offset are in fields 3 and 4
1-length of SE interval is in field 4)
Hinge on center or edge %c
of road (0-center,1-edge)
Parabolic transition length %.3f
at start of SE
Parabolic transition length %.3f
at end of SE

Widening
Right or Left Widening
RW,%d,%.3f,%d,%.3f,%.3f,%.3f,%c or
LW,%d,%.3f,%d,%.3f,%.3f,%.3f,%c
Start Station number %d
Start Station offset %.3f
End Station number %d
End Station offset %.3f
Width at start of widening %.3f
Width at end of widening %.3f
End of widening flag %c
(0-End station number and End station offset are in fields 3 and 4
1-length of widening interval is in field 4)

MC Road
MC road file has a file extension of ".RD3". It is a binary file.
LandXML Road

LandXML is a standard data exchange format.

Refer to LandXML website for details:
http://www.landxml.org/schema/landxml-1.0/Documentation/LandXMLDoc.htm

TopSURV Road

TopSURV road format consists of three files:

1. *.thl: contains horizontal elements of the road and must start with the START definition which includes the starting chainage and a coordinate.

   The elements are: PT, STRAIGHT, ARC or TRANSITION.

   The general format for each record is:

   KEYWORD nnnn, nnnn [,nnnn]

   where:

   START chainage, easting, northing

   STRAIGHT bearing, distance

   ARC radius, length

   SPIRAL radius, length

   PT easting, northing[, radius[, A1, A2]]

   (A1, A2 : clothoid length)

Example1:

   START 1000.000, 8.8888, 199.1200
   STRAIGHT 25.0000, 48.420
   SPIRAL 20.000, 20.000
   ARC 20.000, 23.141
   SPIRAL 20.000, 20.000
   STRAIGHT 148.3000, 54.678
Example 2:

START 1000, 1050, 1100
PT 1750, 1300, 100, 80, 80
PT 1400, 1750, 200
PT 1800, 2000

2. *.tvl: contains vertical elements of the road (vertical curves) and require chainage, level and curve length.
   Starting and ending curve lengths should be zero.
   The format is:
   chainage, level, length

Example:

1000.000, 100.000, 0.000
1100.000, 125.000, 50.000
1250.000, 100.000, 60.000

3. *.trd: contains cross sections:
   The format is:
   Chainage, Template name, Turn (Left or Right), Cut, Fill, Segment name, Horizontal Offset, Vertical Offset
X-sect Templates Formats

Cross section is defined by templates. Each template is stored in a file. A template file consists of a series of segments and each segment has a horizontal and a vertical component. The following sections describe the formats used in the import/export of X-section Template data.

SSS Template

SSS Template format is as follows:

Template Record:
   Template Name, 0, Cut, Fill

Segment Record:
   Template Name, 1, Offset, Height[, Code]

Example:
   SIMP,0,6.000,6.000
   SIMP,1,1.000,0.000,1
   NAME,0,4.000,4.000
   NAME,1,1.000,-0.250,EP
   NAME,1,0.000,0.150,1
   NAME,1,0.500,0.000,2
   NAME,1,0.200,-1.000,3
   NAME,1,0.300,0.000,4

TDS X-section Template

The following sample template file describes a cross section in two segments.

   Number of segments: 2,  Cut slope: 0.500 %,  Fill slope: 1.000 %
   First segment:       hd: 22.000 ft  slope: -2.000 %
   Second segment:     hd: 2.000  ft  vd: -2.000 ft
Example:

TH,2,0.500,1.000
TS,22.000,-2.000,0,roadbed
TS,2.000,-2.000,1,ditch

Definition of components in template file:

TH : Template Header format: TH,%d,%.3f,%.3f
  Number of segments %d
  Slope cut %.3f
  Slope fill %.3f

TS : Template Segment format: TS,%.3f,%.3f,%c,%s
  Segment length %.3f
  Vertical dist or %.3f
  Slope %
  Vertical flag %c (0-Slope % is in field 2)
  Segment name %s

TopSurv Template

TopSURV Template format is as follows:
  Template Name, Code, Offset, Height

Example:

SIMP, 1, 1.000, 0.000
NAME, EP, 1.000, -0.250
NAME, 1, 0.000, 0.150
NAME, 2, 0.500, 0.000
NAME, 3, 0.200, -1.000
NAME, 4, 0.300, 0.000
Localization Format

GC3
This is a binary file containing localization data.

Rocks Survey Formats
The following sections describe the data formats used in the export of road raw data.

X-Section Surveys
The format is as follows:

chainage, offset, level [,code]

Example:
0.000,-4.501,18.527
0.000,-3.500,18.553
0.000,0.000,18.658,CL01
0.000,3.500,18.553
0.000,5.501,18.493
12.669,-4.501,18.029
12.669,-3.500,18.059
12.669,-0.000,18.164,CL01
12.669,3.500,18.059
12.669,5.501,17.999

Find Station Report
The format is as follows:

FindChainageReport:
  Reference road
FindChainage:
  PointName Chainage Offset North East Elev[ Cut]
Raw Data Formats

The following sections describe the formats used in the export of raw data.

FC-5

Refer to the FC-5 interface manual to confirm details on FC-5 data format.

Example:

`SAMPLE_'SOMEONE_#GX0021_S06/01/
95_%24C_&990HP_X1000_(_)_1.200_+.A001_+2755858d_.b0881003d
c+0010942m_*.NS001_1.200_+A002_+a+0006
3265752d_.b0952330d+c+0003366m_*.NS001_1.200_+A003_+a+0420820d_
b0894549d+c+0006913m_*.NS001_1.200_
1002`

GTS-6

The data is GTS-6 and FC-5 unformatted data.

Refer to the GTS-6 interface manual to confirm details.

Example:

`SAMPLE_'SOMEONE_#GX0021_S06/01/
95_%24C_&990HP_X1000_(_)_1.200_+A001_
?+0010942m0881003+2755858d+00010936***+**+**054_*.NS001_0064
1.200_+A002_
?+0003366m0952330+3265752d+0003351**+**063_*.NS001_1.200_
+A003_?+0006913m0894549+0420820d+0006912**+**1039
055_*.NS001_1.200_
2037`
FC-6/GTS-7

The format of the GTS-7 data is the same as the FC-6 data format.

The general format of each record is as follows:

```
CONTROL WORD field1 . . . ,fieldn
```

Where:

- **CONTROL WORD** is terminated by a space.
- Fields 1 to n-1 are terminated by commas.
- Field n is terminated by the end-of-line.
- Each field may be preceded by a number of space characters which should be ignored but may contain spaces after the first non-space character.

GTS-600 v3.1

- **JOB** job name, description
- **DATE** date, time
- **NAME** surveyors name
- **INST** instrument id
- **UNITS** Meter/Feet, Degree/Gon
- **SCALE** grid factor, scale factor, elevation
- **ATMOS** temp, press
- **STN** ptno, ins ht, stn id
- **XYZ** X(easting), Y(northing), Z(elevation)
- **BKB** ptno, backsight bearing, backsight angle
- **BS** ptno[, target height]
- **FS** ptno, target height, pt code[,string number]
- **SS** ptno, target height, pt code[,string number]
- **CTL** control code[,pt code 2[,string no 2]](optional)
- **HV** HA, VA
- **SD** HA, VA, SD
OFFSET    radial offset, tangential offset, vertical offset
PTL_OFF   offset along ref. line, offset perpendicular to line, vertical offset
NOTE      comments
MLM       from point, to point, delta HD, delta VD, delta SD
RES_OBS   ptno, target height, observation count

XYZ                   if present follows the STN record
BKB                   if present follows the BKB record or STN record
                      if no BKB.
CTL                   if present follows the FS or SS header record.
HV, SD or HD          must follow a BS, FS or SS header and follows
                      the CTL if present.
OFFSET               may follow any SD or HD record.

Example:
GTS-600    v3.1
JOB        TEST1,TOPO COLLECTION
NAME       FRED
INST       GTS-7
UNITS      M,D
STN        1,1.500,STN
SS         1001,1.500,BLDG,01
SD         0.0000,84.4650,9.746
SS         1002,1.500,BLDG,01
SD         0.0000,84.4650,9.746
SS         1003,1.500,BLDG,01
SD         0.0000,84.4650,9.747
SS         1004,1.500,BLDG,01
CTL        CL
SD         359.1740,84.4650,9.747
SS         1005,1.500,NS
SD  359.1740,84.4650,9.747
SS  1006.1,1.500,NS
SD  359.1740,84.4650,9.747
FS  2,1.500,NS
SD  179.1740,84.4650,9.747
STN 2,1.500,STN

GTS-600  v3.1
JOB  TEST2, SET COLLECTION
NAME  FRED
INST  GTS-7
UNITS  M,D
STN  1,1.500,STN
XYZ  1000.000,1000.000,100.000
BKB  2,315.0000,0.0000
BS  2,1.500
HV  344.0620,86.3810
FS  101,1.500,STN
SD  325.3420,88.4750,5.275
FS  102,1.500,STN
SD  7.0610,85.2210,9.914
FS  103,1.500,STN
SD  36.1350,87.3800,9.755
FS  104,1.500,STN
SD  83.4730,84.0410,3.313
FS  104,1.500,STN
SD  263.4820,275.5530,3.313
FS  103,1.500,STN
SD  216.1430,272.2150,9.755
FS  102,1.500,STN
SD  187.0650,274.3730,9.916
Land XML

LandXML is a standard data exchange format.
Refer to LandXML Website for details:
http://www.landxml.org/schema/landxml-1.0/Documentation/LandXMLDoc.htm

TDS RawData

Example:

JB,NMA_meas,DT03-15-02,TM15:17:53
MO,AD0,UN1,SF1.000000,EC0,E00.0000
SP,PN1,N 90.0000,E 200.0000,EL 50.0000,--man
OC,OP1,N 90.0000,E 200.0000,EL 50.0000,--man
LS,HI1.0100,HR0.0000
--user has entered the following Azimuth
BK,OP1,BP2,BS0.0000,BC65.4618
--SS,OP1,FP2,AR65.4618,ZE102.0935,SD4.7720,--DOOR
LS,HI1.0100,HR2.5600
SS,OP1,FP3,AR61.1834,ZE84.2723,SD6.5740,--BEN

Refer to the GTS-600 Series, GTS-700 Series, GTS-800 Series,
GMT-100 Series Reference Manual for details.
MOSS Survey

Both traverse and detail raw data formats can be exported.

Example:

SURVEY D:\J0119A
017,DMS
190,,DECR,0900000
180,,9000,,1000.000,1000.000,0.000
200,9000,9001,SDVA,3595958,,1.600,,1.000000
201,,PT01,0103620,14.194,0870623,0.000,,1001
201,,PT01,1333115,10.386,0880200,0.000,,1002
201,,PT02,2872920,9.187,0901702,0.000,,1003
201,,PT02,3350057,15.887,0871812,0.000,,1004
201,CD2,02,PP01,0103555,14.196,0870649,0.000,,1005
201,CD2,03,PP01,1333053,10.392,0880209,0.000,,1006
201,,P101,2872902,9.187,0901634,0.000,,1007
201,,P101,3350118,15.886,0871727,0.000,,1008
999
FINISH
Index

A
Alarms 2-12
Alignment 3-17
Antenna 2-26, 2-36
Attribute 3-8

C
Code 3-8
COGO
intersection 8-7
rotate 8-31
scale 8-33
translate 8-32
two point inverse 8-2
Configuration
GPS+ configuration 2-14
survey configuration 2-4, 2-14
TS configuration 2-43
Control code 3-7, 5-22
Co-Op tracking 2-42
Coordinate system 2-5, 2-73

D
Datum 2-6
Degree of chord 3-22
Degree of curve 3-22
Distance averaging 2-53

E
Elevation mask 2-19, 5-4
Export
to device 2-90
to job 2-78

F
Feature 3-8
Find station 6-31

G
GPS+
GPS+ status 5-2
start base 5-8

H
HAL 3-20
circular arc 3-22
intersection point 3-17, 3-24
line 3-21
spiral 3-23

I
Import
from file 2-69
from job 2-61

J
Job
delete job 2-13
job list 2-2
new job 2-3
open job 2-2
select job 2-61, 2-78

L
Localization 5-41
<table>
<thead>
<tr>
<th>M</th>
<th>Missing line 6-35</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>mmGPS 2-16</td>
</tr>
<tr>
<td>Modem</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GSM 2-24</td>
</tr>
<tr>
<td></td>
<td>internal HiPer Lite 2-22</td>
</tr>
<tr>
<td></td>
<td>Pacific Crest 2-23</td>
</tr>
<tr>
<td></td>
<td>Satel 2-24, 2-48</td>
</tr>
<tr>
<td></td>
<td>Multipath reduction 2-42</td>
</tr>
</tbody>
</table>

| N         | Note 3-32          |

<table>
<thead>
<tr>
<th>O</th>
<th>Observation mode 2-94</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Offset</td>
</tr>
<tr>
<td></td>
<td>hidden point 6-24</td>
</tr>
<tr>
<td></td>
<td>Offsets</td>
</tr>
<tr>
<td></td>
<td>sideshots 6-18</td>
</tr>
<tr>
<td></td>
<td>topo survey 5-28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th>Pattern 2-51</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Point guide 2-54</td>
</tr>
<tr>
<td></td>
<td>Points 3-2</td>
</tr>
<tr>
<td></td>
<td>Post processing</td>
</tr>
<tr>
<td></td>
<td>kinematic 2-17</td>
</tr>
<tr>
<td></td>
<td>static 2-16</td>
</tr>
<tr>
<td></td>
<td>Prism constant 2-54</td>
</tr>
<tr>
<td></td>
<td>Projection 2-5, 2-6</td>
</tr>
<tr>
<td></td>
<td>PTL 6-16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
<th>Raw data 3-34</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Receiver</td>
</tr>
<tr>
<td></td>
<td>base receiver 2-19</td>
</tr>
<tr>
<td></td>
<td>rover receiver 2-27</td>
</tr>
<tr>
<td></td>
<td>Reference direction 2-40</td>
</tr>
<tr>
<td></td>
<td>Road 3-17</td>
</tr>
<tr>
<td></td>
<td>Rover known point 5-38</td>
</tr>
<tr>
<td></td>
<td>RTK 2-16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
<th>Scan range 2-52</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sensitivity 2-52</td>
</tr>
<tr>
<td></td>
<td>Sideshot 6-14</td>
</tr>
<tr>
<td></td>
<td>Signal-to-noise ratio 5-7</td>
</tr>
<tr>
<td></td>
<td>Slope 3-15</td>
</tr>
<tr>
<td>Stakeout</td>
<td>angle sequence 2-53</td>
</tr>
<tr>
<td></td>
<td>line (GPS+) 7-14</td>
</tr>
<tr>
<td></td>
<td>meas method 2-52</td>
</tr>
<tr>
<td></td>
<td>point &amp; direction 7-8</td>
</tr>
<tr>
<td></td>
<td>point (GPS+) 7-2</td>
</tr>
<tr>
<td></td>
<td>road 7-28</td>
</tr>
<tr>
<td></td>
<td>slope 7-33, 7-37</td>
</tr>
<tr>
<td>Stakeout parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>for GPS+ 2-40</td>
</tr>
<tr>
<td></td>
<td>for Total Station 2-55</td>
</tr>
<tr>
<td>String</td>
<td>3-32, 5-24</td>
</tr>
<tr>
<td>Survey</td>
<td>auto topo 5-34</td>
</tr>
<tr>
<td></td>
<td>backsight survey 6-2</td>
</tr>
<tr>
<td></td>
<td>topo 5-20</td>
</tr>
<tr>
<td>Survey parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>for GPS+ 2-38</td>
</tr>
<tr>
<td></td>
<td>for Total Station 2-52</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T</th>
<th>Tape dimension 6-33</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>reference line 6-33</td>
</tr>
<tr>
<td>Tolerances</td>
<td>2-53</td>
</tr>
<tr>
<td>Total Station</td>
<td></td>
</tr>
<tr>
<td></td>
<td>models 2-44</td>
</tr>
<tr>
<td>Track speed</td>
<td>2-52</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>U</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>angle units 2-10</td>
</tr>
<tr>
<td></td>
<td>distance units 2-9</td>
</tr>
<tr>
<td></td>
<td>pressure 2-10</td>
</tr>
<tr>
<td></td>
<td>temperature 2-10</td>
</tr>
</tbody>
</table>
**V**

VAL 3-25
- elements 3-18
- long section 3-18, 3-28
- parabola 3-27
- vertical grade 3-26

**X**

X-section 3-29, 6-29
- cut and fill 3-15
- segment 3-14
- template 3-14